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Preface

Preface

SINUMERIK documentation

The SINUMERIK documentation is organized in three parts:
e General documentation

e User documentation

e Manufacturer/service documentation

Information on the following topics is available at
http://www.siemens.com/motioncontrol/docu

e Ordering documentation
Here you can find an up-to-date overview of publications.

e Downloading documentation
Links to more information for downloading files from Service & Support.

e Searching documentation online
Information on DOConCD and direct access to the publications in DOConWEB.

¢ Individually compiling documentation on the basis of Siemens contents with the
My Documentation Manager (MDM), refer to http://www.siemens.com/mdm
My Documentation Manager provides you with a range of features for
generating your own machine documentation.

e Training and FAQs
Information on our range of training courses and FAQs (frequently asked
questions) is available via the page navigation.

Target group

Benefits

Project engineers, technologists (of the machine manufacturers), commissioning
engineers (for systems/machines), programmers.

The Function Manual describes the functions so that the target group is familiar
with and can select them. It provides the target group with the information required
to implement the functions.

© Siemens AG 2010 All Rights Reserved
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Standard scope

This Programming Guide describes the functionality afforded by standard
functions. Extensions or changes made by the machine tool manufacturer are
documented by the machine tool manufacturer.

Other functions not described in this documentation might be executable in the
control. However, no claim can be made regarding the availability of these
functions when the equipment is first supplied or in the event of servicing.

For the sake of simplicity, this documentation does not contain all detailed
information about all types of the product and cannot cover every conceivable case
of installation, operation, or maintenance.

Technical support

If you have any technical questions, please contact our hotline:

Europe and Africa:

Phone: +49 180 /5050 - 222

Fax: +49 180 /5050 - 223

0.14 €/min. from German landlines, max. 0.42 €/min for calls from a mobile
phone

Internet: http://www.siemens.com/automation/support-request

America:
Phone: +1 423 262 2522
Fax: +1 423 262 2200
E-mail: mailto:techsupport.sea@siemens.com

Asia/Pacific:
Phone: +86 1064 757575
Fax: +86 1064 747474
E-mail: mailto:support.asia.automation@siemens.com

Questions about the documentation

If you have any queries (suggestions, corrections) in relation to this documentation,
please fax or e-mail us:

Fax: +49 9131 98 2176

E-mail: mailto:docu.motioncontrol@siemens.com

A fax form is available in the appendix of this document.

SINUMERIK Internet address

http://www.siemens.com/sinumerik
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EC Declaration of Conformity

The EC Declaration of Conformity for the EMC Directive can be
viewed/downloaded from the Internet at: http://support.automation.siemens.com
under the Product Order No. 15257461, or at the relevant branch office of | DT MC
Division of Siemens AG.

Safety information

These Operating Instructions contain information which you should observe to
ensure your own personal safety as well as to protect the product and connected
equipment. Notices referring to your personal safety are highlighted in the manual
by a safety alert symbol; notices referring to property damage do not have a safety
alert symbol. Depending on the hazard level, warnings are indicated in a
descending order as follows:

f'i DANGER

Indicates that death or severe personal injury will result if proper precautions are
not taken.

i v E Warning

indicates that death or severe personal injury may result if proper precautions are
not taken.

i v E Caution

(With warning triangle) Indicates that minor personal injury may result if proper
precautions are not taken.

Caution

(Without warning triangle) Indicates that property damage may result if proper
precautions are not taken.

Attention

Indicates that an unwanted result or situation may result if the appropriate advice
is not taken into account.

In the event of a number of levels of danger prevailing simultaneously, the warning
corresponding to the highest level of danger is always used. A notice warning of
injury to persons with a warning symbol may also include a warning relating to
property damage.
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Qualified personnel

The product/system that belongs to this documentation may be operated only by
personnel qualified for the associated task while observing the appropriate
documentation for the associated task, in particular, the included safety and
warning notes. Because of their training and experience, qualified personnel can
recognize any risks involved with handling these products/systems and avoid any
possible dangers.

Correct usage of Siemens products

Please note the following:

A Warning

Siemens products must only be used for the applications specified in the catalog and in
the technical documentation. If third-party products and components are to be used, they
must be recommended or approved by Siemens. These products can only function
correctly and safely if they are transported, stored, set up, mounted, installed,
commissioned, operated and maintained correctly. The permissible ambient conditions
must be adhered to. The notes in the associated documentation must be complied with.

Further information

Note

This symbol always appears in this documentation where further, explanatory
information is provided.

NN
o Oﬁ\;) Machine manufacturer
e This shown symbol always appears in this document to indicate that the machine

manufacturer can affect or modify the function described. Observe the machine
manufacturer’s specifications.

Registered trademarks

All designations with the trademark symbol ® are registered trademarks of Siemens AG.
Other designations in this documentation may be trademarks whose use by third parties for
their own purposes can violate the rights of the owner.

Disclaimer of liability

We have checked the contents of this document for agreement with the hardware and
software described. However, since deviations cannot be precluded entirely, we cannot
guarantee full consistency. The information given in this publication is reviewed at regular
intervals and any corrections that might be necessary are made in the subsequent editions.
|
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1 Introduction

1.1 Product description

DNC is a software module in the Motion Control Information System (MCIS) from
SIEMENS.

MCIS comprises modular software solutions for the integration of CNC and
machine tools in the production system. This means that both state-of-the-art
SINUMERIK controllers* and older (CNC) machine tools, which do not support an
open network interface, can be integrated in an automation network. MCIS is,
therefore, the key to boosting productivity in your production processes.
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1 Introduction

1.1.1 MCIS for machine tools

MCIS comprises a number of function modules, which, with the exception of RCS
and RPC, access the joint MCIS database MCISDB. The MCIS database is made
up of shared components such as user administration and machine nodes, as well
as module-specific components that are assigned to the individual function
modules.

1. Production data management
e MDA (Machine Data Acquisition)
e PDA (Production Data Acquisition)
e PMT (Parts Monitoring & Tracking)

For greater manufacturing transparency and more efficient production
processes.

2. NC program management
DNC (Direct Numeric Control):

For cutting the costs of NC data organization through easier management,
archiving and supply of NC programs for CNC systems
and faster supply of NC programs to SINUMERIK* systems via Ethernet.

3. Tool management
TDI (Tool Data Information):

For reducing the tools in circulation and minimizing machine downtimes.

4. Maintenance management
TPM (Total Productive Maintenance)

For support of the machine operator with maintenance activities on machines
and plants.

5. Service management
RCS (Remote Control System)

Remote diagnostics for reducing machine downtimes through prompt
notification of faults and very simple online diagnostics via modem, ISDN,
intranet, Internet and DSL.

6. Computer link
RPC (Remote Procedure Call)

Computer link software for the communication between SINUMERIK* and an
external master computer.

7. Data management system for control components
ADDM (A&D Data Management)

Management of the data and programs of the components used via a uniform
user interface.
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1.1.2 DNC NC program management

General

DNC manages and archives NC data and transfers it to CNC machine tools. DNC
is the interface between production planning and production and offers a wide
range of functions for NC data management and version management.

Operating system

DNC runs on standard PCs with Windows.
Database

The NC data is managed in a database.
Controller connection

Controllers are connected to DNC via a machine server. A special machine server

is required for each connection type.

e DNC provides a machine server (DNC IFC Serial) for connecting any required
controllers via a serial interface that do not support a special protocol.

e DNC IFC SINUMERIK runs on SINUMERIK* controllers and integrates them in
the network.

e The file system machine type can be used to transfer NC data from and to
any network drives that have been released. Any network-capable NFS (with
additional software, such as Microsoft SFU), SMB or CIFS controller that runs
on Windows can be connected to the DNC system. A DNC IFC file system
license is required for this connection type.

¢ Any of the machine servers can also be used to establish connections with
controllers with different interfaces (e.g. OLE/COM, or special serial protocols).
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1.2 Fields of application and system variants

DNC is deployed in all industry sectors with CNC production and allows local
solutions to be scaled as required with DNC Cell through to plant-wide solutions

with DNC Plant.

1.2.1 DNC Plant

DNC Plant DMC HMI
e.g9. on NC programming

8 =*

-—
/__,4 ~ = e
%" Ethernet PC terminal

SINUMERIK 840D/840D1/810D/840Ds1

Serial CHC machines linked with
and other Ethernet-compatible CNCs

a PC terminal or with ComServers

Fig. 1-1: Configuration example of DNC Plant

DNC Plant is a powerful, central NC data archive that allows you to manage your

NC data easily on a server.
Several hundred CNC machines can be connected to DNC Plant either directly or

via station PCs. DNC Plant contains a user interface.
With DNC HMI, you can extend DNC Plant to include additional operator stations,
for example, for the foreman’s office or for NC programmers.

This is the server variant of DNC.

© Siemens AG 2010 All Rights Reserved
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Station PCs

The machine servers and a user interface for transferring the NC data run on the
station PCs.

Networking

The following can be networked with DNC Plant:

¢ Any number of serial CNC machine tools
e via station PCs (up to 16 connected to one station PC)
e via a serial/Ethernet interface converter (so-called COM server) with

DNC IFC Serial

e Programming systems

o Tool setting devices

¢ Any number of SINUMERIK* controllers with DNC IFC SINUMERIK
(transmission protocol: TCP/IP) via direct connection.

e PCs with DNC HMI as operator stations of DNC Plant.

¢ Any Ethernet-capable CNC machine tools that can be supplied with NC data
via a Windows file system

Additional expansion options

MCIS DNC can be combined and expanded with additional MCIS modules.

The shared database is extended here to include module-specific components.
Existing, shared components, such as user administration and the machine nodes,
are detected when additional modules are added.

1.2.2 DNC HMI

With DNC HMI, you can extend DNC Plant to include additional operator stations
for managing NC programs. DNC HMI is used on Windows PCs, for example, in
production planning and production. Serial machines cannot be connected to these
PCs, however.

1.2.3 DNC on terminal server

DNC Plant can also be installed on a Windows terminal server instead on "real"
installations on Windows PCs. All the PCs connected then access the server via a
terminal server session and activate their respective DNC instances assigned for
their terminal server client (e.g. DNC HMI, DNC station or DNC tool setting device).
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1.2.4 DNC Cell

NC programming
workstations

/:/
o Ethernet

DNC Cell

up to 16 serial SINUMERIK 840D/840Di/810D/840Dsl
and other Ethernet-compatible CNCs

up to 16 serial CHC machines

Fig. 1-2: Configuration example of a local DNC concept (DNC Cell)

DNC Cell is a single-user NC data archive solution that facilitates NC data
management.

Interfaces

e Up to 16 CNC machines / tool setting devices can be connected to different
controllers by means of a serial interface.
e Over the network (transmission protocol: TCP/IP), up to 16 Ethernet-capable
CNC machine tools can also be connected directly.
¢ SINUMERIK* controllers via DNC IFC SINUMERIK
e Any Ethernet-capable CNC machine tools that can be supplied with NC
data via a Windows file system (DNC IFC file system).
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1.2.5 DNC IFC SINUMERIK

DNC IFC SINUMERIK is used to connect Ethernet-capable CNC machines with
SINUMERIK* to DNC Plant or DNC Cell.
See also: Manual 2 DNC IFC SINUMERIK

1.2.6 DNC Compare

DNC Compare is an option package. With DNC Compare, DNC Plant and DNC
Cell can be extended to include the following functions:
e NC program comparison

Different NC program versions are compared.

Differences are highlighted in color.

& rilecompare [_ (O] x|
'MPF.DIRW1_6.MPF P1_6.MPF
1 %_W_F1_MFF 1 %_N_F1_MFF ﬂ
2 SPATH=~_H_HWPF DIR 2 ;$PATH=~_H_HPF DIR

3 N0 E_HEAD({ 268439551 .0..0..0..150..
3 N0 E_HEAD(268439551. 0..0..0..1
4 NS E TS{"FRAESERZ0", "FRAESER10".1.| 4 NS E TS{"FRAESERZ0", "FRAESER10
5 M10 G0 90 X-12. ¥-12. ;#5H 5 Hi0 <0 G980 X-12. ¥-12. ;#CH
& M15 G0 G90 Z-5. #5H g NiE &0 G990 Z-5. :#5M
7 N20 Gl G90 G41 XS5. ¥5. G94 Flaoo. | 7 N20 G1 90 41 E5. ¥5. G994 F10
g N25 G111 X30. ¥75. ;#5M a N25 G111 X30. ¥75. ;#5M
9

9 W30 Gl RP=20. AP=17%. #SH W30 G1 EP=20. AP=176. #SH
10 W35 G2 AP=90. :#SM
11 W40 Gl G90 X120. ;#SM 10 40 G1 G30 X120, #SH
12 W45 G111 E120. ¥75. ;#SH 11 45 G111 ¥120. ¥75. #SH
13 HEO G2 AP=4. #SH 1z NS0 G2 AP=4. #SM
14 W55 G1 G90 X145, ¥5. #5M 13 W55 =1 G90 X145, ¥5. #5M
15 W&0 Gl G90 X-20. ;#SM 14 W60 G1 GI0 X-20. #SH
15 H30 #SH 15 H30 #SH
4 KN k|
0K | 4 NEXT | 9 PREV ipranl | Print all | Print diff. |
| Leftonky | Mowed | Right Only [TotalLines : 17 [piFF: 3 [ v

Fig. 1-3: Result of an NC program comparison

e Machine comparisons**:
The system checks whether the NC programs in the SINUMERIK* controller
are identical in terms of name, number and content to the programs that are
already managed by DNC Plant/Cell.

** This function is only available for connections to SINUMERIK* controllers with
PCU50/70. DNC IFC SINUMERIK must also be installed on the SINUMERIK
controller.

Note

The DNC Compare option package can be released in DNC Admin by entering
an 8-digit ID at Tools > Options. The ID is included in the scope of delivery of
the option package.

DNC Compare is only required once per DNC Plant/Cell.
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1.2.7 DNC IFC Serial

With DNC IFC Serial, you can connect CNC machines via a serial interface to
DNC Cell or DNC Plant or to the station PC.

Note
DNC IFC Serial is required for each serial CNC machine.

1.2.8 DNC IFC Dialog (dialog function)

DNC IFC Serial can be expanded with DNC IFC Dialog.

It enables the operator input for the download or upload of machining programs
directly on the CNC.

Dialog programs for requests (created via an editor) and responses are exchanged
between DNC and the machine server. These contain the data relevant for the
download or upload.

Note
DNC IFC Dialog is optional for each serial CNC machine.

1.2.9 DNC IFC file system

DNC IFC file system can be used to connect any CNC machine tools that can be
supplied with NC data by means of an NFS (with additional software, e.g. Microsoft
SFU), SMB or CIFS file system via an Ethernet network.

Programs are transferred via the DNC or HMI computer, or via a station PC.

In addition, a SINUMERIK with PCU20, for example, can be integrated via the DNC
IFC file system.

1.2.10 DNC Machine

DNC Machine is a basic Ethernet solution for networking SINUMERIK* controllers.
DNC Machine provides a user interface on the SINUMERIK controller via which
NC programs can be transferred between the file system and SINUMERIK
controller without the need for additional software components.

Note
DNC Machine can be used independently of MCIS DNC Plant or Cell.

SINUMERIK*: SINUMERIK 810D
SINUMERIK 840D
SINUMERIK 840Di
PCUS50 under Windows with SINUMERIK 840D sl
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2 Plant structure

2.1 Plant topology

Group

The plant topology shows the physical circumstances and conditions of the
machines with the NC data storage system and their hierarchical structures in
MCIS DNC. DNC offers the following hierarchical levels for mapping production:
e Groups

e Machine

DNC contains the "workpiece" folder for bundling the NC data for a workpiece.

8 machine
ED group & warkpiece
=] area

rnachine

R SIMUMERIE

=1 group

Fig. 2-1: Possible plant structure configuration

NC data management allows basic and detailed hierarchical levels to be created by
means of the group hierarchical level. For example, you can combine several
machines of the same type into one group. You can then subdivide these groups
further into subgroups. You can also manage individual items of NC data and
workpieces within each group.

Machines can also be created without a higher-level group.

Note

You can insert groups by choosing File > New - Group. Depending on the
selections you made in the tree view, you can insert groups before or after the
current hierarchy level. To insert groups one hierarchy level lower, choose
File > New - Subgroup.

© Siemens AG 2010 All Rights Reserved
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Machine
Machines are the lowest administrative unit. Each logical machine represents a
physical CNC machine and functions as a container for NC data and workpieces
that belong to this machine only.

Workpiece

The workpiece administrative unit is used to manage related NC data together. All
of the NC data required for performing an operation on a CNC machine can be
stored in this management unit, for example.

You can also bundle NC data for a workpiece and send it to the CNC machine.
The SINUMERIK* controller itself can manage workpieces, which means that
workpiece-related NC data from DNC can be stored on the controller in the same
form.
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NC data

DNC is, in principle, capable of administering all NC data types. The following data
types are predefined in DNC:

MPF (Main Program File)
SPF (SubProgram File)
TOA (Tool Offset Active)

ZOA (Zero Offset Active)
BMP (BitMaP)

WPL (WorkPLan)
RPA (R-Parameter Active)

JOB (JOBs)

ARC (ARChive)

INI (INItialization program)

COM (COMment)

AWB

LST (display LiST)

TOP (TOol Plan)

CEC

EEC

QEC (Quadrant Error Compensation)
PDF (Portable Document Format)
JPG (Joint Photographic Experts Group)
TIF (Tagged Image File)

WPD (WorkPiece Directory)

TTD (Tool Target Data)

Main NC program

NC subprogram

Tool offsets /

actual tool data

Zero offset

Graphics file for clamping sketches
etc.

ASCII file for tool plans

Memory area in the NCK for
R-parameters

Job list

Archives

Initialization program

Comments

Display description

Display list

Tool plan

Sag/angularity

Measuring system error compensation
Quadrant error compensation
Text and graphics in PDF format
Graphics file

Graphics file

Workpiece directory

Tool target data

The above data types are predefined in the MCIS database. The editor assigned in
Microsoft Explorer is used for each NC data type.

In addition to conventional NC data (main NC program and subprograms, tool
offsets and zero offsets), special NC data (e.g. graphics files and tool lists) can also
be processed. These data types are available in the SINUMERIK* controller.

Note

New NC data types must be made known to the system by means of the
appropriate entries in the database table DNCDATATYPE.

If a special editor is required for the new data types, it must be assigned via

Microsoft Explorer or via the registry entries in MCIS DNC. See also: Microsoft
Windows help (Start 2 Help) under the index: "File types".

FBDN1/2-24
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Link

A link allows you to view any directory in a file system. You can display all the files
of any data type or just a specific file type. This provides you with a direct view of
the NC data of other networked systems (e.g. NC programming systems). DNC
does not maintain any administrative data for these files; you can only display the
information in the file system.

Links can be integrated at any level of the hierarchical NC data structure.

Note

Links only allow you to view the objects directly underneath. Subdirectories
cannot be displayed.
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2.2 DNC functions on hardware components

2.2.1 DNC Cell computer

With the local variant DNC Cell, the DNC Cell computer performs the following
tasks:

NC data management in the MSDE database or SQL Server
User data management in the file system

Data maintenance and management

Configuration

Import

Export

Data transfer to and from the CNC machine tools

User administration

Data filter management

Logbook filter management

Comparison of NC programs

Automatic archiving of NC data on the SINUMERIK* controller (optional)

2.2.2 DNC Plant computer

With the DNC Plant variant, the DNC Plant computer (server) performs the
following tasks:

NC data management in the MSDE database or SQL Server (optional: Oracle
database)

User data management in the file system

Central data maintenance and management

Central import functions

Central configuration

User administration

Export

Import

Data filter management

Logbook filter management

Comparison of NC programs

Automatic archiving of NC data on the SINUMERIK* controller (optional)

The DNC user interfaces can run on terminal servers/clients.

2.2.3 DNC HMI computer

With the DNC HMI computer, the DNC Plant variant can be extended to include
additional user interfaces.

FBDN1/2-26
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2.2.4 Station PC

With the DNC Plant variant, the following activities are carried out on the station
PCs:

Configuration of the connected machine interfaces

Data maintenance and management for the connected machines

Data transfer to and from the CNC machine tools

Comparison of NC programs

2.2.5 NC programming system

NC programming systems can be integrated in the DNC network to transfer NC
data. NC data can be imported into the management structure of DNC by NC
programming systems integrated in the network. No MCIS software needs to be
installed on the programming system computer for this purpose. The DNC HMI
software can, however, be installed on an NC programming system in order to
operate the DNC system. If the DNC HMI workstations are configured accordingly,
the controllers can be accessed directly.

2.2.6 Tool setting device terminal

If you want to integrate a tool setting device in the DNC system, an additional DNC
workstation is required (currently only possible with DNC Plant).
The setting device is a separate DNC installation on a PC.

Tool setting devices can be connected to DNC as follows:

e Via the serial interface
e Via the file system

The tool offset data is transferred from the tool setting device to DNC by means of
an upload on the tool setting device terminal. The appropriate file must then be
transferred from DNC (not from the tool setting device terminal) to the CNC
machine tool.
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2.2.7 Controller

SINUMERIK*

In addition to the active memory containing the NC data to be processed on the
machines, SINUMERIK* controllers also feature a passive memory on the PCU50
or MMC. NC data in the form of NC programs, tool data or zero offset data, for
example, can be stored here. This allows NC data to be made available before
production starts. DNC IFC SINUMERIK connects the controllers to DNC via the
network. NC data can be downloaded and uploaded to the controller on the
SINUMERIK operator panel.

Controllers with serial interface

Controllers with a serial interface can be connected to DNC Cell/Plant or station
PCs directly or via interface converters (COM server). For this purpose, the serial
interface (machine server) must be configured for each CNC machine tool. NC
data is transferred to the controller via the interface of the associated station.

SINUMERIK*: SINUMERIK 810D
SINUMERIK 840D
SINUMERIK 840Di
PCUS50 under Windows with SINUMERIK 840D sl
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3.1 Explorer layout for DNC and DNC Admin

The DNC user interface is based on Windows with regard to its functionality and
how it is handled. You can work through the dialogs using the mouse or keyboard.
In addition to the menus, the interface includes a toolbar containing all the key
functions and a status bar for messages.

Operators must log on. Operators are authorized to use different functions
depending on the user rights assigned to them.

There are two user interfaces:
e Userinterface for NC data management (DNC Explorer)
e User interface for administration (DNC Admin Explorer)

3.1.1 Explorer layout

#+ DNC - Terminall

File Edit View Ogtionz Machine Alignment Help
Jﬁléﬂﬁh—}(ﬁuﬁnﬁumer MPF =]
J |F'n:ugram tupe |=— IMPF

J = Icylinder-head

| | Mame | Tupe | e, | Hele...l Tiial... | Length

E|{:| area mokorz 0 0 a7
@3 group 6 yinders Motor_z2 MPF 3 0 0 7463
[, rachire 33-fr
- machire 34-sp
- rnachire 33-it
----- machire 44-en
iy machire 43-dt
B group 8 cyinders
rmachire 1
o machire 2

=] area gear = a1 | H
| I

Fig. 3-1: DNC user interface

The user interfaces for DNC Admin and DNC differ only very slightly. Each of the
programs does, however, have a number of additional, different functions. See
also: Chapter 10 Configuration.

The screen is divided into two sections.

e Asin Windows Explorer, the left side of the screen shows the tree structure for
all the DNC administrative units in the plant configuration, starting with the root
to the groups (subgroups), links and individual machine. Selected units are
highlighted in color.

e The right side of the screen contains a list of all the subordinate elements (NC
data, etc.) for the unit selected on the left. In addition to the file name, the size,
type, creation date, etc. of the units are displayed. You can configure the list
display using the list editor.

The area above these two panes contains the address field, the filter field as well
as the toolbar and menu bar. The status bar is displayed at the bottom of the
screen.
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Menu bar

*

** Available in DNC only

*** Available in DNC only and only under machines with the option "DNC

Compare".

Table 3-1: DNC and DNC Admin menu

3 Operator interface

Available in DNC Admin only (New->... in configuration mode only)

. . . Machine
File Edit View Tools Comparison™* Help
- . * . *kk HEIp
New b | Cut CTRL+X | Configuration Settings... Compare Topics
Open Copy Sl Logbook Display Result *** About
Open... cmo | Ci | NG Data ** L Di A
Print Preview | Paste e | Eilter Editor User Administration * Individual .NC D*eza
Comparison
Print...  cme | Delete o | Filter On/Off - | Consistency Check * Archive
Import... Properties f Toolbar List Editor * Dlsplay*ﬁrchlve
Result
Export «n» | Reset Release ID Sgartus Screen Editor *
Transfer **« Split Options... *
Upload ** Refresh List .~ | Config. Tables
Compare... User for Editor
Logout... Display All My
Machines
Exit
Table 3-2: DNC and DNC Admin file=> New context menu
File
New NC Data... P
Workpiece...
Group... *
Subgroup... *
Machine... *
Setting Device
Link... *
Table 3-3: DNC Admin Tools = Config. Tables context menu
Tools
Config. Tables | b\ cGLOBALSETTINGS *
DNCMACFG *
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Toolbar
SRR ET T dib
Fig. 3-2: Toolbar on the user interface
The toolbar contains icons for the following functions:
e Open
e Cut
e Copy
e Paste
e Back (for workpieces)
e Delete
e Properties
e Download
e Upload
o Filter (on/off)
e NC Package Viewer (only available in conjunction with Siemens PLM Team
Center)
Filter bar
J Filter IINC-F’IDglamme ;I
Fig. 3-3: Filter bar on the user interface
The filter bar indicates which filter is currently selected. It can also be used to
select other predefined filters. The switch position of the filter icon in the toolbar
indicates whether the filter is currently activated or deactivated.
When you choose Filter, a dialog is displayed in which you can add or change
filters in the filter editor (View - Filter Editor).
© Siemens AG 2010 All Rights Reserved
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Quick filter bar

J |F"ru:ugram ype |= IMPF

Fig. 3-4: Quick filter bar on the user interface

The quick filter function allows you to change a filter value without having to call up
the filter editor.

Once you have selected a filter, the first filter condition of the current filter is
displayed in three fields in the toolbar area. The first two fields contain the field
name and operand, while the third field, which can be edited, contains the current
filter condition value (see also Section 3.2. View filter).

Note

The value of the filter condition is treated in the same way as a value with a
wildcard, although the wildcards are not displayed in this field.

Example:

Program name = A

means that the system filters according to program names that contain "A"
(e.g. Program1, Appl_1, 135_A_xzy).

Program name = A*

means that the system searches for program names that begin with "A"

(e.g. Appl_1, 135_A_xzy ("Program1" will not be found in this search because it
does not begin with "A")).

Address bar

The address bar contains the following information:
e The name of the workpiece when the workpiece directory is open
e The link path when the link directory is open

| & |eylinder head
Fig. 3-5: Address bar when the workpiece directory is open

| Adresse  [CAPGPlatay: -

Fig. 3-6: Address bar when the link is open
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Status bar

The status bar contains explanations of the menu items and icons. Message and
error texts are also displayed here.
As well as the number of entries in the list display.

Note

Important error messages are output in a separate message window. These
messages must be acknowledged by the operator.

The following messages are displayed in the status bar:

e Results of processes that occur at unforeseeable times.

e All messages that occur as a result of actions carried out within the dialog
function, i.e. if there is no guarantee that an operator can acknowledge the
messages on the computer.

¢ Information that does not require immediate action on the part of the operator.

The following messages can be displayed in a separate message window:

e Messages that are a direct response to user actions and require a response
from the operator.

o Fatal system errors that prevent the operator from continuing to work properly.
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3.1.2 Display formats

DNC and DNC Admin feature two display formats. The normal display is designed
for use on PCs in areas outside the workshop. The large display is designed for
use in the workshop.

Normal display

The user interface is displayed in the standard Windows dimensions.
Large display

The icons in the large display are twice as big as those in the normal display, and
the text is enlarged.

The large display is designed for use in workshops so that the interface can be
read from a distance.

&+ DNC - Terminall I =] e
File Edit “iew Options Machine dlignment Help
G cowo | ) cioix crve B ooy | @@ abse X pel Fe gMEOF:  Elmrs
Open Cut Copy Paste Back Delets Properties  Download Upload
| Fiter — [MPF =]
J Adresse
g = | Name |T pe | \/ersion| Release... |Tria|... | Length
E. motors 3 0
ECI group 6 cylinder: || |==| fine-grinding-cycle  MPF 5 0 0 7490
......... machining 1 % Picturel MPF 7 0 0 710
......... rmaching 49| % Picturel MPF 3 1 0 1084
......... maching 4e ;‘E To MPF 4 0 1 60
--------- machine 8¢ | =] valve-cylinder-head MPF 5 i i 96
ED group § cylinder: ;_ o2 MPF 4 1 0 60
--------- g machine 3¢ | S cyinder-head MPF 2 0 0 40018
TI
[ B [ 7

Fig. 3-7: Large display of the user interface
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3.1.3 Operation

You can work with the DNC and DNC Admin explorer in the same way as other
Windows applications using the mouse and keyboard.

The most important functions can be called up via the function keys:

Properties
Download

Upload

Refresh List
Switch Screen
Use Filter

3.1.4 Languages

F2
F3
F4
F5
F6
F7

The languages of the DNC and DNC Admin user interfaces can be switched in line
with the language of the user.
The language can be switched under Tools = Settings while the system is
running. The following languages are available:

GR
FR
IT

SP
UK
CH
RU

- German
- French
- ltalian
- Spanish
- English
- Chinese
- Russian

Note

In Chinese and Russian DNC systems, the online help is displayed in English.
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© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition



05.07

DNC Plant/DNC Cell (FBDN1)

3 Operator interface

3.2 View filter

General

To display a filtered view of the files on the right of the interface, choose View >
Filter On/Off. When the filter is activated, DNC displays only a selection of the NC
data that is relevant to the user.

DNC can filter the NC data using the administrative data. The only exceptions here
are the comments. Texts within the NC data comments cannot be filtered.

The filter icons in the toolbar indicate whether the filter function is activated or
deactivated.

v v

Filter activated Filter deactivated

!{.-_ DMC - Terminall
File Edit “iew Egtraz Machine alignment Help

& 4 BR « X Sdnan ¥V

| Fiter  [MFF d|

J |F'n:ugram type |= IMF'F
J.ﬁ.ddress |
: E| l:l group B cylinders || Mame | z | Type | Wi | Releaze .
machining centre
machine 49_dt
machine 44_en
= linder-head
machine 39 it gcy il
ter

Fig. 3-8: Example of unfiltered view

,r_ DHC - Terminall [_ (3] =]

File Edt “iew Estraz Machine aignment Help

[ E| 4 B« XS doan 7

| Fiter  [MPF |

J |F'ruglam tupe |= IMPF

J Address I

' EI |:| group B cylinders 4| | Mame EENET S | [
machining centre [} 5-valve-cylinder-head
man:!hﬂ ii_rlr . Z] walve-cylinder-head MPF 2 1
machine 44_en & cylinder-head
rnachine 33 _it
ter

Fig. 3-9: Example of filtered view (in this case "MPF")
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Generic filtering

You can use the generic filter to search for specific files in the tree display on the
left.

All NC data recorded in DNC and which fulfills the filter conditions is displayed
when the filter is activated.

To create a filter, click the root of the tree display on the left and then activate your
filter.
Files in links are not displayed!

Note

In the case of large plants, a maximum of 1000 items of NC data can be
displayed to prevent the user from having to wait too long. For this reason,
choose a suitable filter so that only the relevant NC data is displayed.

The Workpiece administrative data is only relevant with the generic filter. Under
normal circumstances, no NC data is displayed if "Workpiece" has been defined
as a criterion for the filter.

The list display of the generic filter is defined in the "GLOBAL" display group. If
this display group does not exist, the standard list display is used (for more
information, see "List editor").

!F}_ DNC - Terminall

File Edit Wew Opdons Machine Alignment  Help

J qu'| 3 2] | = X ﬂ]] ﬁul? |J Filter IFiIter d-yalve-cylinder-head j

J Address Il:loss-area filker activated

Eﬁ Mame | Type | Wersion | Release II:II Macine |
E”:l g 4-walve-cylinder-head MPF 7 0 Maszhinest
E‘&: 4-valve-cylinder-head MPF ] 0 Maszhines
4-valve-cylinder-head MPF 5 0 Mas-hined
4-valve-cylinder-head MPF 4 0 Maschined
4-valve-cylinder-head MPF 2 0 Maszhines
4-valve-cylinder-head 2000 MPF 1 0 Maszhined

[l W
& MM .

Fig. 3-10: Generic filtering
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3.2.1 Creating or changing filters

Adding or changing filter criteria

To call up the filter criteria dialog, choose View - Filter Editor... (see below).

MPF-Filter H|
Field name | OpeEr... | value |"| (]9 I
[l Tvpe = MPF -

Cancel |
F=ilter selectiu:unl

[ et
[Ehange |
Accept |
] [Delete |

Field name: Operand: Walue: E ditable:

Tupe j |= j IMF'F O ﬂl

—|{Marne -

Releasze- D

Trialcut-10

T une

Werzion (=
“Workpiece st

Fig. 3-11: Filter criteria dialog — new criterion

Note

If a filter has not yet been defined, the Edit Filter dialog is displayed so that you
can create a new filter (see also the next section but one).

Using the Change and New buttons, you can activate the three fields at the
bottom, after which you enter or change the filter criterion.

To select the active filter whose filter criteria are to be changed, choose Select
Filter.

If several criteria apply for the filter, you can sort these using the Up button. This
only provides a better overview and does not have any functional significance.
Since all of the criteria are ANDed, all of them must always be fulfilled.
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In Field Name, you can choose one of the items of administrative data of the
respective NC data.

In Operand, you can decide how you want to filter your NC data with the field
name you have chosen. The following options are available:

Table 3-4: Filter operands

Operand | Description

= Equal to value
<> Not equal to value
< Less than value
> Greater than value
<= Less than or equal to value
>= Greater than or equal to value

Caution

Before you change a filter, make sure that you have selected the correct filter in
the Select Filter dialog. You can check this in the title of the dialog for the filter
criteria (see above).

You can also use wildcards in the Value field. The following wildcards are
supported:

Table 3-5: Wildcards

DOS SQL Description |Examples

wildcards |wildcards

* % Several c* cylinder_head, coil_plunger
arbitrary %A TOA, ZOA, RPA
characters

? One arbitrary | ?PF MPF, SPF
character 0 TOA, ZOA, JOB

Note

The meaning of the DOS wildcards is the same as that of the SQL wildcards.

Wildcards are sent to the database as "like" queries. This means that the same
filter can have a different effect on different databases (MSDE, ORACLE, etc.)
depending on how these are configured. One example of this is the use of upper
and lower-case letters. The filter can also react differently depending on how the
wildcards or data fields are used.

© Siemens AG 2010 All Rights Reserved
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Once you have entered your criterion, choose Accept.

The checkmark in the checkbox in front of the filter criterion indicates that this
criterion has been activated. If this checkmark is not displayed, this criterion does
not affect the filter.

Important

All the filter criteria are linked by means of an AND operation. This means that
criterion 1 AND criterion 2 AND criterion x must be fulfilled for the NC data so that
this can be displayed. A plausibility check is not performed.

Editing the filter criteria directly

When the Editable checkbox is activated, the value can be edited directly in the selected filter criterion
without needing to make the necessary changes via Change and Accept.

MPF

®
[
-~

L]

Field name | OpET... | walue
Program type = ZMPF

Cancel

Filter zelection

Few
Change

Accept

Delete
Field name:; Operand: Walle: E ditable:

Programmtyp j I = j IMF‘F = IJpward

ddi

Fig. 3-12: Editing the filter criteria directly
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3.2.2 Saving the filter criteria

When you choose OK, a message window containing various options for saving
the filter criteria is displayed. The following options are available:
e Save criteria:
The filter criteria are saved and are provided in this form in subsequent
sessions.
¢ Do not save criteria:
The filter criteria are changed online, but the values are not saved. They
will not be available in this form in subsequent sessions.

Selecting the filter

You can call up the Select Filter dialog by choosing View - Filter Editor... >
Select Filter (see below).

Filter selection |
Filter name | dizplay group | LizEr | gkation |
SPF-Fiter GROURAD OMC M achinel

ROUPEIG M aching]
Filter_4711 GROUPAD DHC achinel
Filker_3378 GROUPEIG helper b achined
|sh|:|wing only MPF-files
] I Cancel Chanhge Mew Copy Deete

Fig. 3-13: Select Filter dialog

FBDN1/3-42

Note

If a filter has not yet been defined, the Edit Filter dialog is displayed so that you
can create a new filter (see also the next section).

The dialog for the filter criteria appears with the selected filter when you choose
OK. This selected filter is then active. The filter that is currently active is
displayed in the title of the dialog.

You can open the Edit Filter dialog by choosing New, Change or Copy.

When you choose the Copy function, the filter criteria of the copied filter are
accepted.
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Creating a new filter — general filter data

Choose the following:

View - Filter Editor... > Select Filter > New or

View - Filter Editor... > Select Filter > Copy or

View - Filter Editor... > Select Filter > Change to open this dialog (see below).

MPFFilter |
Filker narme:
W PF-Filke

Comrett;
IShnws orly MPF-Files

Display group: Station:
|GROUPAD x| |Machine?
IJser name:
IDNE

(] 4 | Cancel

Fig. 3-14: Edit Filter dialog

Note

The filter name must be specified. The Comment field is optional. The other fields
can be used to specify who can use the filter. If you enter a station, the filter can
only be used on this particular station.
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If you make entries in several of these fields, it is possible that nobody will be able
to use this filter because the information you have entered is inconsistent. For this
reason, the Display group, Station, and User name fields can be deactivated by the
administrator. In this case, the ASSIGNEDFILTER=0 parameter in the
DNCGLOBALSETTINGS database table must be set.

Note

It is important to note here that existing filters that are assigned to particular
display groups, stations or users and that are to be modified in "inactive" mode
are displayed without the assigned display groups, stations or user names. The
old assignments are deleted when you save the filter. If you exit the dialog with
Cancel, the old assignments are retained.

Confirming the filter with OK opens the Select Filter dialog again. The new filter
must be selected and confirmed there in order to add the filter criteria.
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3.2.3 Examples of the view filter

Filter criteria

Filter_ 4711 H|

Field name | OpEr... | wvalue | : | Ok I
O Name = Edx C |
O Mame = cE e —lance
FeleaseD = 1 X - :
[ version ve 2 Filter selectu:unl
O Type b= SPF *
MHew
Change |
Serept |
Delete |
Field name: Operand: Walue: editahle:
Name R E EREE v wl

Fig. 3-15: Filter Criteria dialog — example

This filter has a large number of filter criteria, although not all of them are active.
The checkmarks in the checkboxes in front of the filter criteria indicate which
criteria are currently active.

All the following examples refer to the filter in the figure above and are
activated/deactivated one after the other. The title of the example indicates which
of these criteria has been activated. All the other criteria have then been
deactivated for this example.
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Output data without filtering

#+ DNC - Terminall M=l E3

File Edt “iew Estras Maching alignment Help

B Bl « X Sdnan VY

| Fiter — [MPF [~
J Address
E MHame I 3 I T_I,Ipel VersiDnIHeleaseld.I Trialcutid| Length I
ElD graup & cylin cail_plunger
""" B TEMP ) linder_head EMP 1 1 0 1999
machini |[%] cylinder_head MPF 3 1 1137
{ mach!ne cylinder_head MPF 2 1] 0 1248
i mac:!”e cylinder_head MPF 1 0 o 1139
sl MACAINE N Clinder_head SPF 1 0 0 1139
“Welcome to DHCWT-2000 = MPF 1 n 1] 1]
KN IR
Fig. 3-16: Output data without filtering
Example 1: Program name = c%
Mame [ = [ Type| wersion | Release 1d.| Trisloutid| Length

col_plunger

cylinder_head
cylinder_head
cylinder_head
cylinder_head
cylinder_head

BMP
MPF
MPF
MPF
SPF

— g D —

1 0 1899
1 1 1367
1] 0 1243
1] 0 1139
1] 0 1133

Fig. 3-17: Filtering for the output data with filter: Program name = c%

DNC now displays all the NC data that starts with the program name "c". The
remainder of the program name is irrelevant, which is why the wildcard "%" is used.
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Example 2: Program name = %d%

M arme | = | Tupe| wersion | Release 1d.| Trialcutid| Length
cylinder_head BrF 1893
@ cylinder_head MPF 3 1 1 1367
cylinder_head MPF 2 1] 0 1248
@ cylinder_head MPF 1 0 0 1139
@ cylinder_head SPF 1 1] o 1133
] welcoms ta DNC = MPF 1 0 0 i

Fig. 3-18: Filtering for the output data with filter: Program name = %d%

The system now displays all the NC data that contains a "d" in the program name.
No distinction is made between upper and lower case, which is why "Welcome to

DNC" is also displayed. This is a database setting, however, and may be different
in your database.

Example 3: Version >=2

M ame | " | Type | "v"ersicunl Feleasze I|:|.| Trialu:uti-:ll Length
cylinder_head kPF 3 1 1 1367
cylinder_head M PF 2 n 0 1248

Fig. 3-19: Filtering for the output data with filter: Version >= 2

The system now displays all the NC data that has Version 2 or higher.

Example 4: Program type >= SPF

M arne | # | Tupe | Wersi.. | Relzaseld.| Trialcutid] Lergth
Chapeau-rand-standard 1 I
Cycle-filetage-B11 SPF 1 ] n E1
@ Cycle-foiage-chapaauis12 SPF 1 ] 1] EQ
Toaldata TOA 1 0 0 0
Up *  GFF 2 0 0 24528

Fig. 3-20: Filtering for the output data with filter: Program type >= SPF

The system now displays all the NC data for which the program type follows
"SPF" (alphabetically). This is why the NC program of type "TOA" is also displayed.
Since the criterion was set with greater than or equal to, both the SPF and TOA
program are displayed.
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Filtering by date in Oracle databases

Date Oracle E3

Figld 1ame | OpEra... | walue | . (] 4 I
Frogram name = EMaE C i
O workpiece = X 4 &l
Program  type = EE -
O Date modified > spsdate - 2 Selec: Fiter |
O Date modified 2007-03-23
O CDatc modified 2007 02 2212:20:00 Mew |
iDate modified > to_date('23.03. 2007 "D 0. MM ™) :
Change |
Arcept |
; Dekte |
Field Marme: Operand: W alue: E ditable:
EE o] |re_dale[2313.2007.DD.MMY [ Lp |

Fig. 3-21: Filter Criteria dialog for date in Oracle databases

Note

The date format depends on the setting in the database. For this reason, the date
must be entered in the format required by the database since it cannot be
converted.

Example 1: "Change date > sysdate - 2"

The sysdate function allows the current date to be output in Oracle. The filter
criterion Change date > sysdate - 2 returns all the DNC data records whose
change date is no more than two days ago. The sysdate function allows the system
to filter data on a relative basis, e.g. according to changes made over the past few
days (two days in the example provided here). This means that you do not have to
specify an absolute date in a particular date format.

Example 2: "Change date > 2007-03-23"

In this example, all the programs whose change date is after 03/23/2007 are
displayed. The correct date format must be observed here. The default setting in
Oracle is the ISO format:

YYYY-MM-DD. The format should be checked beforehand when this filter criterion
is used. It is based on the settings for the Oracle parameter NLS_DATE_FORMAT,
which is set by the database client.
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Example 3: "Change date > 2007-03-23 12:30:00"

In this example, all the programs whose change date is after 03/23/2007 12:30:00
are displayed. The correct date format must be observed here. The default setting
in Oracle is the ISO format: YYYY-MM-DD HH24:MI:SS. The format should be
checked beforehand when this filter criterion is used. It is based on the settings for
the Oracle parameter NLS_DATE_FORMAT, which is set by the database client.

Example 4: "Change date > to_date('23.03.2007','DD.MM.YYYY")"

In this example, all the programs whose change date is after 03/23/2007 are
displayed. The to_date function also allows the specified date format to be
explicitly communicated to the database. The benefit here is that the entry is
independent of the preset formats. In some cases, the system may not return any
hits if the format has been entered incorrectly.

Note

This function should also be used when the system filters according to an
absolute date if the filter is created for both DNC HMI and DNC IFC SINUMERIK.
They can be applied universally in this form (as with the sysdate functions).
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Filtering by date in SQL Server /| MSDE databases

Date SOLServer

E3
Field 1ame | OpEra... | walue | . (] 4 I
Program name = H343%
O ‘workpiece = B 4 ﬂl
Program  tepe = EE
Diate modified > ettt Selec: Filker |
O Datemodified 2007-03-23
O CDatc modificd  » 2007-02-27 12:20:00 New

Change

Aocept

; Dekte
Field Marme: Operand: W alue: E ditable:

j I % j Igetdate[] -2 ~

Fig. 3-22: Filter Criteria dialog for date in SQL Server / MSDE databases

=

dalll

Note

The date format depends on the setting in the database. For this reason, the date
must be entered in the format required by the database since it cannot be
converted.

Example 1 "Change date > getdate() — 2"

The getdate() function allows the current date to be output in SQL Server. The filter
criterion Change date > getdate() - 2 returns all the DNC data records whose
change date is no more than two days ago. The getdate() function allows the
system to filter data on a relative basis (e.g. according to changes made over the
past few days (two days in the example provided here)). This means that you do
not have to specify an absolute date in a particular date format.

Example "Change date > 2007-03-23"

In this example, all the programs whose change date is after 03/23/2007 are
displayed. The correct date format must be observed here. The default setting in
SQL Server is the ISO format:

YYYY-MM-DD. The format should be checked beforehand when this filter criterion
is used.

Example "Change date > 2007-03-23 12:30:00"

In this example, all the programs whose change date is after 03/23/2007 12:30:00
are displayed. The correct date format must be observed here. The default setting
in SQL Server is the ISO format:

YYYY-MM-DD HH24:MI:SS. The format should be checked beforehand when this
filter criterion is used.
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3.3 User-specific tree view

To display all of the other machines that the logged-on user is permitted to view,
choose Tools - Display All My Machines.

In the case of users who do not have an explicit machine assignment, all of the
machines in the DNC system are displayed.

In the case of users to whom at least one machine has been assigned via the
explicit assignment, all the machines assigned are displayed for this user and not
just the machines that the user is permitted to view on the station he is logged on
to.

See also: Section 5.2.4 "Machine list for a user”

Example

Secondary condition:
e The plant contains machines 1 - 12.
¢ No machines have been assigned explicitly to user dnc1 via User
Administration.
e User dnc2 has been assigned the following machines:
Machine 1
Machine 2
Machine 3
Machine 4
Machine 5
Machine 6

e Station 0815 has been permanently assigned the following machines:
Machine 1
Machine 2
Machine 3
Machine 8
Machine 9

Standard tree view

After logging onto station 0815, user dnc2 can see the following machines:
e Machine 1
e Machine 2
e Machine 3

This is the intersecting set from the explicit assignment for user dnc2 and the
machines assigned to the station.
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After logging onto station 0815, user dnc1 can see the following machines:

Machine 1
Machine 2
Machine 3
Machine 8
Machine 9

User dnc1 can see all of the machines assigned to station 0815. No explicit
assignment has been made for user dnc1.

User-specific tree view

After choosing Tools —> Display All My Machines, user dnc2 can see the

following machines:

Machine 1
Machine 2
Machine 3
Machine 4
Machine 5
Machine 6

User dnc2 can see all of the machines assigned to him for the station.

After choosing Tools —> Display All My Machines, user dnc1 can see all the
machines in the plant because no explicit assignment has been made.
Machine 1
Machine 2
Machine 3
Machine 4
Machine 5
Machine 6
Machine 7
Machine 8
Machine 9
Machine 10
Machine 11
Machine 12

FBDN1/3-52
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3.4 Print function

The printout corresponds to the print preview. The data printed depends on which
window is active. The system prints the active window.

Note
The user must be assigned the necessary authorizations for these functions.
See also: User administration

Tree view active:

If the window on the left (the tree view) is active, the DNC program list in the
window on the right is printed. When you call up this function, all the printers
connected to the computer are displayed. The field contents printed depend on
whether a list description (see Section 10.8.2) has been configured.

List view active:
If the window on the right (the list view) is active, the data of the selected element
is printed. The following options are available:

e Print NC data
e Print administrative data

Print format
To set the format for printing the program list and NC data, choose Tools >
Settings followed by the appropriate option in List Orientation.
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3.4.1 Print preview
The print layout is displayed page by page depending on the window that is active.

Tree view active:

If the window on the left (the tree view) is active, the DNC program list in the
window on the right is displayed in the print preview.

The field contents displayed in the print layout depend on whether a list description
(see Section 10.8.2) has been configured.

List view active:

If the window on the right (the list view) is active, the data of the selected element
is displayed.

Note
No print preview is available for workpieces.

You can set the format for the print preview by choosing Tools > Settings.
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3.4.2 Printing

Print administrative data

The function for printing administrative data can only be called up in the list view
(right window) via the Print Administrative Data context menu. This function
activates the printout of the administrative data for the selected element.

Only users with the appropriate authorizations are allowed to use the print function.
See Section 5.3.5

Note

Multiple selections are possible. The administrative data of the selected elements
is then printed in succession.
There is no print function for workpieces.

Print NC data

The function for printing NC data can only be called up in the list view (right
window) via the Print NC Data context menu. This function activates the printout of
the selected NC data element (of the NC program).

Only users with the appropriate authorizations are allowed to use the print function.
See Section 5.3.5

Note

Multiple selections are possible. The NC data of the selected elements is then
printed in succession.
There is no print function for workpieces.

You can set the print format by choosing Tools > Settings.
You can specify whether the administrative data is to be printed in addition to the
NC data (usually NC programs).

Print format
To set the format for printing the NC data, choose Tools - Settings followed by
the appropriate option in NC Data Orientation.

Note

If configured, graphic data can also be printed.
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Print program list

The function for printing program lists can only be called up in the tree view (left
window) via the Print Program List context menu. This function activates the
printout of the DNC program list in the window on the right.

Only users with the appropriate authorizations are allowed to use the print function.
See Section 5.3.5

Print format

You can set the format for the printout by choosing Tools > Settings.

The field contents printed depend on whether a list description (see Section 10.8.2)
has been configured.
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3.5 Creating a CSV file

The function for creating CSV files can only be called up in the tree view (left
window) via the CSV File context menu.

Based on the filter, this function creates a CSV file that contains all the NC data of
the selected group or machine and, depending on how the system is configured,
the associated field contents (e.g. name, type, release, etc.). The file is stored in
the directory ...Siemens\MCIS\Data\ADNC\CSV.

Under HKCU\Software\siemens\mcis\dnc\settings, you can also create a Windows-
user-specific key CSVPath that can be used for defining a different directory for
saving the CSV file.

You can open the file created in the Notepad editor or Microsoft Excel.

Note

The user must be assigned the necessary authorizations for these functions.
See also: User administration

Prerequisites

The following requirements must be fulfilled in order to create a CSV file:

o Alist description with the name #CSV must be configured.
The field contents of the data records written to the CSV file are specified by
means of the list description #CSV. This is defined when the system is
configured. Separators and comment characters are also defined when the
system is configured.

e The group or machine must contain NC data (Caution filter)
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Structure of the CSV file

Data format

The file is created in UNICODE.

Depending on how the system is configured, the first line can contain the heading
with the language-specific field names (parameters).

Separators

In the DNCGLOBALSETTINGS table, enter the ASCII value for the separator in
INTVAL (default value is 9 (horizontal tab)).

If you open the file in Excel, the configured separators are evaluated and the
individual field contents are displayed in separate columns. If you call the file up in
the editor, the configured separators are displayed.

Comment characters

In the DNCGLOBALSETTINGS table, a data record is created by the setup tool
with NAME = #CSV with STRINGVAL=; (semicolon) as a comment character.

The first character in front of the language-specific field names (e.g. name, type) in
the first row is used as a comment character.

Example: Display in the editor

;Name | Type | Workpiece |Version|Enable |Group / Machine
valve cylinder head|MPF||2]|1|area motors

cut-off cycle|SPF||4|0|area motors

fine grinding cycle|SPF||3|0|area motors
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4.1 Maintenance functions

4.1.1 Creating/changing administrative data

Creating/changing NC administrative data

NC data properties should be created and maintained by authorized users (e.g.
administrators or machine operators). Authorization to change administrative data
must be assigned to these users (see also: Chapter 5 - User administration).

Depending on the parameters set, the NC administrative data is displayed on up to
four tab pages:

e General

e Information

¢ Comment (always integrated)
e Attachments

Alongside the existing standard screens, the following change/extension options

are available:

e Changing the default list layout of the NC data display via the list editor.

e Changing the field types for the output and edit fields for the properties via the
screen editor. The following types are available:

Output fields

Edit fields

Combination fields (combo boxes)

Checkboxes

Output checkboxes

Static output fields

¢ Redefining data fields for describing NC data

Note

Different field types for the screen fields for creating and changing NC
administrative data can be defined.

They can be defined in the DNCFORMDESCRIPTION table using the database
fields FIELDTYPE and FIELDTYPE_NEW.
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Characteristics in the Properties dialog can be changed. Fields for which change
authorization has not been assigned in the parameters cannot be changed,
however.

Note

The parameters can be used to define which fields appear in the dialog. Fields
that have not been parameterized for the properties dialog, therefore, cannot be
changed either.

The standard user interface features the following screens:

Properties - General
Propertiez: 4-valve-cylinder-head |

Gerneral | |rfi I Commert I .-’-'-.ttau:hmentsl

M ame |4-valve-cylinder-head Type IMPF :I'
Wersion IE Warkpiece |
Releaze- D 3 Trialcut- 1D v

Length I?En? Auto Archive II:I_

Develname [siemens Develdate |21.09.53 10:41:54
Madname [DHC toddate [10.08.01 11:33.08
Loadcounter ||:| Lastoad |

(] | Cancel Help

Fig. 4-1: NC data properties / tab: General
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Properties - Information

Properties: 4-valve-cylinder-head

21.03.33 10.41:54
10.08.01 11:35.08

10.08.01 11:37:33

Fig. 4-2: NC data properties / tab: Information
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Properties - Attachments

Properties: 4-valve-cylinder-head

General I I I Camment .ﬁ.ttachmentsl
M ame | sizel hype | changed on I
0093977 _00_1_NCx 1KE  Shartout 30.01.2006 15:33:
m 24 WE-CYLINDER-HEAD 10E, 1EE 10K File 22.03.2006 11:33:56
Eﬂ 24 WE-CYLINDER-HEAD _IOK, TEE  Shartzut 30.07.2006 15:31:45
Open Add Delete | Rename |

] I Cancel Help

Fig. 4-3: NC data properties / tab: Attachments

The Attachments tab page allows you to add any required files to the NC data in
the form of attachments. You can copy the files directly to the attachment or define
them as a link. The attached data is located in the directory
...NCDataName_Version_Type.ATT

Note

When you copy/paste or upload NC data, the subdirectory containing the
attachments is also taken into account.

When you delete NC data, only files that have been copied in the attachment
directory are deleted. The originals of the linked attachment files are retained.
The user must be assigned the necessary authorizations for these functions.
See also: User administration

NC data with an attachment is assigned a special file icon .
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Changing machine configuration data

The machine properties can only be changed in configuration mode in DNC
Admin. The menu option View - Configuration is available to authorized users
(administrators) only. Authorization to configure machine data must be assigned to
these users (see also: Chapter 5 - User administration).

Machine properties are displayed on two tab pages:

e Transfer

e Configuration

Only the Configuration tab page is required for the configuration. It is divided into
two:

It allows users to link physical CNC machines to logical machines in the plant
configuration using machine configuration files.

The machine configuration file can be edited on various dialog screens, which can
be called up with the Config. dialog button.

If required, the machine configuration file can also be edited directly and changed
via EDIT.

This tab page can also be used to make default settings for the dialog function
(see also: Section 10.5 — Machine connections).

area molors group 6 cylinders machining centre |

Dosevnload Ennfiguratiunl

Conficuration file: EDIT

machining centre. MCE

s

Config dialog

Tranzmizzion module: Diizplay group for ligt:

[Seria without protocal ———»| W iCialag functiors [DELLST e
. [T Manual Abort

Upload directory Search levels for HC data

rn rrachine & _ii i:'l machine 5 .1.!

Yerzion Strategy For Upload

o

k. Canizel Help

Fig. 4-4: Machine properties / tab: Configuration
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Changing link administrative data

Authorized users (administrators) are authorized to define links in configuration
mode. Authorization to configure machine data must be assigned to these users
(see also: Chapter 5 - User administration).

When you choose Edit, you can enter a drive or path for a link directly in the MCF.
When you choose "Config. dialog", you can select a drive in the file system or enter
a UNC path in the screen. This means that DNC can now access these files.

Note

Files that are made visible via a link, do not have a database reference.
DNC cannot navigate in any subdirectories of the link that may be available. Only
the files that are located directly under the link node can be accessed.
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4.1.2 Importing NC data

General

DNC allows users to import NC data (files of all configured NC data types) from
networked or higher-level systems (e.g. from the NC programming system).

Table 4-1: Relevant database fields for file import with header data

Database field Description Characters
NCDATANAME NC data name 40 characters; invalid
characters:
&\" ¥+ [5<=> 2\, {1 % SR 2
DNCDATATYPE NC data type 3 characters; only types defined
in the DNCDATATYPE table.
VERSION Version number Long integer
NODENAME* Machine, group or path 40 characters
(e.g. Group1/Machine?2)
WORKPIECE Workpiece name 40 characters
RELEASEID Release ID Value range 0..1 (1 = released)
TRIALCUTID Trial cut ID Value range 0..1 (1 = trial cut ID)
DEVELNAME Developer name 32 characters
DEVELDATE Development date Date
MODNAME Modified by 32 characters
MODDATE Modification date Date
ADMINNAME Administrative data 32 characters
modified by
ADMINDATE Date on which Date
administrative data was
modified
LOCKNAME Lock name 32 characters
LOADID Load ID Long integer
LOADORDER Load order Long integer

*  NODENAME is not a database field in the DNCDATA table but an auxiliary
function to determine the NODEID from the node name. NODEID is an internal
database field in the NODETABLE and DNCDATA tables. It is used for
assigning NC data to its node.

Note

If the administrative data table is extended on a project-specific basis, the new

database fields can also be used in the header.

Undefined or unassigned fields have the value 0 or a blank string.
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A Warning

The following database fields must not be defined in the header:

NODEID is a system-internal variable that is assigned
automatically.

LENGTH is the length of the NC program; set automatically
during the import.

LOADCOUNTER is the transfer counter and is incremented by the
system at every transfer.

LASTLOAD is the date of the last transfer counter and is set by the
system at every transfer.

LOCKNAME is not currently used by the system.

Manual import

When you choose File > Import, the system displays a file browser in which you
can select the files to be imported and then a selection menu that allows you to
specify how the import file is to be processed once it has been downloaded.

Confirm Import |

0033_Flanga_motare_1.MPF

Impaortfile after |mport

& Delete
" Leavelnchanged

k. Al Cancel

Fig. 4-5: Dialog: Confirm file import
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Import without header data

NC data without a header can be imported by authorized users (default:
Administrators or machine operators). The NC administrative data must be
entered in the dialog. To do so, the users must be authorized to import NC
data and change the NC administrative data (see also: Chapter 5 - User

management).

Import with header data

Two files are available for importing files with header data. The header data is
stored in a header file (Unicode). The user data is stored in a separate file.
Importing a file in this way allows NC data to be transferred without the user
needing to make any additional entries. This type of import can be carried out
by any user.

If the administrative data is incomplete, authorized users can edit it
retrospectively in the dialog. Unauthorized users who are not allowed to modify
NC administrative data are not permitted to import the files (see also: Chapter
5 - User administration).

In the import file, you can assign the administrative data via field names

(e.g. NCDATANAME), whereby the import file may contain either selected or

all fields in the administrative data record. The import file is divided into the

following areas by means of start and end identifiers:

e Header data / administrative data (HEADER START, HEADER END).

e Comment (COMMENT START, COMMENT END).

e Name of the user data file (NC START, NC FILE, NC END).
Attachments as link or file (ATT_LINK, ATT_COPY, ATT_MOVE)
ATT LINK: A link to the specified file is created in the attachment directory.
ATT COPY: The specified file is copied to the attachment directory. ATT
MOVE: The specified file is moved to the attachment directory. The source
file is deleted.

The key words are the database field names in the administrative data table
DNCDATA.
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An import file can contain more than one import block. Each block must
comprise header data and NC data and can also contain comments.

In this way, all the NC data that needs to be edited can be included in one
import file.

Table 4-2: Import file with header
Import file with separate NC data file

HEADER START
NODENAME=Groupl/Machine2
NCDATANAME=Butterfly
DNCDATATYPE=BMP

VERSION=1

TRIALCUTID=0

RELEASEID=1
DEVELNAME=Smith

HEADER END

NC-FILE=Bflyl.bmp

COMMENT START
This is a butterfly
COMMENT END

Note

The import format of the MCIS DNC versions up to DNC V1.0 is still supported
with the appropriate database structure.

e Import via links
This involves copying data from a link and then pasting it into DNC (same as
the import function). The general conditions that apply to an import with/without
header data also apply here.
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Automatic import

Files can also be imported with header data automatically. The format of the
header data is the same as that used when files are imported manually with header
data.

Note

In the case of an automatic import, the header does not need to define all the
database fields.

At least the following database fields must be specified:

e NCDATANAME

DNCDATATYPE

VERSION')

NODENAME

WORKPIECE (only relevant if the NC data refers to a workpiece)

If the NC data imported automatically is to belong to machine 2 in group 1, for
example, the following definition must be set:

NODENAME=Groupl/Machine2

If the NC data belongs to a cylinder head workpiece, which belongs to machine 5 in
group 1, the following must be defined:

NODENAME=Groupl/Machine5
NCDATANAME=Butterfly
WORKPIECE=CylinderHead

When DNC is set up, the import directory for the NC data files is defined via a
dialog. The file types for the automatic import are defined as follows:

e File type of the import file: .imp

o File type after successful automatic import: .iok

e File type after unsuccessful automatic import: .ier
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Table 4-3: Structure of the import file for an automatic import

'Line of the import file

' Description \

>
&

x X
NN

x3)

HEADER START
NCDATANAME=
<program name>
DNCDATATYPE=
<program type>
VERSION=
<version number>
NODENAME=
<target machine or group>
WORKPIECE=
<workpiece name>

RELEASEID =<0|1>
TRIALCUTID=<0|1>
DEVELNAME=

<name of the program developer>
DEVELDATE=<date of
development>

MODNAME=

<name of the program modifier>
MODDATE= <date of
modification>

ADMINNAME =

<modifier of administrative data>
ADMINDATE =

<date of administrative data
modification>

HEADER END

ATT LINK=

<path name \ file name>
ATT COPY=

<path name \ file name>
ATT MOVE=

<path name \ file name>

NC FILE=

<path name \ file name>
NC START

%1234

NO0010

M30

NC END

COMMENT START
Comment line 1

Comment line 2
COMMENT END
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Identifier: Start block with administrative data
40 characters,

illegal characters: &\" "*+,/:;<=>2?[\|],(){} % $B§u>
3 characters,

only types know in DNC are permitted

Range of values: 1...999999

40 characters,

only machine name or complete path

40 characters

only required when the NC program is to be stored
in the workpiece

Release ID value 0 or 1 (1 = released)

Trial cut ID value 0 or 1 (1 = trial cut ID)

Max. 32 characters

Date in ISO format
Max. 32 characters
Date in ISO format
Max. 32 characters

Date in ISO format

Identifier: End block with administrative data
Attachments to the NC file (pure information files):
A link to the specified file is created in the

DNC data management.

The specified file is copied to the DNC data
management.

The specified file is moved to the DNC data
management, i.e. the source file is deleted.

If no path is specified, the NC file must be in
the same directory as the import file
Identifier: Start block with NC program
Complete NC program

Identifier: End block with NC program

Identifier: Start block with comments

The entire block must be completely available
or completely omitted

Identifier: End block with comments
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1)

2)

3)

FBDN1/4-72

If a version that already exists is assigned, it is overwritten. If no version is
specified, the set automatic import strategy decides whether the data is
imported. When the data is imported, the next available version number is
assigned. If the maximum number of versions is exceeded, the version with the
oldest modification date that has not been released, is deleted.

The automatic import strategy can be set in the DNCGLOBALSETTINGS table:

Parameter AutolmportStrategy =0 -> import is not performed when version is
missing.

Parameter AutolmportStrategy =1 -> import is performed when version is
missing.

These lines may occur several times.

EITHER the path to a file with the NC data file must be specified

(NC FILE=...), OR the entire block with the NC data

(NC START .... NC END). If the entire NC data file is integrated in the import file
(NC START ... NC END), the import file may not be a UNICODE file

(pure ASCII).
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4.1.3 Editing NC data

General
NC data can be edited by authorized users.
Unauthorized users (e.g. assistants) can view the NC data but cannot save it back

to the database or create a new version. To ensure this, a copy of the NC data is
opened in a temporary folder.

Authorization to edit NC data must be assigned to these users (see also:
Chapter 5 - User administration).

Note

DNC uses the editor used by the Microsoft Explorer for each file type.
New file types must be assigned to an editor via Microsoft Explorer.

Editing/saving files

All the NC data in the current directory can be opened for editing. Either a new
version is created or the old version overwritten in the directory of the original file
when saving, depending on the configuration in the DNCGLOBALSETTINGS
database table (parameter: NewVersionAfterEdit).

Note

To ensure that data is processed appropriately for DNC, only the Save and Exit
menu options of the editor selected by the user should be used. All other
functions can be used, but do not have any effect on the MCIS database.

The menu option Save As, in particular, does in fact create a file with the
specified name in the specified directory, but no link is created to the database. In
this case, the old file remains unchanged in the database.

Delete Version dialog

If the maximum number of versions as defined during parameterization is
exceeded, a dialog is displayed in which you can delete an existing, unreleased
version.
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4.2 Download/upload functions

General

Marking

In the case of machines connected serially, the interface is only opened for the
download/upload procedure and is then closed again. This means that the same
serial interface can be used for different machines (e.g. when DNC is installed on a
mobile station).

Authorization to download/upload NC data must be assigned to the relevant users
(see also: Chapter 5 - User administration).

Note

The interface is always open if the dialog function is configured. It can, therefore,
only be used for one CNC machine tool.

A yellow arrow on the user interface on the machine indicates when data is being
downloaded/uploaded.

Ap

Fig. 4-6: NC data is being uploaded from the CNC machine tool

o

Fig. 4-7: NC data is being downloaded to the CNC machine tool

Note

When a download/upload procedure is initiated, it can take a while for the yellow
arrow to appear.

This can be due to a number of reasons, such as the conversion of end-of-line
characters or code or the insertion of spacers. It can also be due to the size of the
file or the computing power.
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Fig. 4-8: Indication of download/upload functions in DNC
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4.2.1 Downloading NC data

Download jobs

Download jobs for serial machines can be tracked in the Properties screen on the
machine. The file currently being downloaded is displayed in the NC Data field.
The list of files still to be downloaded is displayed in the Download/upload jobs
field.

Download status

The following download states can occur:

e Error (e.g. if a COM port is already being used by a different machine)

¢ Inactive (default setting)

e Send delay (if send delay is > 0 in the [SEND] section of the machine
configuration file)

e Active (downloading)

e Prepare to send (NC date is interpreted after which the file is downloaded (e.g.
code conversion)). "Prepare to send" is indicated in the same way as "send
delay".

Length
The Length field indicates the number of bytes that have been downloaded.

area motors group b cylinders machine 49_dt

Downloac | Configuration |

Diownload state: ||:iusy |Inact|ve

Upload state:

Length: 512 Lengh: |El

MC Data:

Cancel current job

machine 49_dttiotor 21 B MPE

Loadlist:

mackine 49_dh24711-up_1.5FF

Delete selected)ohs

DK, I Cancel Help

Fig. 4-9: Downloading NC data

Cancel current job

A download can be cancelled.
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4.2.2 Downloading NC data to SINUMERIK* with DNC IFC SINUMERIK

General

If the NC data is downloaded to a SINUMERIK* controller, a dialog is displayed in
which the download target within the controller can be selected.

Load to SINUMERIK 840D E

[ Load

Cancel |

Fig. 4-10: Dialog for download to SINUMERIK 840D

The NC data is downloaded to the SINUMERIK* data management system.
If the Load checkbox has been activated, the data is downloaded to the NCK in the
SINUMERIK.

The data is downloaded to a directory that is compatible with the data type
e.g. MPF files are downloaded to the part program directory MPF.DIR
SPF files are downloaded to the subprogram directory SPF:DIR
workpieces are downloaded to the workpiece directory WKS.DIR
etc.
Exceptions include pseudo workpieces, which are downloaded to directories
corresponding to the pseudo workpiece hame.
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4.2.3 Uploading NC data

Upload jobs
Upload jobs for serial machines can be tracked in the Properties screen on the
machine. The file currently being uploaded is displayed in the NC Data field.

Download status

The following download states can occur:

e Error (e.g. if a COM port is already being used by a different machine)

¢ Inactive (default setting)

¢ Ready (DNC is ready for the upload to be initiated; this status remains set until
the actual upload (from the machine) starts).

e Active (uploading data)

Length
The Length field indicates the number of bytes that have been uploaded.

area motors group b cylinders machine 44_en

Daownload | Configuration |

Download state: |Inau:tive Upload state: ‘Ready

Length: 0 Length: [0

MNC Data:

Cancel current job

machine 44_entkewway-milling-cycle_3.5FF

Loadlist:

Deleteselected|mhs

0] 4 I Cancel Help

Fig. 4-11: Uploading NC data
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Cancel current job

fAreal PCUV2serial x|

Diownload I Eunfiguratinni

Download state; |ractive IJpload state: Pctive

Length: [ Lenath: i_|]32

MC data;

] DN C_HH ]| Fercst curent b |

Download jobs: /!\ Accept received NC data

[Telete seleated ohe |

k. Cancel | Help |

Fig. 4-12: Cancel upload (data reception)

When you choose Cancel Current Job, two functions are made available if the
Terminate Manually checkbox has been activated in the configuration dialog:
e Do not accept received data:
The data is rejected.
e Accept received data:
The data is accepted.
Background:
With certain controllers, you have to configure a late receive end (end of
upload x seconds after the last character has been received).
To reduce the transmission time, the upload can be terminated after the final
characters have been received. The NC data received is accepted.

Note

The dialog only appears if the Terminate Manually checkbox has been activated
in the configuration dialog. This checkbox is not normally activated, which means
that the data received is not accepted when the upload is terminated.
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4.2.4 Uploading NC data from SINUMERIK*

General

If you select a SINUMERIK* machine and initiate the upload, a dialog showing the
SINUMERIK* data management directory is displayed.

machine1 x|
M ame | nge' ... | Length | changed | Close I
A4ALVE-CYLINDER-HEAD MPF 94363  DB.0B.2002 15.08... —
FINE-GRINDING-CYCLE ~ MFF E4 09.08.2004 09:25.... LCancel

CUT-OFF-CYCLE MPF 34218 12022004 16:34: .

-] CUS.DIR
Delete

=T
Tranzfer
]

| 111 transmitted

Fig. 4-13: SINUMERIK* data management directory

The content of the SINUMERIK data management system is displayed in a
hierarchical tree and list view. The directories are displayed on the left. The list on
the right displays the content of the directory selected.
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Upload
When you select one of more of the required NC data files on the right and then
choose Upload, the system uploads the data to DNC.
To upload all of the NC data in a directory, you can also select the appropriate
directory in the tree structure.
Note
You cannot upload all the NC data files and subdirectories at once by selecting a
directory.

Delete

To delete data on the machine, select an NC data file and then choose Delete.
Multiple selections are also possible here.

Configuring the SINUMERIK* view

In the SINUMERIK* machine configuration dialog, you can configure which
directories on the controller can be viewed by the user.
See also: Chapter 10 "Configuration dialog"
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4.3 Version management and release / trial cut identifier
4.3.1 Version management

General

DNC allows you to parameterize the maximum number of NC data versions to be
stored.

Machine-specific version management uses version zones to define the hierarchy
level within which NC data with the same name, type, and version can occur.

A version zone can contain up to n items of NC data of the same name and type
provided that the version numbers are different.

The default setting is n = 5, but this can be changed depending on the project.

Note

A version zone can only contain one released version.

Machine-specific version management

Machine-specific version management defines where identical NC data can

appear:

e Group: Identical NC data must be unique within the group.

e Machine: Identical NC data can appear on different machines. The names on
one machine must be unique, however.

Note

Only the selected version zone is taken into account for the release and when
versions are determined.

See also: Section 10.7.4
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If the number of versions exceeds the parameterized limit, the "Delete Version
Dialog" is displayed, which contains all the existing versions along with their main

properties. You now have to delete one of the versions listed.
e The version highlighted in gray is released and cannot be deleted.

¢ Versions that are in the copy list (menu command: Copy or Cut) are marked.

Delete Version Dialog |

MMaximum number of versicns reached.
Delete an old version from the list.

Mame: | Cylinder head

Type: MPF

Vers. | change date J rele
1 1970472007 16:27:11 0

2 19/04/2007 16:30-46 0

3 19/04/2007 16:31:16 0

4 190472007 16:27:11 0
3 10N FFNNT AR 2711 n

cance |

SR

Fig. 4-14: Delete Version dialog
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Editing NC data

Depending on the configuration, modified NC data can be stored as follows:

¢ Unchanged versions and identifiers

o If the next available version is assigned, this is assigned the identifiers for the
edited version.

Importing NC data manually

The following applies depending on whether the NC data is imported with or
without header data:
¢ Without header:
If NC data with the same name, type and version exists, the next available
version will be assigned.
e With header:

e If a version that already exists is specified in the header for NC data of the
same name and type, the permission of the operator must be obtained via
an acknowledgement dialog for transferring the data.

e If no version number has been specified in the header for the NC data of
the same name and type, the next available number will be assigned.

Uploading NC data

When you upload NC data, versions are assigned on the basis of the configured
version strategy.

You can choose one of six strategies (see also: Section 10.7.2 Version strategy for
upload).

Inserting NC data

If NC data is integrated by means of a cut/paste or copy/paste procedure, the next
available version will be assigned if NC data of the same name, type, and version
already exists.
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4.3.2 Release / trial cut identifier

General

DNC uses two different types of identifier:
e Release identifier: NC data is released for production
e Trial cut identifier: NC data needs to be tested before it is released

Eigenschaften: Maschinel ;/ FINE-GRINDING-CYCLE

General Ilnh:u I Enmmentl .ﬁttachmentsl

Name [FINE-GRINDING-CYCLE] Type [sPF =]
Wersion |4 Workpiece I

ReleazeD v Trialcut-D v

Fig. 4-15: Properties: Machine / release & trial cut identifiers activated

Editing/saving NC data

How edited NC data is saved depends on the parameters in the
DNCGLOBALSETTINGS database table. Two options are available here:
e Save with same version

e Save with next highest version (default)

The release and trial cut identifiers are adjusted in line with the selected storage

variant:

e Same version: The assigned identifier is retained.

o If the next available version is assigned, this is assigned the identifiers for the
edited version.

Importing NC data

The following applies depending on whether the NC data is imported with or
without header data:
e Without header:
The imported NC data is not released.
o With header:
¢ If an identifier is set in the header, the identifier is valid.
¢ If no identifier is set in the header, the imported NC data is not released.
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Uploading NC data

When NC data is uploaded, the release identifier is assigned on the basis of the
configured version/identifier strategy in the DNCGLOBALSETTINGS database
table.

You can choose one of six strategies (see also: Section 10.7.2), default is
strategy 1.

Inserting NC data

When you insert NC data, the release identifier is reset and the change date is
updated. If necessary, the version is also incremented to the next free version
(see below). All other NC data properties remain unchanged.

NC data from Cut/Paste or Copy/Paste only retains its respective versions in the
node environment when it is inserted into a different group, which does not contain
any NC data file with the same name type, and version. When you copy and paste
data to the same group, the version is incremented to the next free version
number.

See also: "Machine-specific version management"

Note

If the parameterized maximum number of versions has been exceeded, the
"Delete Version Dialog" appears so that you can delete an old version.
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4.4 DNC Compare

DNC Compare offers two functions:
e NC program comparison
e Machine comparison for SINUMERIK*

4.4.1 Machine comparison for SINUMERIK*

General

The machine comparison requires the DNC Compare option, which must be
obtained separately for each plant.

The SINUMERIK* machine comparison allows you to check whether the NC
programs on the machine and the programs managed in DNC have the same
content.

This function is only available for SINUMERIK* with a PCU 50/70 operator
interface.

Note

An additional configuration is required for the machine comparison. For more
information, see Chapter 10 - Configuration.

Carrying out the machine comparison

You can compare individual machines or a group of machines.

To do so, select a machine with the SINUMERIK* transmission module and then
choose Machine Comparison > Compare.

If you select a group, the machine comparison is carried out for each machine with
a SINUMERIK* transmission module.

The comparison result for each machine is stored in a file and is retained until the
next comparison run is carried out. The file name is the same as that for the
machine configuration file with the extension TXT. All of these files are located in
the directory ... DNC\CmpResult.

Note

The change date and length of the file are compared, but not the content.
Only program versions that have been released are compared with machine
programs.
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Displaying the comparison result

Select the machine for which a machine comparison has already been carried out.
To display the result file for the machine, choose Machine Comparison >

Display Comparison Result.

Table 4-4: Sample file for a comparison result

MACHINE44

NC data only in the machine
MPF.DIR
CYLINDERHEAD4713 .MPF
DRIVINGGEAR4713 .MPF
mpf.dir\DPWP.INI
SPF.DIR

CUT-OFF-CYCLE.SPF

FINE-GRINDING-CYCLE.SPF
WKS.DIR\ GEARBOX4713.WPD
WKS.DIR\ GEARBOX4713.WPD\
WKS.DIR\ GEARBOX4713.WPD\

NC data only in the DNC system
4-VALVE-CYLINDER-HEAD 2.MPF
CUS_1.ARC

GEARBOX0815\ GEARBOX0815_1.MPF

NC data not the same
6-VALVE-CYLINDER-HEAD 3.MPF
GEARBOX4712 1.SPF

GEARBOX0815\ GEARBOX0815 3.SPF

13.11.2000

GEARBOX4713 .MPF
GEARBOX4713.SPF

11:13:46

FBDN1/4-88
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4.4.2 Individual NC data comparison

4 NC data management

The Individual NC Data Comparison function allows you to compare two NC data
files with each other (e.g. compare a modified/optimized NC program with the

original NC program).
Changes are highlighted and the number of changes is displayed. NC program
record numbers can be hidden.

EiFilecompare M= E3
"MPF.DIRIP1_6.MPF P1_6.MPF
1 % _N_P1_MFF 1 %_N_P1_MFF ii
2 . sPATH=~_N_MFF_DIE 2 . sPATH=~_N_WFF_DIE
3 HO E_HEAD([ 268439551, 0..0..0.,150.
3 HO E_HEAD(268439551.0..0..0..1
4 NS5 E_TS("FRAESERZ(O", "FRAESERLIO".1. 4 NS E_TS("FRAESERZ0", "FRAESER1OD
5 Nilo GO G90 X-12. ¥-12. #SH 5 Nilo GO G90 X-12. ¥-12. ;#SH
=] H15 GO G90 Z2-5. #SM =] H15 GO G90 Z-5. #SM
7 H20 G1 G90 G41 X5. ¥5. G94 Flo0. | 7 H20 G1 G90 G41 X5, ¥5. G394 FlO0
g H25 G111 X30. ¥75. [ #SHM g H25 G111 X30. ¥75. [ #SHM
9 N30 G1 RP=20. AP=176. :#5M 9 H3i0 G1 RP=20. AP=176. ;#SM
10 H35 G2 AP=90. ;#SM
11 H40 G1 G90 X120, #5SK 10 H40 G1 G90 X120, #5SH
12 H45 G111 X120, ¥75. [#SH 11 H45 G111 X120, ¥75. [#SH
13 HEO G2 AP=4. ;#SH 12 HE50 G2 AP=4. #5H
14 HE5S G1 G90 X145, ¥5. [ #5M 13 HES G1 G90 X145, ¥5. #5K
15 Hed G1 G90 X-20. #5SK 14 Heo G1 G90 X-20. #5SH
16 M30 ;#5H 15 M30 ;#SH
1 ]« Ll_l
oK | & NEXT | # PREV | W71 | Print all | Print diff. |
[ Leftonly [ Moved | Right Only [TotalLines: 17 |piff: 2 [ 7

Fig. 4-16: Individual NC data comparison

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition

FBDN1/4-89



DNC Plant/DNC Cell (FBDN1) 05.07
4 NC data management

4.4.3 Print function for the individual NC data comparison

Two print variants are available:
e Printall
e  Print diff.

The standard Windows printer is offered as for the default print function.
Format of the print file

The header on each sheet to be printed is: MCIS DNC Compare result.

The header is always blue.

The path and program name of the two files that have been compared always
appears in row 1 ff and applies to the whole printout.

The page number appears at the bottom of the sheet (centered) along with the
total number of pages in the printout (e.g. 5/9). The print date and time are also
printed (right justified).

The data is printed in landscape format (default setting).

Defining colors for the printout

The colors for the printout can be defined in the StartPrint.ini file in the [Colors]
section.

Example:

[Colors]
;color no. RGB-CODE:
COLOR1=0,0,100 Color for path and program name
COLOR2=255,0,0 Color for differences, left (1st file)
COLOR3=0,150,50 Color for differences, right (2nd file)
COLOR4=0,0,100
COLOR5=0,0,0 Color for matches, right/left

(1st and 2nd file)

© Siemens AG 2010 All Rights Reserved
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Print all
To print all the results of the individual NC data comparison, choose Print all.
MCIS DNC Compare result
C:\SiemenstMCIS\Data\DNC\TMP\ C:\Siemens\MCIS\Data\DNC\Data\Halle3\
-4014-m82-02-01-dieckmann_hp_1.nca -4014-m82-02-01-dieckmann_hp_1. nca
1 %4014 1 %4014
2 (99713-0.22.6.99.NICKEL) 2 (99713-0.22.6.99.NICKEL)
3 (L4014001..P99713-0.M17657.WPL3617970 3 (L4014001..P99713-0.M17657.WPL3617970
* MAGNESIUMMASCH. *) * MAGNESIUMMASCH. *)
4 N0001 G40 G90 G80 4 N0001 G40 G90 G80
5 N0002 GO0 G53 G60 Z-117.2
5 NO002 GO0 G53 G60 Z-115.8
6 NO003 X-360. Y246. 6 NO003 X-360. Y246.
7 N0O004 M11 7 NO004 M11
8 N0O0O5 8 NO005
9 N00D6 A90. 9 NO006 A90.
10 NO0O7 M82 10 N0O0Q7 M82
11 NO008 L99 11 NOO008 L99
12 NOOD9 G54
12 N0010 T1 13 NOO10 T1
13 NO0011 L975 R0O1 90. M6é5 14 NO011 L975 R01 90. M65
14 NO0012T2 15 NO0012 T2
15 NO0013 M40 16 NO013 M40
16 N0014 S4030 M03 17 N0014 S4030 M03
17 N0015 M82 18 NO0O015 M82
18 NO0016 L99 19 NOO016 L99
20 NO017 GOOD G54 X-360. Y246.
19  NO017 GO0 G54 X-350. Y246.
20  NOO18 MO7 21 NO018 MO7
21 NOO19 X-892. Y64. Z-196. M08 22 NO0019 X-892. Y64. Z-196. MO8
22 N0020 D1 Z-307.775 23 NO0020 D1 Z-307.775
23 NO0021 GO1Z-332 F201
24 N0022 GO0 Z-307.775 24 NO022 GO0 Z-307.775
25  NO0475 M19 25  N0475M19

Fig. 4-17: Example of a printout of all the results of the individual NC data comparison
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Print differences

To print the differences in the results of the individual NC data comparison, choose

Print diff.

MCIS DNC Compare result

C:\Siemens\MCIS\Data\DNC\TMP\
-4014-m82-02-01-dieckmann_hp_1.nca

C:\Siemens\MCIS\Data\DNC\Data\Halle3\

-4014-m82-02-01-dieckmann_hp_1. nca

5 NO0O2 GO0 G53 G60 Z-117.2

6 NOOO3 X-360. Y246.
7 N0O004 M11
8

NOOO5

9 NOOO& A90.

10 NOOO7 M82

11 NOOOS8 L99

12 N0O009 G54

12 NOO10T1

13 N0011 L975 RO1 90. Me5
14 N0012T2

16 N0014 S4030 M03

17 N0O015 M82

18 N0O016 L99

20 NOO17 GOO G54 X-360. Y246.

20 N0O18 MO7
21 N0OO19 X-892. Y64. Z-196. M08
22 N0020 D1 Z-307.775

24 N0022 GO0 Z-307.775
25  N0475 M19
26 N0476 M63

Fig. 4-18: Example of a printout of the results of the individual NC data comparison (differences only)

1
-

W@~ G,

10
11
4

13
14
15

17
18
19
-1

19
21
22
23
23
24

26

NO0002 GO0 G53 G60 Z-115.8
NO003 X-360. Y246.

NO004 M11

NO005

NO006 AQ0.
NO007 M82
NO008 L99

NOO10 T1
NO011 L975 R01 90. M65
NO012 T2

NO014 54030 M03
NO015 M82
NO016 L99

NO017 GO0 G54 X-350. Y246.
NO018 MO7

NO019 X-892. Y64. Z-196. MO8
NO020 D1 Z-307.775

N0021 GO1 Z2-332 F201

N0022 GO0 Z2-307.775

NO475 M19

NO476 M63

To make it easier to read, three rows with no differences are inserted before and

after each difference identified.

To indicate that the file has been cut, two lines containing "~~~" are inserted after

the three additional rows.

FBDN1/4-92
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4.5 Archiving (manual)

4.5.1 General

You can archive individual machines or a group of machines. Manual archiving
uses the same configuration data as auto archiving (see also: Chapter 12 >Auto
archiving).

To do so, select a machine with the SINUMERIK* transmission module and then
choose Machine Comparison - Archive.
If you select a group, archiving is carried out for each machine with SINUMERIK*.

The archive function creates or replaces a comparison result in a file each time it is
started. This file is located in the directory ...\ADNC\CmpResult. Its name comprises
the name of the machine followed by " AArch.txt".

Note

To execute the Archive function, DNC IFC SINUMERIK must be installed on the
machine with SINUMERIK*.

© Siemens AG 2010 All Rights Reserved
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4.5.2 Archive results
The results files are in English and contain the following results:

e Group and machine name (below each other)
Date (at start and end)
An area entitled "NC data in machine only" in which files are listed that were
only found on the machine.

e An area entitled "Different NC data" in which files on the machine are listed that
differ from those in the DNC system.

¢ An area entitled "NC data in DNC system only" in which files are listed that
were only found in the DNC system and not on the machine.

Note

The area NC data in DNC system only is only created with the start parameter
for the SHOW_FILESONDNC auto archive. The NC data located in this section
and in the upload directory is assigned the auto archive identifier "2" in the DNC
system.

The final result is shown at the end. This indicates whether errors occurred during
the archive run and how many files were archived.

Note

If no errors occurred and this machine has been configured for archiving, all of
the differences will have been dealt with.

© Siemens AG 2010 All Rights Reserved
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4.5.3 Displaying archive results

4 NC data management

When you select a machine (on the left of the operator interface) for which an auto
archive run has already been carried out and choose Machine Comparison >
Display Archive Result, the file with the auto archive result is displayed.

Table 4-5: Sample file for an auto archive result

13.02.2007
MACHINE44

NC data only in the machine
MPF.DIR
CYLINDERHEAD4713 .MPF
DRIVINGGEAR4713 .MPF
mpf.dir\DPWP.INI
SPF.DIR
CUT-OFF-CYCLE.SPF
FINE-GRINDING-CYCLE.SPF
WKS.DIR\ GEARBOX4713.WPD

NC data only in the DNC system
4-VALVE-CYLINDER-HEAD 2.MPF
CUS_1.ARC

GEARBOX0815\ GEARBOX0815 1.MPF

NC data not the same
6-VALVE-CYLINDER-HEAD 3.MPF
GEARBOX4712_ 1.SPF

GEARBOX0815\ GEARBOX0815_ 3.SPF
All files of above list were archived.

(DNCAArch)

20:16:56

WKS.DIR\ GEARBOX4713.WPD\ GEARBOX4713.MPF
WKS.DIR\ GEARBOX4713.WPD\ GEARBOX4713.SPF

(DNCAArch) 3 Files were obtained from machine.
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4.6 Data organization

4.6.1 Database

General

DNC organizes data as follows:
The administrative data is organized in the database.

The database of the local DNC Cell is MSDE or SQL Server.

The database for the DNC Plant server variant is MSDE or SQL Server. An
Oracle database can also be used.

The actual NC data files are managed in the file system.

Database structure

The DNC database is managed in the following tables:

FBDN1/4-96

NODETABLE
DNCNODEINFO
DNCDATA
DNCDATATYPE
DNCWORKPIECE
DNCGLOBALSETTINGS

DNCLISTDESCRIPTION
DNCFORMDESCRIPTION
DNCTABLECOLUMNNAME

DNCFILTERHEADER
DNCFILTERCOLUMN
DNCFILTERASSIGN
DNCLOG
USERGROUPBASETABLE

(Plant configuration with DNCNODEINFO)
(Plant configuration with NODETABLE)
(Management of NC data)

(File type management)

(Management of the workpieces)

(Global settings such as version strategy
etc.)

(Description of the list display)
(Description of the screen display)
(Language-specific translations of the
DNCDATA columns)

(Management of the individual filters)
(Management of the individual filter criteria)
(Management of filter assignments)

(Log book)

(Management of the users in MCIS)

USERGROUPPERMISSIONTABLE "

USERBASETABLE
USERPROFILETABLE
PRODUCTTABLE

(Management of the installed MCIS
products)

© Siemens AG 2010 All Rights Reserved
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DNCDATA *

HEDATAID
NODETABLE * | |WODED

3 |MODEID [ |NCDATANAME
" |MODETYPE [ BICTCDATAT P
MODEMAME YERSIOM
PARENTID WORKPIECE
T |MODEICON TRIALCUTID

NODECPTIONS RELEASEID
PRODUCTS LEMETH
TREECRDER LOADCOUMTER
— [ |LASTLOAD
LOCKMAME
DEVELNAME
DEVELDATE
MODHAME
MODDATE
ADMINMAME
ADMINDATE
LOADID
LOADORDER:
AUTOARCHIY

Fig. 4-19: Database structure of the machines, NC and NC type data

List description

4 NC data management

DNCDATATYPE *

o= H DMCDATATYPE

CRDERMUM

The DNCLISTDESCRIPTION database table is responsible for the layout of the list

on the basis of the display group.

A display group can be assigned to one or more user groups.
For each display group, the fields in the management table for the NC data and for
the list display on the right of the screen in DNC can be defined in accordance with

the following criteria:
e Order of fields
e Column width on output

Note

You can use the List editor in DNC to create and edit the list display (see also:

Chapter Configuration).

Only fields that have been configured are displayed.

MHame I * I Type I Werziah | Trialcut 1d I Release Id I Lengtl
Z| cut-off-cpcle SPF 4 1 0 av
cut-off-cycle SPF 3 1 i 787
cut-off-cycle SPF 2 1 i 787
manual_gear MPF 3 1 i 4965
@ gear-pellow
Fig. 4-20: List display variant of the operator interface
© Siemens AG 2010 All Rights Reserved
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Screen description

The DNCFORMDESCRIPTION database table is responsible for the layout of the
screen displays for the Properties dialog for NC data on the basis of the display
group.

A display group can be assigned to one or more user groups.

The fields for the screen display of the NC data properties in the management table
for NC data can be defined for each display group. This includes:

¢ Assigning the database fields to certain tab pages on the screens

e Positioning the field content on the screen

e Defining the output field type

Note

You can use the Screen editor in DNC to create and edit the description of the
Properties screen (see also: Chapter Configuration).

© Siemens AG 2010 All Rights Reserved
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The plant configuration can be mapped via the NODETABLE and DNCNODEINFO

database tables.

DNCNODEINFO contains additional configuration data for the different nodes.

NC administrative data

The DNCDATA database table describes the NC administrative data. Pointers
exist to NODETABLE and DNCNODEINFO (with regard to the plant configuration)
and to DNCDATATYPE (with regard to the data type).

The following database fields are configured by default:

Table 4-6: DNCDATA database table

Database field Description Field length and type
NCDATAID Internal database field Long integer
NCDATANAME NC data name Character (40 chars)
DNCDATATYPE NC data type Character (3 chars)
VERSION Version number of the NC data Long integer
NODEID* Internal database field Long integer
WORKPIECE** Workpiece Character (40 chars)
TRIALCUTID Trial cut ID Range of values: 0/1 Long integer
RELEASEID Release ID Range of values: 0/1 Long integer
LENGTH Length of the NC data Long integer
LOADCOUNTER Number of accesses Long integer
LASTLOAD Date/time of last download Date/time
LOCKNAME Locked by user... Character (32 chars)
DEVELNAME NC data developer Character (32 chars)
DEVELDATE Development date Date/time
MODNAME Name of person who modified NC data Character (32 chars)
MODDATE Change date of the NC data Date/time
ADMINNAME Name of person who changed admin. data | Character (32 chars)
ADMINDATE Change date for administrative data Date/time
LOADID Load ID Range of values: 0/1 Long integer
LOADORDER Load order for workpieces Long integer
AUTOARCHIV ID indicating whether data has been Long integer
uploaded via the auto archive function.

* External key for the NODETABLE database table.
name of the node.

This is used to determine the

** Like * (relevant if the NC data refers to a workpiece)

Note

Depending on the project, the table can be extended to include variable fields.
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NC data type management

The DNCDATATYPE database table contains all the file types supported by the
configuration.

Table 4-7: DNCDATATYPE database table

DNCDATATYPE ORDERNUM | Description
MPF 1 Main Program File Main NC program
SPF 2 SubProgram File NC subprogram
TOA 3 Tool Offset Active Tool offsets
ZOA 4 Zero Offset Active Zero offset
RPA 5 R-Parameter Active Memory area in the NCK for R-
parameters
WPL 6 WorkPLan ASCII file for tool plans
JOB 7 JOB Job lists
BMP 8 BitMaP Graphics file for clamping sketches etc.
ARC 9 ARChive Archives
INI 10 INltialization Initialization program
COM 11 COMment Comments
AWB 12 Display description
LST 13 Display LiST Display list
TOP 14 TOolPlan Tool plan
CEC 15 Sag/angularity
EEC 16 Measuring system error compensation
QEC 17 Quadrant Error Compensation
Quadrant error compensation
PDF 18 Portable Document Format Text and graphics in PDF
format
JPG 19 Joint Photographic Experts Group Graphics file
TIF 20 Tagged Image File  Graphics file
WPD 21 WorkPiece Directory Workpiece directory
TTD 22 Tool Target Data Tool target data
Note

If other NC data types are required, the table can be extended.
The data type WPD must not be used.

Managing the workpieces

The DNCWORKPIECE database table is used for managing the workpieces. It
defines the location of different workpieces in the plant topology.

FBDN1/4-100
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User administration

User administration is carried out jointly for all MCIS programs.
This involves defining user groups, creating users, and assigning them to a user

group.

The following DNC-specific settings are available:

Display group

Users are assigned the list and screen layout of their display group in the
operator interface. The display group must be assigned to a user group.
Initial level

The initial level determines the view of the tree structure and is user specific.
Station affiliation

The station affiliation is only evaluated in the server variant.

Display size of the operator interface

Managing the filters
The DNCFILTERHEADER database table is used to manage the individual filters.

It is structured as follows:

FILTERNAME contains the unique filter name.

FILTERCOMMENT determines the comments.

TABLENAME defines the table to which the filter belongs (DNCDATA or
DNCLOG).

USERNAME defines the user for whom this filter was configured, or the user
who created it.

USERGROUPID defines the user group for which this filter was configured.
DISPLAYGROUP defines the display group for which the filter was configured.
STATION defines the station for which the filter was configured.
APPLICATION defines the application for which this filter was configured
(e.g. DNC IFC SINUMERIK or DNC HMI).

© Siemens AG 2010 All Rights Reserved
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Managing the filter criteria

The DNCFILTERCOLUMN database table is used to manage the individual filter
criteria. In this table, each criterion of a filter is represented as a data record. As a
result, DNCFILTERCOLUMN contains x data records for one data record in the
DNCFILTERHEADER table.

It is structured as follows:

FILTERHEADER _ID is the assignment of a criterion to a filter in the
DNCFILTERHEADER table.

ROWNUMBER defines the order in which the criteria appear in the filter criteria
dialog.

COLUMNNAME defines the column name that is filtered.

TYPE defines the data type of the column name (a distinction is made, for
example, according to date, integer, flag, character, etc.).

OPERATOR defines the operator (equal to, not equal to, greater than or equal
to, etc.).

CONDITIONVALUE defines the value that is filtered.

FLAGS indicates whether this criterion is active or inactive (checkmark in the
filter criteria dialog).

Managing the filter assignments
The DNCFILTERASSIGN database table is used to manage the filter assignments.

It is structured as follows:

FBDN1/4-102

FILTERASSIGN_ID is a system-internal variable that is assigned
automatically.

FILTERHEADER_ID is the assignment of a criterion to a filter in the
DNCFILTERHEADER table.

NODEID is used to assign a filter to a machine for DNC IFC SINUMERIK.
STATION defines the station for which the filter was configured.
TABLENAME defines the table to which the filter belongs (DNCDATA or
DNCLOG).

USERNAME defines the user for which this filter was configured.
APPLICATION defines the application for which this filter was configured.
SUPPLEMENT1

SUPPLEMENT2
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Language-specific translations of the column names in database tables

The DNCTABLECOLUMNNAME database table is used for the language-specific

translation of the columns in the DNCDATA table. This table is relevant for the

filter, list editor and screen editor.

The table is structured as follows:

e Assignment of the data record to a table.

e Assignment of the data record to a column name in the table.

e Language ID (GR, UK, FR, SP, etc.); this assigns the data record to a
language.

e Translation of the column name into the relevant language.
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4.6.2 File system

The file system reflects the plant configuration:
The DNC configuration elements "group"”, "machine", "link" and "workpiece" are
stored in the file system as directories, while the NC data is stored as files. The
directory structure of the file system is similar to the tree structure on the left of the

interface.

#+ DNC - Terminall

Eile Edit “iew Options

Machine Alignmert

Help

|| & Bo |« X & il ¥

| Fiter  |MFF |
J Address
] Hame | * | Tupe | We
S ﬁ area motars . B-valve-cylinder-head % b=F
EI """"" 1 group B '3-"'|'n'_jer3 cut-off-cpcle SPF
TR I'I'IEICI'h'I!rIE gi'fr fine-grinding-cycle SPF
""""""" Hsrddsaha PictureT BHF
............. machme 38.“: e .
: Picturel * BMP
------------- machine 44-en T TOA
R machine 49-dt 2 . o L
=23 group & cylinders E walvr-rplinder-kead kA =F
............ machineg 1 Zod 204,
............. machine 2 9 cylinder-head
Eﬂ .......... .ﬁ area gear
d | i
| [T T 4

Fig. 4-21: Tree structure of operator interface

Table 4-8: Standard icons in the directory

ROOT
Group/subgroup
Link

VS T

Machine with DVK transmission
module ("SINUMERIK 840D")
Machine (transfer serial without
protocol)

Machine with "SINUMERIK*"
transmission module

NC package*

Network file systems
Workpiece

NC file

NC file with comment (similar to:
SPF, etc.)

NC file with attachment

Tool setting device

* Only available in conjunction with Siemens PLM Teamcenter
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Group/machine/workpiece

NC data

Link

In the file system, these administrative units are represented as directories in the
plant structure, whereby groups can contain subdirectories (groups, machines, and
workpieces). Machines can contain workpieces as subdirectories. Any of the
folders may contain NC data files.

This directory structure is located in the NC data master directory. The NC data
master directory is located under the data directory (specified during installation)
in the "Data" subdirectory.

Example: C:\Siemens\MCIS\Data\DNC\Data

The actual NC programs, subprograms, tool setup data, graphics data, and so on
are represented as files in the system; the associated administrative data is stored
in the database. NC data can be stored in any of the directories in the DNC system
(group, machine and workpiece).

The file name of an NC administrative data record comprises the NC data name,
the version number, and the NC data type.
Example: data name_13.MPF

You can use the links to view the files in the linked directory. Like files, these are
assigned the relevant access rights.
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4.7 Consistency check

4.7.1 General

The consistency check is used to check for and rectify inconsistencies between the
NC administrative data records in the database and the NC data files in the DNC
file structure.

A quick consistency check is performed each time DNC Admin is started. If
inconsistencies are found, a message popup is displayed drawing the user's
attention to this.

Inconsistencies can occur, for example, if an old backup of the database is
imported, which means that database entries are missing or that there are too
many entries.

Inconsistencies must not occur under normal operating conditions. In this context,
"normal operating conditions" means that the database is not replaced and that the
DNC file structure is modified using DNC. If inexplicable inconsistencies occur on a
regular basis, however, contact our support team.

Note

With DNC Plant, you are advised to check for consistencies and rectify these
directly on the server because the consistency check covers all the NC
administrative data for all groups and machines.
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4.7.2 Consistency check when DNC Admin is started

The consistency check performed when DNC Admin is started counts all the files
in the DNC file structure. The number of files (see also Fig. 101 NC data files) is
compared with the number of NC database entries (see also Fig. 96
"Administrative data records"). The message popup shown above only appears if
the numbers in these two fields differ.

DNCAdmin |

36 M management data blocks but
101 ML data files.

Fig. 4-22: Consistency check when DNC Admin is started

Note

Since only the number of files and records is checked, inconsistencies can still
occur even if the message popup is not displayed. To ensure that all
consistencies have been rectified, the user must call up the Consistency Check
dialog.
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4.7.3 Consistency Check dialog

The Consistency Check dialog contains a list of the inconsistencies found and the
options available for rectifying them.

Note

The Consistency Check dialog is only regenerated when it is opened. This means
that changes (rectified inconsistencies) not made in this dialog will not be visible
until the dialog is closed and opened again. Toggling between the options
described below does not result in the consistency being checked again because
the user would have to wait a long time in the case of large plants.
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Missing files

Consistency check result E

Mizzing files |

ciziemensmcizidncidatalarea gearsiautomatic gear'aaaaa_1 .mpf

csiemensimcizidnc\datalarea gearstautomnatic gearblablabla_1 .mpf
chsiemensimcisidnc\datalarea gearstautomatic gear'machine 1'bohrungen_aufhdngung_122_1 spf
csiemensimcizidncidatalarea gearstautornatic gearimaching 1wellekhbd711 1 mpf
csiemensimcisidncidatalares gearstautomatic gearimachine 1'%khbt3_1 .mpf
clhziemensimoizidncidatatarea gearsiautomatic gear'machine 1motar_z2_1 .mpf

— Consistency option:
Delete

™ Migsing DB enties for directonies
[Ereate

I

" Mizssing database entries ™ Migsing workpiece in ‘WP table
E xit

Fig. 4-23: Consistency Check dialog: Missing files

This dialog displays administrative data records for which the corresponding file is
missing.

The complete path in which the file should appear is displayed. This path
comprises the NC data master directory (in this case:
C:\Siemens\MCIS\Data\DNC\Data\) and the subdirectories for the group(s),
machine, workpiece and attachments for NC data. The file name of an NC
administrative data record comprises the NC data name, the version number and
the NC data type.

Example: data name_13.MPF

To delete the selected administrative data records from the database, choose
Delete.

You can also use Microsoft Explorer to add the file at the required location. The
name of the file is not case sensitive. If you carry out this step, you have to close
the Consistency Check dialog and open it again so that this inconsistency is no
longer displayed.
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Missing database entries for NC data

Consistency check result E
Mizzing databaze entriez |

q ensimoisidncidata barea matarshgroup B cylindersimachine 43 dtsmator 22 1.mpf
chgiemensimcisidncidatatarea motorshgroup B cylindershmachine 39_ithcastro_7.mpf
cgiemensmcisidncidatabarea motorsharoup B cylindershmachining centrehclamping setup_1.mpf
o hsiemensimcisidncidatatarea motorsharoup B cylindershmachining centretcut-of-cycle_d spf
chziemenzimeiztdncidatatarea motorshgroup B cylindershmachining centretcylinder. ct:

o hsiemensimcisidncidatabarea motorsharoup B cvlindershmachining centrehclamping setup_2.mpf
chsiemensimcizidnctdatatarea motorshmotartd-valve-cylinder-head_12.mpf

— Conzistency optian:

Drelete |
' Missing files " Mizsing DB entries for directariss
Create |
% Miszing databaze entries "~ Mizzing workpiece in WP table |
E xit

Fig. 4-24: Consistency Check dialog: Missing database entries for NC data
This dialog displays files located in the NC data master directory and to which no
administrative data record is assigned in the database.

The complete path is displayed in which the file without an administrative data
record is located.

To delete the selected files from the NC data master directory, choose Delete.

To create an administrative data record for this file, choose Create. The Properties
dialog is displayed for each file.
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Missing database entries for directories

Consistency check result *
Mizzing DB entries for directories |

nensimecisidnchdatabarea motorshgroup 8 colinders\machine 37 #

o hsiemensimoisidnc v datasimporttest

— Consistency option:

Delete |
" Missing files ' Mizzing DB entries for directonies

[Ereate |
" Mizsing database entries " Mizsing workpiece in WP table

Eit |

Fig. 4-25: Consistency Check dialog: Missing database entries for directories
This dialog displays directories located in the NC data master directory but which
do not appear in the database as a group, machine, or workpiece.
The complete path is displayed.

To delete the selected empty directories from the NC data master directory,
choose Delete.

Empty directories that do not contain any files are identified by means of ™" at the
end of the directory name. Only these directories can be deleted.

Alternatively, you can create a group, machine or workpiece with the same name
using DNC Admin in configuration mode in order to rectify these inconsistencies.

Exception:
Directories of NC packages cannot be created in this way.
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Missing workpieces in the workpiece table of the database

Consistency check result E

Group ! Maching | work piece |
HG1WGET _HG Wit makor

— Conzistency optian:

[elete |
= Mizsing files = Mizsing DB entries for directonies

Create |
" Mizssing database entries & Hizsing workpiece in WP table

E wit

Fig. 4-26: Consistency Check dialog: Missing workpieces in the workpiece table of the database

The "Missing WP in WP Table" radio button is only active when inconsistencies in
workpieces have been detected.

Note

If inconsistencies occur with workpieces, you are advised to correct the
inconsistencies in "Missing Files" first before correcting the inconsistencies in the
workpieces.

This inconsistency occurs automatically if you want to use a MCIS database from

an earlier version of DNC. This dialog can also be used to update your older 2.x-

version database in the workpiece area. To do so, select all your workpieces and
choose Create.

SINUMERIK*: SINUMERIK 810D
SINUMERIK 840D
SINUMERIK 840Di
PCUS50 under Windows with SINUMERIK 840D sl
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5.1 Structure of the user administration

User-specific data is defined via the user administration under Tools - User
Administration. The user administration is only available in DNC Admin and can
only be accessed by authorized users. Each user must be assigned to a user
group.

User groups

A user group combines users with the same user rights and the same display
group, that is, each individual user in a user group is assigned the same DNC user
rights and the same list and screen display.

Users

To allow individual access to the DNC software, users must be configured with
passwords. Each user is assigned further special parameters (see also:
Sections 5.2, 5.3).
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5.2 User administration

5.2.1 General

5 User administration

When the user administration function is called up, all the user names are listed

along with the user group, language, and product.

When you choose Change or New, a user administration dialog is displayed in
which the existing user data can be changed or new users defined. To delete a
user, select the user in question and choose Delete. To make a user-specific filter
assignment, choose Assign Filter.

|_group

| language | product selection I

a

M arne

adrministratar ADMIN LE DHC

dnc ADkIM 1K DMNE Change |

HHIK eyPosition INFO UK, DNC

HMIEeyPosition INFO K DMC Mew

HMIK eyPosition? USER UK, DHC

HMIK eyPosition? USER UK, DNC

Hid M arwfacturer ADMIN UK, DNC Delete |

HMIS ervice ADMIN LK. DNC

HHdI S pstern ADMIN UK, DNC

HMILiser ADMIN LK, DNC User Groups
k achine List

Azzign Filter
| 4'

Fig. 5-1: Overview of existing users
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5.2.2 Creating new users / changing user properties

To call up the dialog in which you can define users, choose New or Change in the
user screen. Here, you can create a new user or change the properties of an
existing user that you selected beforehand. The following parameters are available:

User name

Full name

Access password

User group (group to which the user belongs)
Area to be displayed

The two checkboxes allow you to select the large-format user interface and
activate the filter.

Lzer narne: IInfu:u
Camplete nare: ILDgin far programnner Cancel |
Password: |’“‘x
Confirm password: I*’“‘
Izer group: IINFEI j
Ilzer groups
Filker active: I+ Large display: I

Fig. 5-2: Screen for creating/changing users

User name

The user name is the name specified when the user logs on to DNC.

Full name

Text can be entered in the Full Name field to provide additional information about
the user name. This text is only visible here.
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Password

The password is required by users to identify themselves when they log on. For
security purposes, the password must be entered again in the Confirm Password
field.

Note

As delivered, a user DNC (password: DNC) is always defined with administrator
rights.

During commissioning, you should create a new administrator and delete the user
DNC or, at the very least, assign it a new password.

User group

An existing user group for assigning user rights and the display group can be
selected in the User Group selection field. If a user group with the required access
rights or display group does not exist, you must create a new user group. To call up
the dialog for creating/modifying user groups, choose User Groups.

See also: "Managing user groups"”

Filter activated

If the Filter Activated checkbox is activated, the last filter used is active for this
user once the user has logged on.

Note

If a filter has not yet been defined, the user has an unfiltered view of all the NC
data defined in the system.

Large display

The Large Display checkbox determines the size of icons and text when displayed
on the user interface. The large display makes the user interface easier to read for
users in workshops.
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5.2.3 Assigning filters for users

Filter assignment - Admindata

DHC

SPF Filker
DMC Admi...

SPF Filter

siemers
ZIEMErs

bl achine:

IJzer I filker name I application | station | machine I Cloze
DHC MPF Filter OMCIFC ... M achine2
SPF Filter DMC Admi... - Dielete

di.

Tablz
zelection

Pozzsible users

Filter name : : R =
DNE [MPF Fiter I ZIoNC Haw
= OHE Statich: [ helper . Change
. [ HMIk.eyPasitiond
™ | OHE Edmin I j [ HMIK eyPasition] Liceent

— DMC IFC SIMUMERIK

7 onCIFC SINUH [B Hachine

[ HIKeyPasition?

HIF eyPozition3 i
4 | i»

[Faice]

L

Fig. 5-3: Filter assignment

To assign filters, choose Tools - User Administration and then Assign Filter.
This allows you to assign filters to users. You can do this both for the standard
DNC user interface and for the DNC Admin configuration program as well as for
machines with DNC IFC SINUMERIK.

You can use the Assign Filter dialog to create, change, or delete filter assignments.
The dialog is divided into two parts:

The upper part is used to select and delete an existing filter assignment. Using the
Select Table button, you can choose the database (NC administrative data or log

data) to which the filter assignment is to apply.

The lower part of the dialog is used to change or create filter assignments.
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Select table

You can use the Select Table button to choose the database for the filter
assignment. You can select from the following options:

e Administrative data (NC administrative data)

¢ Log data (records of all the errors and messages that occur)

Deleting a filter assignment

To delete a filter assignment, first select the assignment you want to delete and
then choose Delete. You can only select and delete one filter assignment at a time.

If you want to delete more than one filter assignment, first sort the list so that all of
the assignments you want to delete appear underneath each other. Select the first
entry to be deleted and then delete the other entries individually.
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Adding or changing a filter assignment

You can create one or several new filter assignments by choosing New. You can
change the selected filter assignment and create one or more new filter
assignments by choosing Change.

The following settings need to be made:

Select filter name

A list of users that can use this filter is then displayed. This list can be
restricted to a small number of users depending on the restriction criteria set
when the filter was configured. (See also: "Creating or changing filters").

Assign users
The relevant checkbox must be activated for each user to whom this filter is to
be assigned.

Choose application(s)

After you have chosen at least one application (DNC IFC SINUMERIK, DNC or
DNC Admin) for which the selected filter is to be assigned to the selected
users, you have to choose an entry in the combo box.

DNC / DNC Admin

In the Station Name combo box in DNC and DNC Admin, an empty combo
box means that the filter assignment applies to all stations. If you specify a
particular station, however, the filter assignment applies to this station only.

DNC IFC SINUMERIK

If you select a group for DNC IFC SINUMERIK, a filter assignment is created
or an existing filter assignment changed for all the SINUMERIK* machines
under this group.

Accept data
Using the Accept button, you can create filter assignments or change existing
ones.

Note

Only one filter assignment can be defined per user, application (DNC IFC
SINUMERIK, DNC and DNC Admin), machine or station. This means that if a
filter assignment already exists, and a new one is nevertheless defined, the old
filter assignment will be replaced by the new one. This is carried out
automatically.
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5.2.4 Managing user groups
Refer to Section 5.3.
5.2.5 Machine list for users

M Mois a

EDi:l group G celinders

- Dn 10774 Cancel |

=00 motors

----- machine 33
..... maching 34-zp
----- machine 33-it
----- machine 44-en —
----- riachine 43-dt
..... O & machine 1334
..... O &8 raching 134-zp
..... O & maching 133t
..... [ & machine 144-en
..... O & machine 143-dt
----- O &8 machine 233
----- O machine 234-2p
----- O &8 machine 239-it
----- O &l machine 244-2n

----- O &8 machine 249-dt i
1 |»

Fig. 5-4: Machine list for enabling/disabling nodes on a user-specific basis

General

You can disable or enable certain nodes (groups, machines, links) for specific
users explicitly. The steps for configuring this are carried out in DNC User
Administration although this applies to all products, that is, the dialog can also be
used by MCIS TPM, for example.

Selecting users

In the user list, you select the user for whom you want to create or change a
machine list.

Note

The machine list is not defined for the user logged on but instead for the user
selected in user administration.
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Determining machine lists

To open the Machine List dialog, choose Machine List.

By selecting/deselecting the checkboxes for the nodes, you can select/deselect the
machines, links, and groups. When you choose OK, the nodes currently selected
are assigned explicitly to the user.

If a user does not have an explicit machine assignment, this user will be able to
see —on DNC computers to which at least one machine is assigned — precisely
those machines assigned to this computer.

If a user has an explicit machine assignment, this user will be able to see — on
DNC computers to which at least one machine is assigned — precisely those
machines assigned to this computer if they have also been assigned to him via
User Administration. The machines in this station that have not been assigned to
him explicitly are not displayed. This is then the intersecting set of station
assignments and assignments made via User Administration.
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5.3 Managing user groups

5.3.1 General

When you call up the function for managing user groups, all the user groups are
listed along with any comments.

When you choose Change or New, a User Group Management dialog is displayed
in which the existing user group data can be changed or new user groups defined.

To delete a selected user group, choose Delete (provided that all the users in this

group have already been deleted).

5.3.2 Creating new user groups / changing user group properties

User groups
I ame | Camrment
ADMIM administrator group
IMFO anly dizplay rights
IUSER WEET

[
Delete |

Fig. 5-5: Overview of existing user groups

When you choose User Groups in the Create User / Change User Properties
dialog, a dialog is displayed in which you can manage the user groups. Here, you
can create a new user group or modify the properties of an existing user group.
The following user groups are defined in the standard DNC system:

e Administrator ADMIN
e Users USER
e Information user INFO
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Cormnrment: IF‘ngrammer graup T — I
Izer rights - Display group
Configure/plan CROLUFAD J

Create MC data and work pieces
Import MC data

Export MC data

Chiarige HC mariagenernl dala
Edit NC data

Il

il

Fig. 5-6: Screen for managing the

user groups

Caution

Any changes made to the properties of a user group apply to all users within this

group.

To create or change a user group, you have to specify the following:

5.3.3 Name of the user group

The name of the user group is displayed in the overview of the user groups
and in the dialog for creating/changing a user.

5.3.4 Comment

A comment is displayed in the overview of the user groups to provide additional

information about

FBDN1/5-124

the user group.
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5.3.5 Userrights

The user rights assigned to users disable or enable the menu options in DNC and
DNC Admin for the user group in question.

Planning/Configuring

When this checkbox is activated, the user is authorized to call up configuration
mode in DNC Admin and to carry out the required configuration activities (View
menu). The user is also permitted to enter or change data in the dialogs for editing
DNCGLOBALSETTINGS and DNCMACFG.

Create NC data and workpieces

When this checkbox is activated, the user group is authorized to create new NC
data and workpieces via File > New or the context menu.

Import NC data

When this checkbox is activated, this user group is authorized to import NC data
manually (File menu).

Export NC data

When this checkbox is activated, this user group is authorized to export NC data
(File menu).

Change NC administrative data

When this checkbox is activated, users are authorized to change the NC data in
the Properties dialog (provided that the properties screen contains fields that can
be changed).

Edit NC data

When this checkbox is deactivated, an NC data file is opened as read only. No
changes can be made to the original file or saved.

Copy/paste NC data in administrative data

When this checkbox is activated, users are authorized to copy and paste NC data
(Edit menu and context menu).

Copy/paste NC data in link

When this checkbox is activated, users are authorized to copy and paste NC data
from/to links (Edit menu and context menu).

Note

Both rights must be assigned to enable data to be copied from a link to the
administrative data and vice versa.
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Delete NC data

When this checkbox is activated, users are authorized to delete NC data. The
function for deleting versions in the Delete Version dialog is separate from this.

Cut NC data

When this checkbox is activated, users are authorized to cut NC data files (Edit
menu and context menu).

Download NC data with release identifier

When this checkbox is activated, users are authorized to download NC data (File
menu, context menu and icon in toolbar) with a set release identifier.

Download NC data with trial cut identifier

When this checkbox is activated, users are authorized to download NC data (File
menu, context menu and icon in toolbar) with a set trial cut identifier.

Upload NC data

When this checkbox is activated, users are authorized to upload NC data (File
menu, context menu and icon in toolbar).

Compare NC data

When this checkbox is activated, users are authorized to carry out a comparison
between two NC data files and a machine comparison with SINUMERIK*.

This function is only supported, however, if the DNC Compare option has been
installed.

Reset release identifiers

When this checkbox is activated, the Reset Release ID function (multiple selection)
in the Edit menu and in the context menu is available. The function can, however,
also be enabled for an individual NC data file in the Properties dialog.

Configure list descriptions

When this checkbox is activated, users are authorized to call up the list editor in
DNC Admin (Tools - List Editor menu).

Configure screen descriptions

When this checkbox is activated, users are authorized to call up the Screen editor
in DNC Admin (Tools - Screen Editor menu).
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Configure user

When this checkbox is activated, the user group is authorized to activate user
administration to create users and user groups, assign rights, or delete users
(Tools = User Administration menu in DNC Admin).

Note

If a user deactivates his own Configure User right, he will no longer be able to
access User Administration.

Change tools settings

When this checkbox is activated, the user group is authorized to make changes in
the Tools > Settings menu (e.g. change the language).

Perform consistency check

When this checkbox is activated, the user group is authorized to perform
consistency checks. This right should only be assigned to administrators because
the Consistency Check dialog lists not only the inconsistencies found but also the
options for rectifying them (Tools menu).

Configure filter

When this checkbox is activated, the user group is authorized to create, change, or
select filters (View menu).

Change filter

When this checkbox is activated, the user group is authorized to change filter
values (View menu). The change is, however, temporary and is only valid until
DNC is exited.

Note

When the Configure filter right is activated, deactivation of Change filter has no
effect.

Select filter

When this checkbox is activated, the user group is authorized to choose between a
range of different filters (View menu). If the group has Configure filter right,
deactivation of Select filter has no effect.

Activate/deactivate filter

When this checkbox is activated, the user group has the option of activating or
deactivating filters via the filter icon.
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Generic filtering

When this checkbox is activated, the user group is authorized to use generic filters.

Print

When this checkbox is activated, users are authorized to print program lists, NC
data, NC administrative data, graphics and comments.

The menu option File = Print and the context menus Print Program List, Print
NC Data, Print Administrative Data, Print Graphic and Print Comment are also
activated.

Create CSV file

When this checkbox is activated, users are authorized to create CSV files.
The Create CSV File context menu is also activated.

Manage attachments

When this checkbox is activated, users are authorized to manage attachments for
NC data.
The Add, Delete, and Rename buttons on the Attachments tab are active.

Open attachments

When this checkbox is activated, users are authorized to open attachments.
The Open button on the Attachments tab is active.

Delete NC data on SINUMERIK 840D

When the Delete NC data on SIN. 840D checkbox is activated, the Delete button
is active on the Upload dialog of the SINUMERIK 840D.
NC data can then be deleted directly on the SINUMERIK 840D.

Start Teamcenter NC Package Viewer

When the Start TC NC Package Viewer checkbox is activated, the Teamcenter
NC Package Viewer can be called.
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5.3.6 Display group

The drop-down list field for the display group is supplied from the
DNCFORMDESCRIPTION screen definition table in the database. All of the
display groups defined here appear in user administration

(see also: Sections 10.8 - List editor and 10.9 - Screen editor).

SINUMERIK*: SINUMERIK 810D
SINUMERIK 840D
SINUMERIK 840Di
PCUS50 under Windows with SINUMERIK 840D sl

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition FBDN1/5-129



DNC Plant/DNC Cell (FBDN1) 05.07
5 User administration

Notes
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6.1 General information about the dialog function

The dialog function (DNC IFC Dialog) is optional. In the case of machines
connected in series, it allows data to be downloaded/uploaded directly from the
CNC machine tool. Dialog programs for requests (created via an editor on the
controller) and responses are exchanged between DNC and the machine server.
These contain the data relevant for the download/upload.

If a machine is configured with the dialog function (see also "Configuration"), the
associated machine server is started when the DNC program is started (unlike in
general mode) and runs until the program is ended. This means that the defined
interface is always occupied.

Note

If the required COM interface is not opened when the DNC program is started,
repeated attempts are made to open it.

For special requests, in addition to the integrated dialog interpreter,
an external dialog interpreter in the form of an ActiveX DIl can be integrated.

Important

The following controller requirements must be fulfilled:

e It must be possible to save at least two NC programs on the controller.

e An NC program editor must be available with which an NC program can be
generated.

e The alphanumeric characters of the required NC program name must be
available on the machine's operator panel.

If one or more of these requirements is not fulfilled, you can use the dialog
function with an additional input terminal (handheld).

Fig. 6-1: Dialog function with additional terminal
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6.2 Dialog program

6.2.1 Program structure

DNC IFC Dialog analyzes the following rows in the [DIALOGFUNCTION] section
of the machine configuration file:

Program number

Dialog function ID
%MPF9999

Command program row

Dialog function command
(S), (ST); (SL) or (R)

File name program row

File name
e Specific name
e (Wildcard)

o X999 (wildcard alternative for controllers that cannot edit all characters)

File types program row

File type
e Specific type
e (Wildcard)

e Y001 (alternative for specific type with controllers that cannot edit all
characters; Y001 normally represents MPF files)

The program end IDs M00, M17, and M30 are evaluated indirectly.

Note

This section of the machine configuration file can also be created in the
configuration dialog, which is described in Section Configuration - Configuration
dialog - Dialog function tab page.
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6.2.2 Examples

Table 6-1: Example of a download request with default configuration parameters

Sample file Description
SMPF9999 Dialog program
Request from CNC machining unit
(8) Request to download a released NC data file
(TEST_1) Name of requested file
(MPF) Type of requested file
M30

End-of-program ID

Table 6-2: Example of a standard list request for NC data files

Sample file Description
SMPF9999 Dialog program
Request from CNC machining unit
(sL.) Request to download an NC data file list
X999 Wildcard replacement for *
Y002 File type SPF due to 2nd field entry in standard DNCDATATYPE
M30

End-of-program 1D

FBDN1/6-134
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6.3 Dialog program responses
6.3.1 Program structure

Program number

ID for a response to a formulated request.
%MPF9998

1st to nth program row

e List (response to list request)
e Error message (response to a program request that cannot be fulfilled)

End-of-program ID
M30
6.3.2 Examples

Table 6-3: Example of a response to a standard list request

Sample file Description

$MPF9998 Response ID to a formulated
request

(Name size...changed on) List header

(zkpf_1.mpf 24096 06.05.99 17:59:04)

List content

(zkpf_2.mpf 28116 10.05.99 08:03:40)

List content

M30 End-of-program ID

Table 6-4: Example of a response to a program request that cannot be fulfilled

Sample file Description

$MPF9998 Response ID to a formulated
request

Requested data not found! Request:Zkpf 2.mpf Error message

M30 End-of-program ID

Note

In the DNCGLOBALSETTINGS database table, the DLGFUNCLISTREQ
parameter defines which NC data files are included in the list.

1 = released NC data files only

2 = NC data files with trial cut ID only

3 = released NC data files with trial cut ID only

0 is not permitted.
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6.4 Configuration parameters

The configuration parameters for the dialog function are defined in the machine
configuration files (.MCF) in the [DIALOGFUNCTION] section. The standard
configuration parameters and their meaning are listed in the table below.

Note

This section of the machine configuration file can also be created in the
configuration dialog, which is described in Section Configuration - Configuration
dialog = Dialog function tab page.

Table 6-5: Configuration parameters for the dialog function

Configuration parameters Description Standard
configuration
DigScanLines Number of rows to be searched through for a 10
DIgID parameter in the NC data file, starting from
row 1.
DigID ID for a dialog program for a formulated request | %MPF9999
DigIiDSend ID for a response to a formulated request. The %MPF9998

response can have the following content:

e List (response to list request)

e Error message (response to a program
request that cannot be fulfilled)

DlgSendEnd Program end of a response (list, error) from DNC | M30
to the machine.

DigSendCmd Command to download released NC data files. (S)

DIigSendTcCmd Command to download NC data with trial cut ID | (ST)

DigReceiveCmd Command to upload NC data files. Two programs | (R)

are sent one after the other:
e Request program
e Program to be uploaded

DigSendListCmd Command to request a list. The ID must be in the | (SL)
1st line of the NC data file.

DigWpdMark ID for workpieces in the dialog program. In the WPD
case of controllers that cannot edit all characters,
path information or conditions (e.g. Z888 or
G040) are also possible.

© Siemens AG 2010 All Rights Reserved
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DIigExchangeCNCType

ID for file types in the dialog program. In the case
of controllers that cannot edit all characters, path
information or conditions (e.g. Y001 or G02) are
also possible. The character is declared in the
"Dialog" section. The numeric constituent of the
ID refers to the ODERNUM field in the
DNCDATATYPE database table.

Y

DIlgExchangeWildcard

Wildcard alternative for controllers that do not
support * (e.g. in the case of requests for lists of
all data types or file names).

X999

DigConverter This parameter can be used to configure an DNCDIgl.DNCChntrl
external dialog interpreter.
DigSubNumber This parameter can be used to assign an 0

additional ID for the interpretation type to the
external dialog interpreter.
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Notes
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© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition

7 Code conversion function

FBDN1/7-139



DNC Plant/DNC Cell (FBDN1) 05.07

7 Code conversion function

7.1 Code conversion

General

DNC uses NC programs in ASCII code. Data is always downloaded/uploaded in
the code required by the CNC machine tool. If necessary, the code may have to be
converted. The DNC code conversion server supports three types of code:

e ASCIl code

e |SO code

e EIA code

To download/upload NC programs in a particular code, the code must be converted
via a code conversion table, which allows characters to be converted individually or
filtered out.

Code conversion tables

The CODES.TXT file in the program directory contains all the code conversion
tables. A table is defined for each code type and transmission direction. It begins
with its name, which comprises the code type and transmission direction (OUT =
download; IN = upload). The table content is enclosed by {}. Each row in the table
comprises a series of assignments, whereby an output value is assigned to an
input value. An assignment is made as follows: #2A AA ™'

# Start of assignment

2A Two-digit input value in hex
Blank used as separator

AA Two-digit output value in hex
Blank used as separator

™ Mnemonic as comment
Two blanks used as separator

The code conversion table can also be used to hide certain characters. For this
purpose, FF must be entered as the output value.

Note

The offset must never be changed; if it is changed, this could result in non-
initializations or incorrect initializations.

Note

Each station is only assigned one code conversion file (CODES.TXT).
Any changes made in one of the six code conversion tables only affect machines
that use this code type.
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7.2 Examples

The code conversion tables can also be used to create a machine-specific code.
For this purpose, a different output value is assigned to an input value in the ASCII
code conversion table.

Table 7-1: Modified ASCII code conversion table

Original code conversion table Modified code conversion table
ASCII_OUT ASCII_OUT

#0D 0D 'CR' ... #0D OA 'CR'

1 1

Table 7-2: Hidden "CR" characters in ISO code

Original code conversion table Modified code conversion table
IS0 OUT IS0 OUT

#0D 8D 'CR' ... #0D FF 'CR'

P P
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7.3 Code conversion tables

Table 7-3: Code conversion table: ASCIlI_OUT

ASCII_OouT

{

#00 00 NUL #01 01 SOH #02 02 STX #03 03 ETX #04 04 EOT #05 05 ENQ
#06 06 ACK #07 07 BEL #08 08 BS #09 09 HT #0A OA LF #0B 0B VT
#0C OC FF #0D OD CR #0E OE SO #OF OF Sl #10 10 DLE #1111 DC1
#1212 DC2 #13 13 DC3 #14 14 DC4 #15 15 NAK #16 16 SYN #17 17 ETB
#18 18 CAN #19 19 EM #1A 1A SUB #1B 1B ESC #1C 1CFS #1D 1D GS
#1E 1E RS #1F 1F US #20 20 SP #2121 #2222 #2323 (1)
#24 24'¢$' #25 25 '%' #26 26 '&' #27 27 " #2828 '(' #2929")
#2A 2A ™ #2B 2B '+' #2C2C'' #2D 2D '- #2E 2E "' #2F 2F 'I"
#3030'0' #3131'1" #3232 '2' #33 33'3 #34 34 '4' #3535'5'
#36 36 '6' #37 37'T #38 38 '8' #39 39'9' #3A3A" #3B 3B ;'
#3C 3C '<' #3D 3D '=' #3E 3E '>' #3F 3F '?' #4040'@' #41 41'A'
#42 42 'B' #43 43'C' #44 44 'D' #45 45 'E' #46 46 'F' #47 47 'G'
#48 48 'H' #49 49'I' #4A 4A')' #4B 4B 'K' #4C 4C 'L’ #4D 4D 'M'
#4E 4E 'N' #4F 4F 'O' #50 50 'P' #51 51'Q’ #52 52 'R’ #53 53'S
#54 54 'T' #55 55 'U' #56 56 'V' #57 57 'W' #58 58 'X' #59 59'Y"
#5A 5A 'Z' #5B 5B 'T' #5C 5C '\ #5D 5D ' #5E 5E "N #5F 5F ' '
#6060 "' #6161 'a’ #6262 'b' #63 63 'c' #64 64 'd' #65 65 'e'
#66 66 'f #67 67 'g' #68 68 'n' #69 69 'i' #6A 6A '}’ #6B 6B 'k’
#6C 6C'I' #6D 6D 'm' #6E 6E 'n' #6F 6F 'o' #7070 'p' #7171'q'
#7272'r #7373's' #7474 't #7575'U’ #7676 'V' #7777 'W
#7878 'x' #7979y #TATA'Z #7B 7B (2) #7C7C"| #7D 7D (3)
#7E TE '~ #7F 7F DEL

}

Table 7-4: Code conversion table: ASCIl_IN

ASCIL_IN

{

#00 00 NUL #01 01 SOH #02 02 STX #03 03 ETX #04 04 EOT #05 05 ENQ
#06 06 ACK #07 07 BEL #08 08 BS #09 09 HT #0A OA LF #0B 0B VT
#0C OC FF #0D OD CR #0E OE SO #OF OF Sl #10 10 DLE #11 11 DC1
#12 12 DC2 #13 13 DC3 #14 14 DC4 #15 15 NAK #16 16 SYN #17 17 ET
#18 18 CAN #19 19 EM #1A 1A SUB #1B 1B ESC #1C 1CFS #1D 1D GS
#1E 1E RS #1F 1F US #20 20 SP #2121 #2222 ™ #2323 (1)
#24 24'¢' #25 25 '%' #26 26 '&' #27 27" #28 28 '(' #2929')
#2A 2A ™ #2B 2B '+' #2C2C"'' #2D 2D '-' H#H2E 2E ' #2F 2F '/
#3030'0' #3131'1" #3232 '2' #33 33'3 #34 34 '4' #3535'5'
#36 36 '6' #37 37'7" #38 38 '8' #39 39'9' #3A3A " #3B 3B ;'
#3C 3C '<' #3D 3D '=' #3E 3E '>' #3F 3F '?' #4040'@' #41 41°'A'
#42 42 'B' #43 43 'C' #44 44 'D' #45 45 'E' #46 46 'F' #47 47 'G'
#48 48 'H' #49 49'I' #4A 4A ') #4B 4B 'K' #4C 4C'L' #4D 4D 'M'
#4E 4E 'N' #4F 4F 'O' #50 50 'P' #51 51'Q’ #52 52 'R’ #53 53'S'
#54 54 'T' #5555 'U' #56 56 'V' #57 57 'W' #58 58 'X' #59 59'Y"
#5A 5A 'Z' #5B 5B 'T' #5C 5C '\ #5D 5D 1 #5E 5E "N #5F 5F '
#6060 "' #6161 'a’ #6262 'b' #63 63 'c' #64 64 'd' #65 65 'e'
#66 66 ' #67 67 'g' #68 68 'h' #69 69 'i' #6A 6A 'j' #6B 6B 'k’
#6C 6C ' #6D 6D 'm' #6E 6E 'n' #6F 6F 'o' #7070 'p' #7171'q'
#7272'r' #7373 's' #7474 't #7575 'U’ #76 76 'V' #7777 'W'
#7878 'x' #7979y #7TATA'Z #7B 7B (2) #7C7C"| #7D 7D (3)
#7E TE '~ #7F 7F DEL

}
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Table 7-5: Code conversion table: EIA_OUT

EIA_OUT

{

#00 FF NUL
#06 FF ACK
#0C FF FF
#12 FF DC2
#18 FF CAN
#1E FF RS
#24 FF '$'
#2A FF ™
#3020 '0"
#36 16 '6'
#3C FF '<'
#42 62 'B'
#48 68 'H'
#4E 45 'N'
#54 23 'T'
#5A 29 '7'
#60 FF "
#66 76 'f
#6C 43
#7249
#78 37 'x'
#7E FF '~

}

#01 FF SOH
#07 FF BEL
#0D 80 CR
#13 FF DC3
#19 FF EM
#1F FF US
#25 0B '%'
#2B 70 '+
#3101 1"
#3707 '7"
#3D FF '=
#4373°C'
#49 791
H#4F 460"
#55 34 'U'
#5B FF T
#6161’
#6767’
#6D 54 'm’
#7332’
#7938y
#7F 7F DEL

#02 FF STX
#08 2A BS
#0E FF SO
#14 FF DC4
#1A FF SUB
#2010 SP
#26 OE '&'
#2C 3B,
#3202'2'
#38 08 '8'
#3E FF >
#44 64'D'
#4A 51 ')
#50 57 'P'
#56 25'V'
#5C FF '\
#6262 '’
#68 68 'h'
#6E 45 'n'
#7423 't
#7A 29 '

Table 7-6: Code conversion table: EIA_IN

EIA_IN

{

#00 00 NUL
#FF 06 ACK
#FF OC FF
#FF 12 DC2
#FF 18 CAN
#FF 1E RS
#FF 24'$'
#FF 2A ™
#2030'0’
#16 36 '6'
#FF 3C '<'
#62 42'B'
#68 48 'H'
#45 4E 'N'
#23 54 'T'
#29 5A 'Z'
#FF 60"
#FF 66 'f
#FF 6C T
#FF 727
#FF 78 '’
#FF 7E '~

}

#FF 01 SOH
#FF 07 BEL
#80 0D CR
#FF 13 DC3
#FF 19 EM
#FF 1F US
#0B 25 '%'
#70 2B '+
#0131'1"
#07 37'7'
#FF 3D '='
#7343'C'
#7949
#46 4F 'O’
#34 55'U'
#FF 5B
#FF 61'a'
#FF 67 '’
#FF 6D 'm’
#FF 73 '’
#FF 79y
#TF 7F DEL

#FF 02 STX
#2A 08 BS
#FF OE SO
#FF 14 DC4
#FF 1A SUB
#10 20 SP
#0E 26 '&'
#3B 2C",
#02 32 '2'
#08 38 '8’
#FF 3E ">’
#64 44'D'
#514A'J
#57 50 'P'
#25 56 'V'
#FF 5C'\'
#FF 62 'b’
#FF 68 'h’
#FF 6E 'n’
#FF 74 't
#FF 7A'Z
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#03 FF ETX
#09 3E HT
#OF FF SI
#15 FF NAK
#1B FF ESC
#21 FF "
#27 FF ™
#2D 40 -
#3313'3'
#3919'9'
#3F FF '?'
#45 75 'E'
#4B 52 'K'
#5158'Q’
#57 26 'W'
#5D FF 1T
#6373 'C
#6979 1
#6F 46 '0'
#7534 U’
#7B FF (2)

#FF 03 ETX
#3E 09 HT
#FF OF SI
#FF 15 NAK
#FF 1B ESC
#FF 217
#FF 27 ™
#40 2D -
#13 333"
#19 39'9'
#FF 3F '?'
#75 45 'E'
#52 4B 'K’
#58 51'Q’
#26 57'W'
#FF 5D
#FF 63 'C
#FF 69 7
#FF 6F '0'
#FF 75 'U'
#FF 7B (2)

7 Code conversion function

#04 FF EOT
#OA FF LF
#10 FF DLE
#16 FF SYN
#1C FFFS
#22 FF ™
#28 1A ('
#2E 6B "
#3404 '4'
#3AFF "
#40 FF '@’
#46 76 'F'
#AC 43 'L
#52 49 R’
#58 37 'X'
#5E FF '~
#6464 'd'
#6A 51
#70 57 'p'
#76 25 V'
#TCFF |

#FF 04 EOT
#FF OA LF
#FF 10 DLE
#FF 16 SYN
#FF 1C FS
#FF 22 ™
#1A 28 ('
#6B 2E '
#04 34 '4'
#FF 3A "
#FF 40'@'
#76 46 'F'
#43 4C 'L
#49 52 'R’
#37 58 X'
#FF 5E 'V
#FF 64 'd'
#FF 6A
#FF 70 'p'
#FF 76 V'
#FF 7C |

#05 FF ENQ
#0B FF VT
#11 FF DC1
#17 FF ETB
#1D FF GS
#23 FF (1)
#29 4A ")
#2F 31"/
#3515 '5'
#3B FF )
#4161 'A
#47 67 'G'
#4D 54 'M'
#53 32'S'
#59 38'Y"
#5F FF '
#65 75 '¢'
#6B 52 'k’
#7158'q"
#77 26 W'
#7D FF (3)

#FF 05 ENQ
#FF OB VT
#FF 11 DC1
#FF 17 ETB
#FF 1D GS
#FF 23 (1)
#4A 29')
#31 2F '/
#15 35 '5'
#FF 3B}
#6141 'A
#67 47 'G'
#54 4D 'M'
#3253'S'
#3859'Y"
#FF 5F ' '
#FF 65 '¢'
#FF 6B 'k
#FF71'q’
#FF 77 'W'
#FF 7D (3)
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Table 7-7: Code conversion table: ISO_OUT

ISO_OUT

{

#00 00 NUL
#06 06 ACK
#0C OC FF
#12 12 DC2
#18 18 CAN
#1E 1E RS
#24 24§’
#2A AA ™
#3030 '0"
#36 36 '6'
#3C 3C '<'
#42 42 'B'
#48 48 'H'
#4E 4E 'N'
#54 D4 'T'
#5A 5A 'Z'
#6060 "
#66 66 'f
#6C 6C I
#7272
#78 78 'x'
#7E 7E '~

}

#01 81 SOH
#07 87 BEL
#0D 8D CR
#13 93 DC3
#19 99 EM
#1F 9F US
#25 A5 '%'
#2B 2B '+
#31B1'1'
#37B7'T'
#3D BD '='
#43 C3'C'
#49 CO I
#4F CF 'O’
#55 55 'U'
#5B DB T
#61E1'a’
#67 E7'g
#6D ED'm’
#73F3's'
#T9 F9'y'
#7F FF DEL

#02 82 STX
#08 88 BS
#OE 8E SO
#14 14 DC4
#1A 9A SUB
#20 AO SP
#26 A6 '&'
#2C AC ',
#32B2'2'
#38 B8 '8'
#3E BE >'
#44 44 'D'
#4A CA'J'
#50 50 'P'
#56 56 'V'
#5C 5C "'
#62 E2'b'
#68 E8 'h'
#6E EE 'n'
#7474t
#7A FA'Z'

Table 7-8: Code conversion table: ISO_IN

ISO_IN

{

#00 00 NUL
#06 06 ACK
#0C OC FF
#1212 DC2
#18 18 CAN
#1E1ERS
#24 24§’
#AA 2A ™
#3030'0’
#36 36 '6'
#3C 3C '<'
#42 42 'B'
#48 48 'H'
#AE 4E'N'
#D4 54 'T'
#5A BA'Z'
#6060 "'
#66 66 'f
#6C 6C I
#r272'r
#7878 'x
H#IETE '~

}
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#8101 SOH
#87 07 BEL
#8D OD CR
#93 13 DC3
#99 19 EM
#OF 1F US
#A5 25 '%'
#2B 2B '+
#8131 1"
#B7 377"
#BD 3D '='
#C343'C'
#C9 49 I
#CF 4F 'O’
#55 55 'U'
#DB 5B T
#E161 '’
HET 67'g'
#ED 6D 'm’
#F373's'
#F9 79y
#FF 7F DEL

#82 02 STX
#88 08 BS
#8E OE SO
#14 14 DC4
#9A 1A SUB
#A0 20 SP
#A6 26 '&'
#AC 2C "/
#B232'2
#B8 38 '8’
#BE 3E >’
#44 44°'D'
#CA 4A'J
#50 50 'P'
#56 56 'V'
#5C 5C 'V
#E262'b'
#E8 68 'h'
#EE 6E 'n’
#r4 74t
#FATA'Z

#03 03 ETX
#09 09 HT
#OF OF S|
#15 95 NAK
#1B 1B ESC
#2121
#27 27 ™
#2D 2D -
#3333'3'
#3939'9'
#3F 3F '?'
#45 C5 'E'
#4B 4B 'K'
#51D1'Q’
#57 D7'W'
#5D DD 1T
#6363 'c’
#69 69 i
#6F 6F 'o'
#75 F5 'U'
#7B 7B (2)

#03 03 ETX
#09 09 HT
#OF OF Sl
#95 15 NAK
#1B 1B ESC
#2121
#27 27 ™
#2D 2D
#3333'3'
#3939'9'
#3F 3F '?'
#C5 45 'E'
#4B 4B 'K'
#D151'Q
#D7 57 'W'
#DD 5D 1
#6363 'C’
#69 69 'f
#6F 6F '0'
#F575'u'
#7B 7B (2)

#04 84 EOT
#0A OA LF
#10 90 DLE
#16 96 SYN
#1C 9C FS
#2222™
#2828 ('
#2E 2E "
#34 B4 '4'
#3A A"
#40 C0'@'
#46 C6 'F'
#4C CC 'L’
#52 D2 'R’
#58 D8 'X'
#5E DE '~
#64 E4 'd'
#6A BA
#70 FO 'p'
#76 F6 V'
#TCFC'|

#84 04 EOT
#0A OA LF
#90 10 DLE
#96 16 SYN
#9C 1C FS
#2222 ™
#2828 ('
#2E 2E "
#B4 34 '4'
#3A 3A "
#C0 40'@'
#C6 46 'F'
#cC4c'L'
#D2 52 R’
#D8 58 'X'
#DE 5E '~
#E4 64 'd'
#6A BA '
#F0 70 'p'
#F6 76 V'
#FC7C |

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition

#05 05 ENQ
#0B 8B VT
#11 11 DC1
#17 17 ETB
#1D 1D GS
#23 A3 '0'
#29 A9 ')
#2F AF '/
#3535 '5'
#3B BB '}
#4141 'A
#A7 47'G'
#4D 4D 'M'
#53 53 'S’
#59 59'Y"
#5F 5F ' '
#65 65 'e’
#6B EB 'K’
#7171'q’
#7777 W
#7D 7D (3)

#05 05 ENQ
#8B 0B VT
#11 11 DC1
#17 17 ETB
#1D 1D GS
#A3 230"
#A9 29
#AF 2F '/
#35 35 '5'
#BB 3B '}
#4141 'A
#47 47'G'
#4D 4D 'M'
#53 53 'S’
#59 59'Y"
#5F 5F '
#65 65 '’
#EB 6B 'K’
#7171'q’
#7777 W'
#7D 7D (3)



05.07 DNC Plant/DNC Cell (FBDN1)
8 System platform

8

8 System platform

8.1 HArAWAre ...cooeeeeeeee e 8-146
8.1.1 Requirements for DNC Cell ...........ocoiiiiiiiiiiiiiee e 8-146
8.1.2 Requirements for DNC Plant ... 8-147
8.2 SOfWAIE ... 8-148
8.2.1 Requirements for DNC Cell ..., 8-148
8.2.2 Requirements for DNC Plant............cccccccieiiiiiiiiiiiiie e 8-149

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition FBDN1/8-145



DNC Plant/DNC Cell (FBDN1)

05.07

8 System platform

8.1 Hardware

8.1.1 Requirements for DNC Cell

Table 8-1: Hardware requirements for DNC Cell

Hardware component

Requirement

PC

Pentium class processor P Il or higher

Main memory

=512 MB

Hard disk

> 5 GB for the system (operating system, database, DNC....)
Additional disk memory for the data to be managed

Screen resolution

=800 x 600

Drive

CD-ROM

COM interfaces

Optional, depending on the required serial interfaces:
4x / 8x interface cards, COM server

Network card

Optional in network

FBDN1/8-146

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition




05.07

DNC Plant/DNC Cell (FBDN1)

8.1.2 Requirements for DNC Plant

Table 8-2: Hardware requirements for DNC Plant

8 System platform

Hardware component

Server and DNC HMI computer
requirements

Requirements regarding station
PCs

PC

Pentium class processor P Ill or
higher

Pentium class processor P Ill or
higher

Main memory

>512 MB

> 256 MB

Hard disk

> 5 GB for the system (operating
system, database, DNC...)
Additional disk memory for the data
to be managed

> 5 GB for the system (operating
system, database, DNC....)
Additional disk memory for the data
to be managed

Screen resolution > 800 x 600 > 800 x 600
Drive CD-ROM CD-ROM
COM interfaces Optional, depending on the required
serial interfaces:
4x [ 8x interface cards, COM server
Network card Yes Yes

Backup medium

Depends on the backup concept

Raid system

Depends on the availability
requirements
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8.2 Software

8.2.1 Requirements for DNC Cell
Table 8-3: Software requirements for DNC Cell

Remark

Software component

Operating system

Windows 2003 Server
Windows XP Professional
Windows Vista Ultimate **

Required for each networked PC / SINUMERIK
when the server operating systems are used

Client access license

MSDE required

Internet Explorer

Network protocol optional in network
(provided with Windows)

TCP/IP

When suitable modules are used

Driver software for multiple series interfaces

MCIS database

e MSDE (license-free SQL Server) — available in
DNC Cell
e SQL Server*

*

If SQL server is already installed on the system, this is used for managing data

and an MSDE does not need to be installed.
** For Windows Vista, see readme.pdf

FBDN1/8-148
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8.2.2 Requirements for DNC Plant

Table 8-4: Software requirements for DNC Plant computers

Remark Software component
Operating system Windows 2003 Server
For each networked PC / SINUMERIK Client access license
MSDE required Internet Explorer
Network protocol optional in network TCP/IP

(provided with Windows)

When suitable modules are used Driver software for multiple series interfaces
MCIS database e MSDE (license-free SQL Server) — available in
DNC Plant

e SQL Server*
e Oracle **

*

If SQL server is already installed on the system, this is used for managing data
and an MSDE does not need to be installed.

** Data can also be managed on Oracle 9i (V9.2) instead of MSDE/SQL Server.
This is not installed as standard. See: readme.pdf

Requirements for the station PCs and HMI computers

Table 8-5: Software requirements for the station PCs and HMI computers

Remark Software component

Operating system Windows 2003
Windows XP Professional
Windows Vista Ultimate **

Additional license for server operating system Client access license
MSDE required Internet Explorer
Network protocol optional in network TCP/IP

(provided with Windows)

When suitable modules are used Driver software for multiple series interfaces
(not required for HMI computers)

*

If SQL server is already installed on the system, this is used for managing data
and an MSDE does not need to be installed.
For Windows Vista, see readme.pdf

*%
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Notes
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9.1 Software structure

The software structure shows the data flow between the DNC user interface, the
servers and the machine.

All transfer functions are handled via the machine servers. Standard or user-
specific code conversions can also be carried out, if necessary. You can call up
either the DNC code conversion server or your own code conversion server. You
could set up your own code conversion server in such a way that it then calls up
the DNC code conversion server. Depending on the project, an external dialog
interpreter can be used for the dialog function. In this case, the data flows to the
machine server via the dialog interpreter, where the code is converted, and then to
the machine.

Operator interface
DNC

£~ DNC NT-2000 - Terminall
Detei Bearbeiten Ansicht Extras Hiffe

B e X SdoiaV | Adosce

Code conversion

server

Machine server

eg.
SerlntSvr

External
dialog interpreter

Legend
<==) dataflow

optional
application

2 optional
data flow

Fig. 9-1: Software structure
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9.2 Machine server

DNC uses the data transmission functions available on machine servers for the
following reasons:

e The server is replaced independently of DNC.

e Changes on the server are independent of DNC.

All machine servers are OLE/COM servers with defined interfaces to DNC.

DNC normally uses the SerIntSvr for the interface to serial machines. Separate
machine servers can be created for machines that require a different type of data
transmission.

9.2.1 SerIntSvr

Function

DNC offers the SerIntSvr as standard for serial data transmission without protocol.
The SerIntSvr features a dialog interpreter function and can, if necessary, also call
up an external dialog interpreter and the code conversion servers.

9.2.2 Separate serial machine servers

If the SerIntSvr cannot fulfill the requirements, customer-specific machine servers
can be created.

Applications include the following:

¢ Machines without a serial interface

e Machines that require serial data transmission with protocol

9.3 Code conversion server

DNC code conversion server

The DNC code conversion server offers three conversion codes: ISO, ASCII and
EIA. The definition tables for the conversion contain the CODES.TXT file. It is in
the program directory of DNC together with the DNCConvSvr code conversion
server.

Separate code conversion servers

If the DNCConvSvr cannot fulfill all the requirements, separate code conversion
servers can be created. Possible applications include:

Converting a different code

Further conversions (e.g.: A = AV)
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9.4 External dialog interpreter

General

DNC offers an optional interface for an external dialog interpreter that allows you to
carry out project-specific name conversions or a specific interpretation of the dialog
program, for example. The dialog interpreter must be created as an ActiveX DLL
with Visual C++ or Visual Basic. It is called up from the machine server.

This involves a different type of conversion than that for the code conversion server
since it is only configured for the dialog function. Applications include controllers
that cannot edit all characters. In cases such as this, "G00" could be converted to
"cylinder head", for example.

Note

A short description of the external dialog interpreter is available on the MCIS
DNC CDROM in the IBS_Doku directory in "ExternalDialogInterpreter.pdf".
Additional information can also be called up if required.

Configuration

The configuration is carried out in the [DIALOGFUNCTION] section of the machine

configuration file or in the configuration dialog for the serial machines.
|
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10.1 General

Configuration should only be carried out by authorized users. Definitions and
configurations can/must be carried out in the following areas:

Definition of station name and type (for DNC Plant only)

Plant structure (software simulation of the plant topology)

Machine connections (type of machine interface)

Screen definitions for the NC data properties and the import

List definition

Parameters for the dialog function

User-specific data (access and display definition; see also: Chapter 5)

The "DNC Admin" program is available for most configurations. Only a small
amount of configuration work can be carried out in DNC (e.g. creating and
changing filters and NC data).

10.2 Separation of DNC Admin and DNC

10.2.1 General

DNC Admin and DNC are independent of each other to prevent unintentional
changes being made to the DNC configuration. Separating these two programs
ensures that the user explicitly chooses to configure the plant. DNC is easier to use
as a result of the configuration functions being removed.

DNC Admin should only be used by authorized personnel, whereas DNC can be
used by anyone from administrators to assistants.

Note

DNC Admin is also available to other users. Users must be assigned
authorizations on an individual basis in order to determine which functions they
are permitted to use. See also: Chapter 5 "User administration”.

Some configurations that are performed in DNC Admin, only take effect when
DNC is restarted!

Although, at first sight, the two programs look very similar, they contain different
functions.
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10.2.2 Differences
Table 10-1: Differences between DNC and DNC Admin

Function DNC DNC Admin
Background color (default) White Light blue /
green

Configuration mode - X (green)
Consistency check and rectification - X
Configure users and user groups - X
Screen editor - X

List editor - X

Edit configuration tables X

Create CSV file X

Download NC data X

Upload NC data X -
X
X

User for editor
Machine comparison / archive

From the background color, users can see which program they are working in
and whether configuration mode (green) has been activated. The background
colors in DNC Admin can be changed during commissioning. See also:
Readme.pdf

Additional functions in DNC Admin

The configuration mode (View - Configuration) is used to create and change the
plant topology. This means that the user can create and delete groups, machines,
tool setting devices and links in the configuration mode and parameterize machines
or tool setting devices. See also: Plant structure

The consistency check (Tools > Consistency Check) is used to check for and
rectify inconsistencies between the NC administrative data records in the database
and the NC data files in the DNC file structure. A quick consistency check is
performed each time DNC Admin is started.

Configure users (Tools > User Administration). Users authorized to configure
users can use this function to create and delete new users as well as change their
authorizations, passwords, display groups, and other user-specific settings.

The screen editor (Tools > Screen Editor) can be used to adapt the NC data
properties dialogs and to create new display groups for these dialogs.

The list editor (Tools = List Editor) can be used to adapt the layout and the
contents of the list display and to create new display groups for these list displays.
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Edit configuration tables (Tools > Config. Tables). This dialog allows you to
display the selected database table as it currently appears in the database and, if
you are an administrator, edit it.

Note

The user must be assigned the necessary authorizations for these functions.
See also: User administration

Additional functions in DNC

Based on the filter, the Create CSV File function creates a CSV file that contains
all the NC data of the selected group or machine and, depending on how the
system is configured, the associated field contents (e.g. name, type, release, etc.).
You can open the file in the Notepad editor or Microsoft Excel.

Download NC data (File > Download) allows the user to send NC data from DNC
to the NC machine.

Upload NC data (File > Upload) allows the user to send NC data in the other
direction from the NC machine to DNC.

User for Editor (Tools = User for Editor) enables an existing Windows user in
DNC to be disclosed who is assigned write authorization for Windows editors (for
example, Notepad, etc.) irrespective of the current DNC user. This user
authorization allows editable files to be edited and stored in DNC regardless of
whether the current DNC user has write authorization.

The Machine Comparison function is used to determine which programs exist on
the machine as compared with the data management system for this machine in
DNC. You can also carry out a comparison between files on the machine and in
DNC. This function is only available on machines with SINUMERIK* and PCU50/70
as well as DNC IFC SINUMERIK.

Note

The user must be assigned the necessary authorizations for these functions.
See also: User administration
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10.3 Defining the station name and type

Settings
Language: Im "i
Ligt Orientation———— MC Data Orieqtation———— Cancel |
" Porrait £+ Puortrait
* Lardscape i~ Landscape Save |
Station Mame: IMEIS-Sewer
Station Tppe: ISth all machines, data transfer anly to azsigned maciines LI

[T Temminal Server Client

[T Upload Dialog

Manme. IDNE e Group. HOA-aDkIN

Drizplay Group: IH ] Bl

Fig. 10-1: Settings

General

The Tools > Settings function can be used to configure the station name and
type once after DNC Plant has been installed. This can only be done in
configuration mode. This does not need to be carried out for DNC Cell. The two
fields are deactivated.

Station name

If the computer to be configured is the DNC server or a station PC, specify the
name of the station for your computer here. If the computer to be configured is a
terminal server client, the station name is assigned automatically if the Terminal
Server Client checkbox is activated. In this case, the station name is the name of
the terminal server client.

Note

If the computer to be configured is a terminal server client and the Terminal
Server Client checkbox is not activated, overwrite the station name of the server.
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Station type

Depending on whether your computer functions as a server, terminal server client
or station PC, the station type is stored for a specific user or a specific computer.

User-specific relevance:
The Terminal Server Client checkbox is activated. The station type is defined for
the user. The user-specific parameters in the DNC database are updated.

Computer-specific relevance:

The Terminal Server Client checkbox is deactivated. The station type is defined
for the computer. The computer-specific parameters in the DNC database are
updated irrespective of the user logged on.

The following station types are available:

Display assigned machines, data transfer possible:

Only machines that are assigned to the terminal-specific station are displayed.
Data transfer is possible to the machines displayed.

Display all machines, no data transfer:

All machines are displayed irrespective of whether they are assigned to the
terminal-specific station. Data transfer to the machines is not permitted.
Display all machines, data transfer only to assigned machines:

All machines are displayed irrespective of whether they are assigned to the
terminal-specific station. Data transfer is only permitted to machines that are
assigned to the terminal-specific station.

Display all machines, permit data transfer to all machines:

All machines are displayed irrespective of whether they are assigned to the
terminal-specific station. Data transfer is permitted to all machines that are
assigned explicitly to the terminal-specific station or no station.

Important

If machines in the system are assigned explicitly to a different station, data
transfer to these machines is not possible.

DNC server:
The computer must be the DNC server. All machines are displayed. Data
transfer is permitted to all machines.

Terminal Server Client

FBDN1/10-160

Activate this checkbox if your computer functions as a terminal server client, that is,
if it is neither a station PC nor the DNC server.

Note

You can only activate the checkbox in configuration mode. The checkbox cannot

be activated for DNC Cell.
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10.4 Plant structure
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Fig. 10-2: Plant structure in the file system

The plant structure can be configured via the DNC user

interface. Configuration mode must be selected.

The directories and subdirectories of the file system correspond to the tree
structure of the user interface.

The access path is (default): <Drive> Siemens\MCIS\Data\DNC\Data.
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10.5 Machine connections

The machine connections are configured in machine configuration files. If a
configuration file does not yet exist for the selected machine, the user is prompted
to select one from predefined template files for machine configurations. Once a
template has been selected, the configuration file is assigned the name:
MachineName.MCF.

See also: Templates for configuration files

You can choose one of the following connection types:
e Serial without protocol

¢ SINUMERIK* connected via Ethernet

e Via Windows file system

The entries in the machine configuration file differ accordingly.

The configuration file is divided into different sections, which are evaluated by the
relevant servers. The entry MachineType in the [GLOBAL] section contains the
connection type. In addition to the sections already available, you can add new
ones for connecting different servers. Comment lines are preceded with ;.

To edit the configuration file, choose EDIT in the editor.

In the case of the serial machine connection without protocol, the machine
configuration file can also be edited via the configuration dialog. To call this up,
choose Config Dialog. Each section is displayed on a separate tab page.
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Fig. 10-3: DNC Plant: Machine properties transmission mode: Serial without protocol

Station

In DNC Plant, enter the name of the station to which the machine is to be assigned.
This entry is not necessary in DNC Cell because there is only one station.

Note

When you confirm the Properties dialog, a plausibility check is carried out to
determine whether the station name has already been assigned to a tool setting
device. In this case, the dialog remains open until a correct station name has

been entered.
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Machine-specific version strategy for the upload

If a global version strategy is not sufficient, you can also define a machine-specific
strategy. You can use the Version Strategy For Upload field for this in the bottom
left of the dialog box. If 0 is configured there, the global version strategy applies.
Other permissible values include 1-6 in accordance with the global version strategy
(see Section 10.5.2).

Note

If the machine properties in DNC Plant are edited on the server, a station PC
must be assigned to the machine via the Station input field.

Terminate manually

The Terminate Manually checkbox allows you to control how the system responds

if a current NC data upload job is terminated.

e When you activate the checkbox, a dialog appears when the receive operation
is terminated. In this dialog, you can specify whether the data that has already
been received is to be accepted or rejected.

e If you do not activate the checkbox, the receive operation is terminated without
a dialog appearing. No data is accepted.

See also: Uploading NC data

Areal Sin840D ]|

Configuration |

Conficuration file: EDIT

mackine 43_dt MCF

[Eaie dislag
Tranzmizzion module: Diizplay group for ligt:
| SINUMERIK. 8400 x| V¥ Auto Compare |DELLST I-]
[T &uto Archive
Upload directory Search levels for HC data

a machine 49_dt l‘ I-n machine 49_dt j

Werzicn Strateqy For Upload

o
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Fig. 10-4: DNC Cell: Machine properties transmission mode: SINUMERIK*
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10.5.1 Machine configuration files

Standard configuration files

DNC includes the following standard machine configuration files:

Dncmastd.MCF for machine connections with a serial interface without protocol
SIN840DStd.MCF for SINUMERIK* machine connections

When you select the Auto Compare and Auto Archive checkboxes, NC data on
SINUMERIK* machines is compared with the NC data in the DNC system and
is downloaded automatically to the DNC system if any differences are
established.

The file system machine type can be used to transfer NC data from and to any

network drives that have been released. Any network-capable controller can be
connected to the DNC system under Windows. Two configurable directories
are available for downloading and uploading data. When data is uploaded, the
version strategy is used. The administrative data is updated when data is
downloaded/uploaded.

Any of the machine servers can also be used to establish connections with
controllers with different interfaces (e.g. OLE/COM, or special serial protocols).

Note

The machine configuration files may not contain standard specifications for
certain parameters with string assignments. When functions are used that contain
parameters with string assignments, the standard machine configuration file
should be adapted in such a way that all the relevant entries exist. This means
that the adjustments do not need to be made for each individual machine.
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Templates for configuration files

In addition to the standard machine configuration files, separate templates for
machine configuration files can be created. The following general conditions must
be fulfilled:

e The file extension must be .MCF.
e The files must contain a [GLOBAL] section with a machine type key that
corresponds to the selected controller type.

Table 10-2: Controller types for machine configuration file templates

Template file Machine type Remark

Dncmastd.MCF Serial For serial transmission without protocol

é-IN84ODStd.MCF SINUMERIK840D For SINUMERIK*

DNCFSStd.MCF File system For transmission to network drives

| Important

The templates must be stored in the ...config/template directory.

The standard system includes the following three template files:

e Dncmastd.MCF etc.
e SIN840DStd.MCF
DNCFSStd.MCF
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If several template files of the selected machine type are in the ...config/template
directory, clicking the Edit or Config Dialog button opens a dialog for the template
selection, which contains all the template files available in the ...config/template
directory. Different template files are already available for controller types from

other manufacturers.

Select Template E |

Acrarratic_AZ2100
Bozck CC220M
Engelhardt_CHEC_3300
Faruc_BT
Hecklzr-koch CHMCTE3-2
Heller_Unipro30
Heller_Unipro90-25
Hitachi_Seikibdulti
|Gb_Limat

fid

Fig. 10-5: Template selection for serial transmission without protocol

Note

The dialog for selecting the template is only displayed if the template directory
contains more than one template file for the machine type in question.
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10.5.2 Configuration for the serial connection without protocol

Configuration dialog for the serial connection without protocol
The machine configuration file is configured in the configuration dialog.

General tab / [GLOBAL] section

The General tab page describes the [GLOBAL] section of the machine
configuration file. The machine server to be used is configured here. You have to
enter the program ID (ProgID) of the machine server to be used. It comprises the
following elements: ComponentName.ClassName.

Note
The serial machine server is called SerIntSvr.Machine (default).

machine 44_en I
|nterface Send I Receive I Dialoa function I |nterpretation of data fow
General Machine zerver [SERIMTSYR] I Code converzion zerver [DNCCony]

b achine server: SerlntSvr b achine

k. Cancel Help

Fig. 10-6: Config dialog / tab: General

Extract from machine configuration file:
[GLOBAL]
MachineServer=SerIntSvr.Machine
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Machine Server tab page / [SERINTSVR] section

machine 44_en |
Interface | Send | Receve I Dislog furction | Interoretation of data flow |
General Machine zerver [SERINTSVR] | Code converzion zerver [DMNCCony]

Code conversion server; |DMCCony. CodeConvert

] | Cancel Help

Fig. 10-7: Config dialog / tab: Machine Server

The Machine Server tab is the [SERINTSVR] section of the machine configuration

file. Here, you configure the code conversion server to be used. You have to enter

the program ID (ProgID) of the code conversion server to be used. It comprises the
following elements: ComponentName.ClassName.

Note

The code conversion server is called: DNCConv.CodeConvert (default)
If the code conversion server is to be called by a different machine server, you
are advised to assign a new section.

Warning

Do not enter a code conversion server if code conversions are not to be carried
out.
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Extract from machine configuration file:
[SERINTSVR]

; CNCConverter=DNCConv.CodeConvert

Note

This extract from the machine configuration file contains a commented-out code
conversion server because no code conversion is to be carried out.
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Code Conversion Server tab page / [DNCConv] section

machine 44_en I
|nterface I Send I Receive I Dialog function I |nterpretation of data fow |
General | tachine server [SERIMT 5%F] Code corversion server [DMCCany]

Code conversion server: l|

k., | Cancel | Help

Fig. 10-8: Config dialog / tab: Code Conversion Server

The Code Conversion Server tab page is the [DNCConv] section of the machine
configuration file. You specify the code conversion type here. Conversions from
ASCII to CNC code are carried out when data is downloaded and from CNC code
to ASCII when data is uploaded.

You can select the following code conversion types from a combination field:

e ASCI

e |ISO

e EIA
Note

Do not enter a code conversion server in the [SERINTSVR] section or on the
Code Conversion Server tab page if code conversions are not to be carried out.

; CNCConverter=DNCConv.CodeConvert

Extract from machine configuration file:
DNCConv]
CNCcode=ISO
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Interface tab page / [COM] section

The Interface tab page is the [COM] section of the machine configuration file. You

set the serial interface parameters here.

Note

The entries on the Interface tab page must match the settings for the CNC
machine serial interface.

machine 44_en

eneral | tachine zerver [SERINTSVR] I Code corverzion server [DMCCany]
Interface | Send I Receive I Dialoa function I |nterpretation of data fow

COM interface:
Baud rate: 3600 =
Mumber of data bits: |2 bits =
Mumber of stop bits: |1 bit i
Farity: Mone

Flows contral: RTS/CTS =

#0OM control char: |17

#OFF contral char: |19

HRRENNNN.

Transmizsion mode: | AS5CI 2

]|

Ok

Cancel Help

Fig. 10-9: Config dialog / tab: Interface
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e COM interface
The COM interface is used for connecting the machine. Interfaces 1 to 256 can
be assigned.

1= COM1

16= COM256

Extract from machine configuration file:

[coM]

ComPort

= 2

10 Configuration

Note

ComPort=0 is not a valid interface.

e Baud rate

The baud rate specifies the transmission rate of the interface.

Baud rates of 110 to 256000 are possible.

Extract from machine configuration file:
BaudRate = 9600

e Number of data bits
6, 7 or 8 bits can be evaluated as data bits.

Extract from machine configuration file:
ByteSize = 8

e Number of stop bits
1 or 2 bits can be evaluated as stop bits.

Extract from machine configuration file:
StopBits = 1

o Parity

The following parities can be defined:

Table 10-3: Parity of the serial interface

N=No No parity check
0=0dd Odd parity
E=Even Even parity
M=Mark Logical 1
S=Space Logical 2
Extract from machine configuration file:
Parity = N
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e Flow control

Flow control specifies the handshake setting. The following parameters can be

defined:

Table 10-4: Flow control of the serial interface

DTRDSR (DTR/DSR) Hardware handshake
RTSCTS (RTS/CTS) Hardware handshake
XONXOFF (XON/XOFF) Software handshake
NONE No handshake

Extract from machine configuration file:

FlowCtrl = RTSCTS

e XON/XOFF control characters
If controllers are configured with a different code type, deviations may occur
with the XON/XOFF control characters. If flow control is controlled with
XON/XOFF, the control characters for XON/XOFF must be defined in
accordance with the controller.

Extract from machine configuration file:

,XONChar=17
;XOFFChar=19

Note

If the XON / XOFF control characters in the machine configuration file are
commented out, the internal presettings apply (XON=0x11, XOFF=0x13).

e Transmission mode
The transmission mode specifies the type of transmission. The following
transmission modes are available:

Table 10-5: Transmission modes of the serial interface

ASCII
Binary

= O

Note

In "binary" transmission mode, the transmission file is transmitted 1:1 and is not
formatted beforehand.

Extract from machine configuration file:
Binary = 0
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Send tab page / [SEND] section

The Send tab page is the [SEND] section of the machine configuration file. The
transmission parameters for the machine server are set here.

machine 44_en |
General I Machine zerver [SERIMTSYR] I Code converzion zerver [DMNCCony]
|nterface | Send | Receive I Dialoa function I |nterpretation of data Fow
—— Program (D Caomrment Header Trailer
Start; IE Start; |4EI Length: [0 Length: IEI
End: ID Ett: |4'| Char.: ID Char.: ID
[ Suppress
— Spacer
Start of program (D End of program 1D
Length: IEI 1 I 1: I
Char.: IEI 2 I 2 I
2+ I N I

End af line character: INu:une "’I Send timeaut: I'I [miir]
Send baud rate:; IEI Send delaw: IEI [zec]

Fig. 10-10: Config dialog / tab: Send

Note
The ASCII characters are entered in decimal code (0 ...255).
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Start-of-program identifier

The start-of-program identifier specifies the marker for the start of the program
as an ASCII character in decimal code (0 ...255), which is inserted before each
NC data file (example: 065 for A).

Extract from machine configuration file:
ProgramStart=65

End-of-program identifier

The end-of-program identifier specifies the marker for the end of the program
as an ASCII character in decimal code (0 ...255), which is inserted after each
NC data file (example: 069 for E).

Extract from machine configuration file:
ProgramEnd=69

Comment start

The comment start identifier specifies the marker for the start of the comment
as an ASCII character in decimal code (0 ...255), which is inserted before each
comment (example: 075 for K).

Extract from machine configuration file:
CommentStart=75

Comment end

The comment end identifier specifies the marker for the end of the comment as
an ASCII character in decimal code (0 ...255), which is inserted after each
comment (example: 101 for e).

Extract from machine configuration file:
ProgramEnd=101

Suppress comment
This checkbox enables a comment to be suppressed so that it is not
transmitted.

Table 10-6: Comment during transmission

Comment is transmitted

=[O

Comment is suppressed

FBDN1/10-176

Extract from machine configuration file:
SuppressComment=1
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e Header size
The header size is specified in bytes. It describes the number of header
characters to be inserted.

Extract from machine configuration file:
HeaderSize=8

e Header character
The header character is inserted as an ASCII character in decimal code
(0 ...255) with the factor header size (example: 072 for H).

e Extract from machine configuration file:
HeaderChar=72

Note
In this case, the header is HHHHHHHH

e Trailer size
The trailer size is specified in bytes. It describes the number of trailer
characters to be inserted.

Extract from machine configuration file:
TrailerSize=6

e Trailer character
The trailer character is inserted as an ASCII character in decimal code
(0 ...255) with the factor trailer size (example: 078 for N)

Extract from machine configuration file:
TrailerChar=78

Note
In this case, the traileris NNNNNN
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e Spacer
If a file contains several NC programs that are to be sent to a machine
together, certain controllers require a spacer to be transmitted between the
individual NC programs.
The spacer consists of a configurable number (SpacerSize) of identical
characters (SpacerChar).

Note

If code conversion is activated, the spacer is converted too. (This is not the case
with the header and trailer, which must be configured directly in line with the code

type.)

Up to six strings can be configured for the search to determine where the
spacer is to be inserted. Three strings are used for searching for a start-of-
program identifier (SpacerMark1..3), and three for an end-of-program identifier
(SpacerMarkinsertAfter1..3).

Note

A search should be carried out for start-of-program identifiers only or end-of-
program identifiers only, otherwise two spacers may be inserted between the NC
programs.

When the system searches for start-of-program identifiers, the spacer is
inserted before the line containing the start-of-program identifier.

When the system searches for end-of-program identifiers, the spacer is inserted
after the line containing the end-of-program identifier.

e Spacer size
The spacer size is specified in bytes. It describes the number of spacer
characters to be inserted.

Extract from machine configuration file:
SpacerSize=15

© Siemens AG 2010 All Rights Reserved
FBDN1/10-178 Motion Control Information System DNC (FBDN) - 04/10 Edition



05.07

DNC Plant/DNC Cell (FBDN1)

10 Configuration

Spacer character
The spacer character is inserted as an ASCII character in decimal code
(0 ...255) with the factor spacer size (example: 090 for Z).

Extract from machine configuration file:
SpacerChar=90

Note

In this case, the spacer is ZZZ2777777777777

Up to six strings can be configured for the search to determine where the
spacer is to be inserted. Three strings are used for searching for a spacer start-
of-program identifier (SpacerMark1..3), and three for a spacer end-of-program
identifier (SpacerMarkinsertAfter1..3).

Note

A search should be carried out for spacer start-of-program identifiers only or
spacer end-of-program identifiers only, otherwise two spacers may be inserted

between the NC programs.

Spacer start-of-program identifier
The spacer is inserted before the line containing the start-of-program identifier.
The start-of-program identifiers may have maximum 16 characters.

Extract from machine configuration file:
SpacerMarkl =%MPF

SpacerMark2 =%SPF

SpacerMark3 =

Spacer end-of-program identifier
The spacer is inserted after the line containing the end-of-program identifier.
The end-of-program identifiers may have maximum 16 characters.

Extract from machine configuration file:
SpacerMarkInsertAfterl =M30
SpacerMarkInsertAfter2 =M17
SpacerMarkInsertAfter3 =
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End-of-line character
The end-of-line character is the character that indicates the end of a line. If the
end-of-line character is converted, the SerIntSvr proceeds as follows:

All end-of-line characters are converted to CR-LF for downloads.
All CR-LF and LF are converted according to the following table for
uploads.

Table 10-7: End-of-line character conversion during download

End-of-line character

Description

No conversion

CRCR

CRLF

LF CR

LF LF

CRCRCR

CRCRLF

CRLFCR

CRLFLF

OO (N[O |W|IN|=O

LF CRCR

LF CRLF

LF LF CR

LF LF LF

CR

RD

Extract from machine configuration file:
EOBcode=0

Send baud rate

The send baud rate specifies the baud rate (differs from that for the interface
definition ([COM] section)) with which data is transmitted. If O is specified for
the baud rate, the baud rate of the interface description ((COM] section) is
used.

Extract from machine configuration file:
SendBaudRate =0

Send timeout

The send timeout specifies the interval in minutes after which the send job is
aborted if the machine is not ready to receive. The value 0 means that the
system will wait indefinitely.

Extract from machine configuration file:
SendTimeout=1

Send delay
The send delay specifies the interval in seconds by which the send job to the
machine is to be delayed.

Extract from machine configuration file:
SendDelay=0

FBDN1/10-180
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Receive tab page / [RECEIVE] section

The Receive tab page describes the [RECEIVE] section of the machine
configuration file. The upload parameters for the machine server are set here.

machine 44_en |

General I tachine zerver [SERIMTSYR] I Code converzion zerver [DMNCCony]
|nterface I Send Receive I Dialoa function I |nterpretation of data Fow

Header length: ¥ Ignore ZERD values

|E]
Trailer length: IEI [T Test mode
IIZI

First walid character:
Start of program character;

End of program character:

o
—
End of transmission character. [0
—

End of reception after

last character: [zec]

] | Cancel Help

Fig. 10-11: Config dialog / Receive tab page

Note

The ASCII characters are entered in decimal code (0 ...255).

e Header size
The header size is specified in bytes. It indicates the number of header
characters to be deleted after the data has been received.

Extract from machine configuration file:
HeaderSize=8
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o Trailer size
The trailer size is specified in bytes. It indicates the number of trailer characters
to be deleted after the data has been received.

Extract from machine configuration file:
TrailerSize=6

e First valid character
This is the first valid character of the NC program as an ASCII character in
decimal code (0 ...255) (example: 086 for V). The search is performed in the
header. All characters that appear in front of the first valid character are
truncated.

Extract from machine configuration file:
ValidData=86

e Start-of-program character
Start-of-program character specified as an ASCII character in decimal code
(0 ...255) (example: 083 for S). It is inserted at the start of the file before each
NC program is received.

Extract from machine configuration file:
ProgramStart=83

e End-of-program character
[End-of-program character specified as an ASCII character in decimal code
(0 ...255) (example: 069 for E). It is added at the end of the file before each NC
program is received.

Extract from machine configuration file:
ProgramEnd=69

e End-of-transmission character
End-of-transmission character specified as an ASCII character in decimal code
(0 ...255) (example: 4 for EOT). Reception is terminated when this character
has been received. The end-of-transmission character itself is cut off.
When EOFChar=0, the system does not monitor for an end-of-transmission
character; reception is terminated by means of a timeout.

Extract from machine configuration file:
EOFChar=4

Note

If the machine does not transmit an EOFChar, the upload procedure is terminated
in accordance with the configured receive end after the final character (timeout).

© Siemens AG 2010 All Rights Reserved
FBDN1/10-182 Motion Control Information System DNC (FBDN) - 04/10 Edition



05.07

DNC Plant/DNC Cell (FBDN1)

10 Configuration

End receive after last character

This is the time interval in seconds after which transmission is terminated if no
further characters are received. Values between 1 and 600 can be entered.
Monitoring is not carried out if 0 is entered. Data receipt is terminated by
means of the end-of-transmission character only.

Extract from machine configuration file:
TimeOut=10

Ignore ZERO values
This parameter specifies whether binary zero values within the file to be
transmitted are to be discarded.

Extract from machine configuration file:
NullDiscard=1

Test mode

When the test mode is activated (TestMode=1), the temporary files in the
parameterizable temporary directory (default: ...DNC\Tmp) are not deleted.
This enables data that has been sent and received to be compared.

Extract from machine configuration file:
TestMode=0
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Dialog Function tab page / [DIALOGFUNCTION] section

The Dialog Function tab page is the [DIALOGFUNCTION] section of the machine
configuration file. The dialog function parameters are set here.

machiner |

General I Machine server [SERINTSVR] | Code conversion server [DMCCony] i

Interface | Send | Receive Lhalog bunctior I Irterpretation of data flow
Humber of zsignificant lines: Wiorkpiecs |0 PO
Request ID: Im File tupe 10 I—
Respcnze [D: lm Wildcard alternative: I—
Response end 1D: #3230

— Request for NG data commant————— List request command

il release 1D (L] I[ L]

Upload command
itk trial cut 10 [LT]
I[ R

Euternal dialog interpreter:

Interpretion wpe;

1

F, | Cancel Help

Fig. 10-12: Config dialog / Dialog Function tab page

Note

The ASCII characters are entered in decimal code (0 ...255).

If a machine is configured with the dialog function, the machine server is started
when the program is started and runs until the program ends.

Examples are available in the sections Dialog programs and Dialog program
responses.
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Number of significant lines
This parameter specifies the number of lines as of line 1 within the NC data file
in which a search is made for the request ID DIgID.

Extract from machine configuration file:
DlgScanLines=10

ID for request
This parameter defines the ID of a request made by the CNC machining unit by
means of the dialog function.

Extract from machine configuration file:
D1gID=%MPF9999

ID for response

This parameter defines the ID of a response to a request made by the CNC
machining unit by means of the dialog function.

The response can have the following content:

List (response to list request)

Error message (response to a program request that cannot be fulfilled)

Extract from machine configuration file:
Dl1gIDSend=%MPF9998

End ID for response
The End ID for Response to a request via the dialog function is formulated via
the DIgSendEnd parameter. It terminates either a list or an error message.

Extract from machine configuration file:
D1gSendEnd=M30

Command for NC data request with release ID

DIgSendCmd is the command for requesting NC data with a release ID via the
dialog function. The parameter is a string that must be formulated in
accordance with the NC program.

Extract from the machine configuration file:
DlgSendCmd= (S)

Command for NC data request with trial cut ID

DIgSendTcCmd is the command for requesting NC data with a trial cut ID via
the dialog function. The parameter is a string that must be formulated in
accordance with the NC program.

Extract from the machine configuration file:
DlgSendTcCmd= (ST)
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Command for list request

DIgSendListCmd is the command for requesting a list of NC data files via the
dialog function. The parameter is a string that must be formulated in
accordance with the NC program. It must be in the first line of the NC data file.

Extract from the machine configuration file:
DlgSendListCmd= (SL)

Command for upload

DIgReceiveCmd is the command for responding to a request. The parameter
is a string that must be formulated in accordance with the NC program. Two
programs are sent successively:

Request program

Program to be transferred back

Extract from the machine configuration file:
DlgReceiveCmd= (R)

External dialog interpreter

This parameter contains the name of an optional dialog interpreter. You can
use the external dialog interpreter to carry out project-specific name
conversions. You have to enter the program ID (ProgID) of the dialog
interpreter to be used. It comprises the following elements:
ComponentName.ClassName.

Extract from the machine configuration file:
DlgConverter=DNCD1gI.DNCCntrl

Type of interpretation
You can use this parameter to assign an additional ID for the code conversion
type to the external dialog interpreter.

Extract from machine configuration file:
D1gSubNumber=0
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o Workpiece ID
The DIgWpdMark parameter specifies the workpiece ID in the dialog program.
Combined axis/numeric IDs (e.g. DigWpdMark=W Z888) can also be used for
controllers that cannot edit all characters.

Extract from the machine configuration file:
DlgWpdMark=WPD

e Filetype ID
The File Type ID parameter specifies the file type ID in the dialog program.
Combined axis/numeric IDs (e.g. Y002) can also be used for controllers that
cannot edit all characters. The character is declared in the
DIgExchangeCNCType parameter. The numeric part of the ID refers to the
sequence of file types in the DNCDATATYPE database table, starting with
001; increment = 1.

Extract from machine configuration file:
DlgExchangeCNCType=Y

e Wildcard alternative
The Wildcard Alternative parameter specifies the wildcard alternative for
controllers, which cannot edit *, in the dialog program. The parameter for list
requests (e.g. to request lists of all the data types or file names) is important
here.

Extract from the machine configuration file:
DlgExchangeWildcard=X999
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Data Stream Interpretation tab page / [RECEIVE] section

The Data Stream Interpretation tab page is defined in the [RECEIVE] section of the
machine configuration file.

machiner |

General I Machine server [SERINTSWR] I Code conversion server [DMCCony] i
Interface | Send | Receive I Dialog functior Interpretation of data How

| nterpretation mode

MHurnber of gignificant lines: I5
Start |D IﬂNameﬂ
YWiorkpiece / MC name delimiter I

MC name / type delimiter

EndIC I#End#

Start of program 11 F i af program 1T
ik iz 1) HMEIII
2 | 2 !wn 7
5] I 3 I
F, Cancel Help

Fig. 10-13: Config dialog / Data Stream Interpretation tab page

Note

If the number of significant lines (NCNameLines) > 0, with no separator strings
defined for the workpiece ID or type ID, this is identified as an error in the
machine configuration (red dot on the machine icon).

If the dialog function and data stream interpretation are active, the data stream
interpretation has priority over the dialog function, even if a request program has
been received immediately beforehand.

If the data received does not constitute a request program and does not contain
the IDs (start identifier, workpiece identifier, etc.) for interpreting the data stream,
the data is discarded.

If the data received contains a type that is not known to DNC, the data will be
rejected with an error message. In this case, nothing is saved.
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Interpretation mode (NCSplit parameter) specifies how the received data can be
split. Three values can be set for this parameter.

Table 10-8: Data stream interpretation: Interpretation mode: NCSplit parameter

Interpretation mode Description
NCSplit = 0 Disabled
NCSplit = 1 SINUMERIK*:

This activates the name assignment in accordance with the
SINUMERIK convention. The parameters for determining the
file name are of no significance. The start-of-program and
end-of-program identifiers must be parameterized.

NCSplit = 2

Other controller:

The parameters for determining the file name as well as the
start-of-program and end-of-program identifiers must be
parameterized.

If third-party controllers (other controllers) are connected, the syntax of the lines
to be interpreted is not clearly specified.

In this case, configuration parameters are used to specify how separators in the
data as well as the NC program file name and type are defined.

Parameter for determining the file name

Table 10-9: Data stream interpretation: Configuration parameters for NC data files for other controllers

(NCSplit=2)
Parameter Type |Description
Number of Significant | Integer | Number of lines as of the start of the program in which a search is
Lines (NCNameLines) made for the name string(]
0 = function deactivated (default)

Start Identifier String | String for identifying the start of the name
(NCNameBegin)
Separator Workpiece / | String | Separator string between the workpiece and NC program name
NC Name
(NCNameWPD)
Separator NC Name / | String | Separator string between the NC program name and type
Type (NCNameWPD)
End identifier String | String for identifying the end of the NC program name
(NCNameEnd)

Note

Each individual NC program should always have a name with identifiers (start
identifier, workpiece ID, etc.) so that the data stream can be interpreted. This
helps prevent any confusion.

If this is not possible, the name of the NC program saved beforehand is used,
and a consecutive number is appended (_i (i=1,2,3....) in order to make a
distinction between the programs. The file name (of the entire data stream)
specified by the operator is used for the first NC program.
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Program start

identification / program end identification

(NCProgramsStart.../NCProgramEnd...)

Three strings can be defined in each case for the start and end, whereby any
combination of start and end strings is valid.
When the data is split, a distinction must be drawn between the following cases:

1.

Only start identifiers defined

The data before the first start identifier is ignored. The data as of the start
identifier up to the next identifier is stored in the first file. Starting at the second
identification in the second file, etc., until the file end.

If no start identification is found, all the data will be discarded and a message
issued to the operator.

Only end identifiers are defined

[OFrom the start of the data up to and including the first end identifier, all the
data is stored in the first file. As of the next line, the data is stored in the next
file, up to the next end identifier and so on. The last block is also stored even if
no further end identifier is found. Likewise, all of the data is stored if the file
does not contain any end identifiers.

Start and end identifiers are defined

[0The data between an identified start and end string (including the lines in
which the identifier string was identified) is stored in each case in a separate
file. Data that occurs between these areas is ignored.

A search is always alternately made for a string type:
Initially, a search is only made for the start identifier string. If the start of the
program is found, only a search is then made for the end, that is, other start strings

are

ignored. If the end identifier is found, a search then starts again for the start

string.
The data will be discarded if no start identifier is found. If the last end identifier is
missing, the data up until the end is stored.

FBDN1/10-190

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition



05.07

DNC Plant/DNC Cell (FBDN1)

10 Configuration

Data interpretation for SINUMERIK*

Data that is received serially from a SINUMERIK*/802D/840C always contains
information on the storage location and the file names in the data management
system on the controller. When this data is received, the NC program name and file
type are determined in DNC from the information for interpreting the data flow. The
syntax is specified by the SINUMERIK®*. If these files originate from a workpiece
directory on the controller, this information is evaluated too and an appropriate
workpiece is created or the NC program files are stored in a workpiece directory,
which may already exist, with the same name.

Note

All of the control lines are always interpreted. If necessary, the data is divided up
among several files.

Important

The number of significant lines must be less than the number of lines in the
shortest NC program.
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Example

Start identifier: #Name#
Workpiece / NC name separator #SWPN#
NC name / type separator #SNT#H
End identifier #End#

Table 10-10: Example: Data stream interpretation

File contents | Description

#Name#4-VALVE-CYLINDER-HEAD.MPF#End#

NC program:
4-VALVE-CYLINDER-HEAD.MPF

#Name#MOTOR#SWPN#4-VALVE-CYLINDER-HEAD.MPF#End#

Workpiece:

Motor

NC program:
4-VALVE-CYLINDER-HEAD.MPF

#Name#MOTOR#SWPN#4-VALVE-CYLINDER-HEAD.MPF#SNT#MPF#End#

Workpiece:

Motor

NC program:
4-VALVE-CYLINDER-HEAD.MPF
File type:

MPF

Internal definition for SINUMERIK*/802D/840C

FBDN1/10-192

Number of significant lines 3
Start-of-program identifier: %
End-of-program identifier: M30
End-of-program identifier2: M17

© Siemens AG 2010 All Rights Reserved

Motion Control Information System DNC (FBDN) - 04/10 Edition



05.07 DNC Plant/DNC Cell (FBDN1)
10 Configuration

Standard machine configuration file for serial connection without protocol

Table 10-11: Example of a standard machine configuration file for serial connection without protocol

; MCIS DNC V2 Machine configuration templatefile

; Base: " standard-serial.MCF"

; more infos see the machine configuration documentation on

; Install-CDROM in "IBS Docu\Machine-configuration-docu\*.pdf"
[GLOBAL]

MachineType=serial

MachineServer=SerIntSvr.Machine

[SERINTSVR]
; CNCConverter=DNCConv.CodeConvert
CNCConverter=

;Server for Code conversion
[DNCConv]

;CNCcode= (ASCII,ISO,EIA)
CNCcode=ISO

;Serial COM-port Paramter

[coM]
; ---CommPort---: 1=COM1 ... 16=COMl6
ComPort = 2
; ---BaudRate---: 110, 300, 600, 1200, 2400, 4800, 9600, 19200, 38400 ;57600, 115200
Bd
BaudRate = 9600
;---ByteSize---: 6,7,8
ByteSize = 8
;j---StopBits---: 1, 2
StopBits = 1
;---Parity---: No=N, 0dd=0, Even=E; Mark=M; Space=S
Parity = N
;---FlowCtrl---: DTRDSR, RTSCTS, XONXOFF, NONE
FlowCtrl = RTSCTS
;---XON/XOFF---: in ASCII-decimal- Code (0 ... 255)
XONChar=17
XOFFChar=19
;---Binary---: 0= NO 1 = YES (transfermode: 0=ASCII, l=binary)

Binary = 0

;Program Output Parameter

[SEND]

;Parameters in ASCII- Dezimal- Code (0 ... 255)

;---ProgramStart---: (character, added before each file)
ProgramStart=0

;---ProgramEnd---: (character, added after each file)
ProgramEnd=0

;---CommentStart---: (character which marks the begin of an comment)
CommentStart=40

;---CommentEnd---: (character which marks the end of an comment)
CommentEnd=41

;---HeaderChar---: (character, added "HeaderSize"-times before each file)
HeaderChar=0

;j---TrailerChar---: (character, added "TrailerSize"-times before each file)
TrailerChar=0

;---HeaderSize---: (Size in Bytes to add Parameter "HeaderChar" before each file)
HeaderSize=0

;---TrailerSize---: (Size in Bytes to add Parameter "TrailerChar" after each file)
TrailerSize=0

;---SpacerChar---: (character, added "SpacerSize"-times before/after each SpacerMark)
SpacerChar=0

;---SpacerSize---: (Size in Bytes to add Parameter "SpacerChar" before/after each
SpacerMark)
SpacerSize=0

;---SkipFirstSpacerMark---: 0= NO 1 = YES (to suppress Spacer before 1. NC Programm)

SkipFirstSpacerMark=0
; ---SpacerMarkers (max 16 Byte each)
;---SpacerMarkl..3 ---: (before each line in which these SpaceMarkers appear a spacer
will be inserted)
i SpacerMark3=%MPF
SpacerMarkl=
SpacerMark2=
SpacerMark3=
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;---SpacerMarkInsertAfterl..3 ---:(after each line in which this SpacerMarkers appear
a spacer will be inserted)
;SpacerMarkInsertAfter3=M30
SpacerMarkInsertAfterl=
SpacerMarkInsertAfter2=
SpacerMarkInsertAfter3=

;---EOBcode---: (This parameter is used for the end of line conversion to/from
CNC)

; 0=No, 1 = CR + CR, 2 =CR + LF, 3 =LF + CR, 4 = LF + LF,

; 5 =CR + CR + CR, 6 = CR + CR + LF, 7 = CR + LF + CR, 8 = CR + LF + LF,

; 9 = LF + CR + CR, 10 = LF + CR + LF, 11 = LF + LF + CR, 12 = LF + LF + LF,

; 13 = CR, 14 = LF
EOBcode=0

;---SuppressComment---: 0= NO 1 = YES (comments will not be transferred)
SuppressComment=0

;---SendTimeOut in minutes---: 0= infinite (job will be cancelled after that time, if

machine is not in receive mode)
SendTimeout=1

;---Different Baudrate for sending---: (SendBaudRate=0 = same Baudrate as in [COM]
section)
SendBaudRate=0

;---SendDelay in seconds---: (the system waits for this time before the data will be

send to the machine)
SendDelay=0

; Program Input Parameter

[RECEIVE]
;---Parameters in ASCII- Dezimal- Code (0 ... 255)---
;---ValidData---: (This charakter shows the first wvalid character of the NC-program.

All charakters before will be cut)
ValidData=0

;---ProgramStart---: (character in ASCII dec. added in front of each file after
uploading)
ProgramStart=0

;---ProgramEnd---: (character in ASCII dec. trailed at the end of each file after
uploading)
ProgramEnd=0

;---EofChar---: (character, which indicates the end of uploading) O=none -> receive
ends after TimeOut (see below)
EofChar=0

;TimeOut in seconds. Uploading is stopped after this time, if no bit further more is
received (1 ... 600, O=infinite)

TimeOut=5

;---HeaderSize---: (Size in Bytes to cut from program header after receiving each
file)
HeaderSize=0

;---TrailerSize---: (Size in Bytes to cut from program end after receiving each file)
TrailerSize=0

;---NullDiscard---: 0 = NO 1 = YES (binary NULL values will discarded everywhere in
the file)
NullDiscard=1

;---TestMode---: 0 = NO 1 = YES (received Tmpfile will not be deleted)
TestMode=0

;---NCSplit---: 0= deactivated 1 = SINUMERIK 840D 2 = any other CNC
NCSplit=0

;---NCNameLines---: (number of the signifcant lines, beginning with line 1)
NCNameLines=5

; ---NCNameBegin---: Startmark in front of NameInfo
NCNameBegin=#Name#

; ---NCNameEnd---: Endmark behind NameInfo
NCNameEnd=#End#

; ---NCNameWPD---: seperator between WPD and Name
NCNameWPD=

; ---NCNameType---: seperator between Name and Type

NCNameType=
NCPéogrammStartl:%
NCPéogrammStartZ:
NCPéogrammStart3:
NCPéogrammEnd1=M3O
NCPéogrammEnd2=M17

NCProgrammEnd3=
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[DIALOGFUNCTION]

;---DlgScanLines---: (number of the signifcant lines, beginning with line 1)
DlgScanLines=10

;---Parameters in special ASCII-Character- Words---

;---D1gID---: (Name of the dialogue file)
D1gID=%MPF9999

j---DlgIDSend---: (Name of the answer file (list, error), sent from DNC_NT to
machine)
D1gIDSend=%MPF9998

j---DlgSendEnd---: (Program End for the answer file (list, error), sent from DNC _NT

to machine)
D1gSendEnd=M30

;j---DlgSendCmd---: (character which indicades to download a file with releaseID)
DlgSendCmd= (S)

;---DlgSendTcCmd---: (character which indicades to download a file with trialcutID)
DlgSendTcCmd= (ST)

;---DlgReceiveCmd---: ( character which indicades to upload a file from machine to
DNC)
DlgReceiveCmd= (R)

;---DlgSendListCmd---: ( character which indicades to download a filelist of the

machinedirectory in DNC)
DlgSendListCmd= (SL)

;---DlgWpdMark---: (allows to change the shortcut of an workpiece directory)
DlgWpdMark=WPD

;if it is impossible to write MPF, SPF, TOA ... you can define a character followed
by a number

;Y001 = MPF, Y002 = SPF, Y003 = TOA ... ordernumber as defined in Databasetable
NCDATATYPE
DlgExchangeCNCType=

;in exchange for * if it is impossible to write *, eg. X999 (only for use with
DlgSendListCmd!)
DlgExchangeWildcard=

;DlgConverter=DNCD1gI.DNCCntrl
DlgConverter=
D1gSubNumber=0

; CutFromName=

;MiniDNC DNC NT-2000

FHAHHHAHHARHARH AR RS H A H AR R A R

i [CcoM]

; #1210 [COM] XONChar

; #1211 [COM] XOFFChar

; #1401 [COM] ComPort, or Paramter: [SEND] SendBaudRate
; #1402 [CcOM] FlowCtrl,

; #1403 [CcOM] BaudRate, Parity, ByteSize, StopBits
; #1501 [COM] ComPort,

; #1502 [cOM] FlowCtrl,

H #1503 [CcOM] BaudRate, Parity, ByteSize, StopBits
; not existent [CcOM] binary

i [SEND]

; #1201 [SEND] ProgramStart

; #1202 [SEND] ProgramEnd

; not existent [SEND] CommentStart

; not existent [SEND] CommentEnd

; #1205 [SEND] HeaderChar

; #1207 [SEND] TrailerChar

; #1204 [SEND] HeaderSize

; #1206 [SEND] TrailerSize

H #1209 [SEND] SpacerChar

; #1208 [SEND] SpacerSize

; not existent [SEND] SkipFirstSpacerMark

; #1217 [SEND] SpacerMarkl

; #1218 [SEND] SpacerMark?2

; #1219 [SEND] SpacerMark3

; #1220 [SEND] SpacerMarkInsertAfterl
; not existent [SEND] SpacerMarkInsertAfter2
; not existent [SEND] SpacerMarkInsertAfter3
; #1203 [SEND] EOBcode

; not existent [SEND] SuppressComment

; #1103 [SEND] SendTimeout

; #1401 [SEND] SendBaudRate
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; #1117

[RECEIVE]
#1302

#1303

#1304

not existent
#1102

#1301

not existent
#1324

not existent

[DIALOGFUNCTION]
not existent
#1109

not existent
#1123

not existent
#1124

not existent
not existent
not existent
not existent
#1101

not existent

[SEND] SendDelay

[RECEIVE] ValidData

[RECEIVE] ProgramStart

[RECEIVE] ProgramEnd

[RECEIVE] EofChar

[RECEIVE] TimeOut

[RECEIVE] HeaderSize

[RECEIVE] TrailerSize

[RECEIVE] NullDiscard

[RECEIVE] TestMode
[DIALOGFUNCTION] DlgScanLines
[DIALOGFUNCTION] D1gID
[DIALOGFUNCTION] DlgIDSend
[DIALOGFUNCTION] DlgSendCmd
[DIALOGFUNCTION] DlgSendTcCmd
[DIALOGFUNCTION] DlgReceiveCmd
[DIALOGFUNCTION] DlgSendListCmd
[DIALOGFUNCTION] DlgWpdMark
[DIALOGFUNCTION] DlgExchangeCNCType
[DIALOGFUNCTION] DlgExchangeWildcard
[DIALOGFUNCTION] DlgConverter
[DIALOGFUNCTION] DlgSubNumber

; Copyright (C) Siemens AG A&D, ALL RIGHTS RESERVED
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10.5.3 Configuration dialog for the SINUMERIK* connection type

Configuration dialog for the SINUMERIK* connection type
The machine configuration file is configured in the configuration dialog.
General tab page (SINUMERIK* machine configuration) [GLOBAL]

The General tab page is the [GLOBAL] section of the machine configuration file for

SINUMERIK* machine connections.

machine? E |

Comparizon Directories I Job Archive Serer I Remaote Login
General FTP | Upload Dialog
Machine IP Address Im
DM Path | #4dh
MCU ID |
Pratection Level ’3_
DMS Wait Time EN
Iimkermal PCL Math I+
Mo wiorkpiece Directary [
] I Cancel | Help |

Fig. 10-14: Config dialog SINUMERIK* / General tab page

e Machine IP address

Here, you enter the IP address or the name of the machine (controller).

Extract from the machine configuration file:
MachineIpAddress=PCU50

. DMS path

This input field contains the path to the data management system on the
controller. To be able to access the data management system on the controller
from the DNC computer, a share must be set up on the controller.

Extract from the machine configuration file:
DHPath=f$\dh

© Siemens AG 2010 All Rights Reserved
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« NCUID
Designation (ID) of the controller for M:N functionality.

Extract from machine configuration file:
NCU Id=1

« Protection level
To access the SINUMERIK* machines operated with a high protection level
(0-3) from DNC, you have to set the appropriate protection level for downloads
and uploads in DNC. For this purpose, you have to enter the protection level in
the MCF file. If this is configured, prior to the download/upload, the protection
level on the machine is fetched, possibly the appropriate password set, and
after the download/upload reset again.

Changing the protection level by DNC also acts on the SINUMERIK user
interface, i.e. the machine operator has all operating capabilities possible with
this protection level!

Protection level O: System password
Protection level 1: Manufacturer password
Protection level 2: Service password
Protection level 3: User password

Extract from machine configuration file:
NC_ACCESLEVEL=3=

« DHS wait time
Time interval during which calls made to the data management server are
monitored (The default value should be used.)

Extract from the machine configuration file:
DCOMDhsWait=20

« Internal PCU path
This parameter controls the evaluation and generation of a header with an
internal path (Siemens program header) in the NC data file.

Checkbox not activated: No evaluation
Checkbox activated: One or more paths evaluated

Extract from machine configuration file:
Section [PATHS] DriveInternPath =2

A Warning

The check to determine whether an NC data file already exists on the controller can
only be carried out correctly if this checkbox has not been selected.
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¢ No workpiece directory
This parameter can only be selected if the Internal PCU Path checkbox is activated. It
is only active when bundled workpiece NC programs are uploaded.

Checkbox not activated:
A workpiece is created in DNC after the upload has been completed. The bundled NC
files are stored in the workpiece directory.

Checkbox activated:
No workpiece will be created in DNC after the upload. The bundled NC files are stored
without a workpiece directory in the machine or group.

Extract from the machine configuration file:
DIPNOWP=1
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FTP tab page (SINUMERIK* machine configuration) [FTP]

The FTP tab page is the [FTP] section of the machine configuration file for
SINUMERIK* machine connections. The settings for data transmission via FTP are
made here.

Note

The FTP checkbox must be activated on the General tab page too.

machine? E |

Comparizon directories | Job archive server I Remate login
General FTF | Upload dialog

Host |P address

Idzer

Fazgword

—Moce
ASCI i
Birary v

k. Cancel Help

Fig. 10-15: Config dialog SINUMERIK* / FTP tab page

« FTP
Data transmission takes place via FTP if the FTP checkbox is activated
(UseFTP=1). The appropriate settings must also be made on the FTP tab
page.

Extract from the machine configuration file:
UseFTP = 1

¢ Host IP address
This input field contains the IP address or the name of the DNC computer.
(The computer must be configured as the FTP server here.)

Extract from the machine configuration file:
HostIpAddress=127.0.0.0
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« User and Password
In these fields, you enter the user name and password required for the FTP.

Extract from the machine configuration file:
User=
Password=

« Mode
Mode specifies the transmission type. The following transmission modes are
available:
1: ASCII
2: Binary

Extract from machine configuration file:
Mode=2
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Upload Dialog tab page (SINUMERIK* machine configuration) [UPLOADDLG]

The Upload Dialog tab page is the [UPLOADDLG] section of the machine
configuration file for SINUMERIK* machine connections.

Note

The SINUMERIK* directories that the user can see for the upload from
SINUMERIK* are defined here.

machine? E |

Comparizon directories I Job archive server | Remote login i
eneral I FTFP |lpload dialog

Selected DF directories

SPF.CIR
SYF.OIR
WwiorkJeces

k. Cancel Help

Fig. 10-16: Config dialog SINUMERIK* / Upload Dialog tab page

The list on the left contains all of the possible SINUMERIK* directories. You can
use the arrow buttons to move selected directories to or delete them from the list of
selected DM directories on the right.

Extract from machine configuration file:
DHDIR1=MPF.DIR
DHDIR2=SPF.DIR
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Comparison Directories tab page (SINUMERIK* machine configuration)
[COMPARE]

The Comparison Directory tab page is the [COMPARE] section of the machine
configuration file for SINUMERIK* machine connections.

On this tab page, you can specify the SINUMERIK* directories that are to be
compared with the relevant directories in the DNC system.

Note

The directories specified here are used for the upload, (manual) archiving, auto
archiving, and machine comparison functions.

machine? E |

General | FTF I |lpload dialog
Comparizon directaries | Job archive server I Remate login
Selected DF directories
I — ARC.DIR
Cha DIR Cha DR
COM.DIR JIEESN | (i
C3T.0IR CUsS.DIR
CUS.DIR MPF.DIR
DEF.CIR IS puky
0G.oOIR Workpieces
DH.CIR
DP.DIR
H5.DIR :_I
Pzeudo workpiece [
D ata bppes I
File exclusion I
[k Cancel Help

Fig. 10-17: Config dialog SINUMERIK* / Comparison Directories tab page

The list on the left contains all of the possible SINUMERIK* directories. You can
use the arrow buttons to move selected directories to or delete them from the list of
selected DM directories on the right.
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Pseudo workpiece

If you want to compare the data from a selected DM directory with a pseudo
workpiece called name.DIR or archive it in a pseudo workpiece, you have to
activate this checkbox.

Note

If you activate the Pseudo Workpiece checkbox here, it will also be taken into
account when data is uploaded.

If DNC IFC SINUMERIK is also installed on the relevant machine, the pseudo
workpiece ID must be set during configuration for the same data
management directories.

FBDN1/10-204

0: No pseudo workpiecel(]
1: Pseudo workpiece

Data types

In this field, you specify the data types for the selected directory that are to be
taken into account when comparisons are carried out and when data is
archived.

Exclude file

If files should be excluded from the comparison and the archiving, this should
be specified in the Exclude file file.

For example, EXCLUDE_MPF.DIR =Test1

Extract from the machine configuration file:
For example, WKS.DIR directory, (no pseudo workpiece), files of the type
MPF, SPF, TOA, etc., will be considered, the WKSA1 file will be excluded

DHDIR1 = WKS.DIR;0;MPF;SPF;TOA;ZOA;RPA;WPL;JOB;BMP;ARC; INI
EXCLUDE_WKS.DIR =WKSAl
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Job Archive Server tab page (SINUMERIK* machine configuration) [COMPARE]

The Job Archive Server tab page is the [COMPARE] section of the machine
configuration file for SINUMERIK* machine connections.

NC-active data (a subset (to be defined) of the series startup data) on the controller
may need to be backed up during auto archiving. You can enter the settings
required for this on this tab page.

Note

The Auto Archive and Auto Compare checkboxes in the Properties dialog for the
machine must also be activated.

machine? E |

General I FTP I Ilpload dialog
Comparizon directaries Job archive server I Femate login
Jab file [
Archivs file |

' aiting time |5 [Minutes]

k. Cancel Help

Fig. 10-18: Config dialog SINUMERIK* / Job Archive Server tab page
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Job file

The job file contains the job data for auto archiving. The file must be located in
the add_on directory (same directory as DHS.EXE) on the PCU50/MMC103.
You must enter the name of this file in the appropriate input field.

Extract from the machine configuration file:
ARCJOB=aaa

Archive file

This field contains the name of the archive file to be created. The file is first
created in the data management system on the machine and is then uploaded
to the DNC system. If you do not make an entry here, the name of the job file is
used as the archive file name.

Extract from the machine configuration file:
ARCFILE=

Wait time

Auto archiving is time-monitored, that is, if an individual archiving job is not
reported as complete during the specified wait time, auto archiving continues
with the next partial job. This is noted with an appropriate entry in the log file
(ARSERVER.TXT in add_on\tmp).

Extract from the machine configuration file:
ARCTIMEOUT=5

| Important

If you have any questions about this function (particularly with regard to defining
the job file), please contact the hotline.

FBDN1/10-206
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Remote Login tab page (SINUMERIK* machine configuration) [REMOTELOGIN]

The Remote Login tab page is the [REMOTELOGIN] section of the machine
configuration file for SINUMERIK* machine connections.

A remote login is necessary for transmitting data because if transmission does not
take place via FTP and although the data management directory on the controller
is shared, the user logged in to the PC is not authorized to access the controller.
Remote login enables the user of the DNC PC to log in to the controller with the
name and password entered on this tab page.

machine? E |

General I FTP I Ipload Dialog |
Comparizon Directaries I Job Archive Server Remate Login

Fiemaote Computer

Damaia IF"I:LI ]
M ame I.f-‘-.LIDLISEFE
Pazzward I"“’“‘””‘

DCOM Authentication [

k. I Cancel Help

Fig. 10-19: Config dialog SINUMERIK* / Remote Login tab page
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Remote computer
This input field contains the IP address or the name of the remote network
server.

Extract from the machine configuration file:
RemoteName=PCU50

Domain

Here, you enter the domain to which the user is assigned. This is only the
same as the name in the Remote Computer field when used locally. (You have
to enter the computer name here. The IP addresses are syntactically
incorrect).

Extract from the machine configuration file:
Domain=PCU50

Name and Password

Here, you enter the user and password to be used to access the data
management system on the controller

(see DM Path on the General tab page - [GLOBAL] section).

Extract from the machine configuration file:
User=AUDUSER
Password=******x*x

DCOM authentication
This checkbox must be activated if the login parameterized above (domain,
name, password) is also to be used for DCOM authentication.
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Standard machine configuration file for the SINUMERIK* connection type

Table 10-12: Example of a standard machine configuration file for the SINUMERIK* connection type

[GLOBAL]
MachineType=SINUMERIK84 0D
; NCU_Id=NCU Identifier, only for N:M functionality
;  NCU _Id=NCU 1
;  MachineIpAddress=195.212.26.XXxX (or MMC Computer name)
MachineIpAddress=127.0.0.0
DHPath = Sharename of the released Network-Path of
MMC/PCU e.g. PCU50: the directory f:\dh is shared as
; "data" --> DHPATH=data
DHPath=c\dh
;  You can use FTP for Filetransfer, if you have an FTP-Server
; 1in your Subnet available. UseFTP 0=NO, 1=YES
;  Note: You must set the right ftp-path in your ftp-settings, to
;  put the files in the DNC directory
UseFTP = 0

NC_LOGIN=
DCOMDhsWait=20

[FTP]

; HostIpAddress= (or DNC Computername)
HostIpAddress=127.0.0.0

User=27?7?

Password=???

; Mode (1=ASCII/2=Bindr)

Mode=2

[COMPARE]

; Specify directories on the SINUMERIK 810D/840DI/840D/810D side, which have to be
compared with

the directories in the DNC-System

AutoArchive-function will archive missing directories in the DNC-System

if necessary, compare or archive DH-directories (ARC...) with a pseudo-workpiece-
directory (*.DIR)

limit to special filetypes, if requested

EXAMPLES :
DHDIR2

SPF.DIR;0; SPF
second DH-Direcory. List all your DH-DIRs. from 1-30, if necessary.

DHDIR2 = SPF.DIR;0; SPF
AAAAAAY SPF.DIR is the name of the DH-directory.
Files belonging to DH\SPF.DIR (SINUMERIK) will be
compared/archived

DHDIR5 = CST.DIR;TRUE; AWB;COM;SPF
AAA% TRUE: specifies, that files from this DH-directory will be
archived in a PSEUDO-Workpiece (*.DIR) (here: CST.DIR)

TRUE or 1: DH-directory will be archived as a Pseudo-
workpiece-directory in DNC-System

FALSE or 0: files of the DH-directory will be archived
directly in the default-upload-directory
in the DNC-System

DHDIR3 = WKS.DIR;0; MPF;SPF;TOA
AAAAAAAAAAS MPF;SPF;TOA: Listing of filetypes,

which have to be compared/archived.

Caution: All filetypes have also to be

configurated in the DNC-database!!

7
7
7
i
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
7
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Exclude special files from comparing/archiving-function.
EXAMPLES :
DHDIR1= MPF.DIR;0; MPF; CEC
EXCLUDE_MPF.DIR = Test; Testl

Test.mpf, Test.cec,Testl.mpf and Testl.cec
of the the DH-directory "MPF.DIR" will be excluded

DHDIR1= MPF.DIR;0; MPF
EXCLUDE_MPF.DIR =

DHDIR2= SPF.DIR;0; SPF
EXCLUDE_SPF.DIR =

DHDIR3 = WKS.DIR;O0; MPF;SPF;TOA;ZOA;RPA;WPL;JOB;BMP;ARC; INI
EXCLUDE WKS.DIR =

DHDIR4= ARC.DIR;1; ARC
EXCLUDE_ARC.DIR =

; Note: If you don't find the directory, you want in this list, please
; refere the MMC/PCU - Services and add the directory you want with the
; next free DHDIR - Number (e.g. 11).

;Sicherungsauftrag fir NC aktive Daten

'Archivauftragsdatei muss in selben Verzeichnis liegen wie der DHS.EXE
;ARCJOB=NCACT1

;zu erstellende Archivdatei in der Datenhaltung

;ARCFILE=NCACT1.ARC

'Timeout in Minutes

ARCTIMEOUT= 5

[REMOTELOGIN]

; Only necessary, 1f FTP is not used

; IP-Address, DNS or NetBIOS name of the Remote Network Server, default is
; the Name of the Machine in the network like in [GLOBAL] MachineIpAddress
RemoteName=PCUXXXXXXX

; User with read/write access to the network share/directory of [GLOBAL] DHPath
User=AUDUSER

; Password for the User with read/write access the network share
Password=*******

; Domainname, where this user is assignet to, if it is a local user in e.g.
; Win NT or XP, same like [REMOTELOGIN] RemoteName (PCUXXXXXXX)
Domain=PCUXXXXXXX

[ULOADDLG]

;DHDIR1=MPF.DIR
;DHDIR2=SPF.DIR

; Copyright (c) SIEMENS A&D, ALL RIGHTS RESERVED

© Siemens AG 2010 All Rights Reserved
FBDN1/10-210 Motion Control Information System DNC (FBDN) - 04/10 Edition



05.07 DNC Plant/DNC Cell (FBDN1)
10 Configuration

10.5.4 Configuration for the file system connection type

The file system machine type can be used to transfer NC data from and to any
network drives that have been released. Any network-capable controller can be
connected to the DNC system under Windows. Two directories have to be
configured for downloading and uploading NC data.

A conversion of the file type can be configured for the download or upload. This
configuration can appear only in the machine configuration file.

See also: Standard machine configuration file for the file system connection type

Configuration dialog for the file system connection type

File zystem properties

Send drectary I'\'\Machine_S"xInputDir

Meceivz directary I\\Machinej'\[lutput[.lir

Fig. 10-20: File system config dialog

Note

Only users with the appropriate configuration authorization are permitted to define
directories for the file system machine type.

Send directory
The send directory is the directory to which the NC data is to be downloaded.
Receive directory

When the NC data is uploaded, it is transferred to the specified receive directory in
accordance with the version strategy.

Note

The directories are not specific to a particular computer when they are specified
in UNC notation (e.g. \Server1\DNC\Data).
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Standard machine configuration file for the file system connection type

Table 10-13: Example of a standard machine configuration file for the file system connection type

[GLOBAL]
MachineType=filesystem
Comment=

[SEND]
DIRECTORY=C:\tmp\send
Conv1l=MPF TXT
Conv2=SPF -

[RECEIVE]
DIRECTORY=C:\tmp\receive
Convl=- SPF

; Copyright (C) Siemens AG A&D, ALL RIGHTS RESERVED

Rename file extension for the download

The renaming of the file extension for the download is configured in the parameters
Conv1 to Conv4.

In the assignment, the file extension in DNC (corresponds to NCDATATYPE) is
specified first and then the new file extension for the file system.

Extract from machine configuration file:
[SEND]

Conv1l=MPF TXT
Conv2=SPF NCA

Example:

DRILL_4711.MPF > DRILL_4711.TXT
MILL_4711.MPF > MILL_4711.TXT
DRILL_4811.SPF - DRILL_4811.NCA
MILL_4820.SPF - MILL_4820.NCA

If the files should not have any file extension after the download, the assignment
must contain a minus character rather than the new file extension. In this case, the
file extension (including the period) will be truncated

Extract from machine configuration file:
[SEND]

Conv1l=MPF -
Conv2=SPF -

Example:
DRILL_4711.MPF - DRILL_4711
DRILL_4811.SPF - DRILL_4811

Rename file extension for the upload

The renaming of the file extension for the upload is configured in the parameters
Conv1 to Conv4.

In the assignment, the file extension for the file system is first specified and then
the file extension in DNC.

Extract from machine configuration file:
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[RECEIVE]

Conv1=TXT MPF
Conv2=NCA SPF

Example:

DRILL_4711.TXT - DRILL_4711.MPF
MILL_4711.TXT = MILL_4711.MPF
DRILL_4811.NCA > DRILL_4811.SPF
MILL_4820.NCA > MILL_4820.SPF

If the files do not have any file extensions prior to the upload, they can only receive
one file extension in DNC, because it cannot be determined which file extension
was appended prior to the download.

Extract from machine configuration file:
[RECEIVE]

Convl=- SPF

Example:

DRILL_4711 > DRILL_4711.SPF
MILL_4711 > MILL_4711.SPF
DRILL_4811 - DRILL_4811.SPF
MILL_4820 > MILL_4820.SPF
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10.5.5 Dialog function configuration dialog

General
To configure the dialog function, the Dialog Function checkbox on the
Configuration tab page on the Machine Properties dialog must be selected. The
dialog function remains active until it is deactivated again in the configuration.
GroupA machinel |
Configuration |
Conficuration file: E dit |
|ma.:h'ne 49 drMCF
: Config dialog |
Station:
ITerm'naH
Tranzmiszion module: Drizplay growup for ligt:
ISeria without pratocal ~| ™ Dislog function IMLI5'1 |
¥ Manual sbort
Upload directony Search levels for HC data

ﬁ machine 43_dt _"'J & machine 49 _dt ;I

Yerzion Strategy For Upload

o

] 4 Cancel Help

Fig. 10-21: Machine properties / Configuration tab page: Configuration
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DISPLAYGROQUP | LPOS | COLUMNNAME | FIELDNAME_GR|FIELDNAME_UK COLWIDTHI

| |GROUPAD 1 NCDATANAME  MName MName 20
| |GROUPAD 2NCDATATYPE Twp Type 5
| |GROURAD 3 VERSION Wersion Yersion 7
| |GROUPAD 4 RELEAZSEID Freigabekennung Release |d. 10
i GROUPAD S TRIALCUTID Einfahrkennung | Trialcut 1d. 1o

GROUPAD B LENGTH Lange Length 10
: GROURAD T AREA Eereich Area 5
| |MLIST! 1T NCDATANAME  Name MName 1
| |MLIST ZNCDATATYFE  Twp Type 1
| MLIST 3 VERSION Wersion Wersion 1
| [MLIST 4 RELEASEID Freigabekennung Release Id. 1
| |MLIST 5 LENGTH Lange Length 1
* 0
Datensatz: 14] 4 || £ v |»1]r#] von 12

Fig. 10-22: List description for dialog function lists

The list display group (MLIST1) refers to the response lists requested via the dialog
function.

The list display of a display group can be changed in the List Editor. The List
Editor can also create a new display group if a suitable list display is not available.
The display groups are defined via the DNCLISTDESCRIPTION database table in
DNC.

You can select any of the defined lists, even those that were created for the user-
specific list display on the right of the interface.

Depending on the options offered by the controller editor, it may be advisable to
choose short list displays for the dialog function.

Note

The display of response lists to dialog function requests for links is set
permanently with:

e Name

e Size

e Changedon
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Downloadlist. izt - Notepad -|O] |
File Edit Search Help
YMPF9998 =
{Hame Type Uersion Release Id. Trialcut Id. Length)
{Bielle-moteur HPF 1 1 [§] 1487 )
{Cycle-filetage-B11 SPF 1 1 a 254 )
{Up SPF 2 a 1 17 )
M3 g
Ki 4

Fig. 10-23: Response list for a dialog function request

Search levels for NC data

The configured search directory in the dialog function is machine specific, that is,
any program or list requested can only originate from this defined section. The
configuration is performed via a combination field. The following search areas are

available:
e Link (when

the link is configured, a second combination field appears

containing all of the links configured on the machine. You have to choose one
of these links for the configuration).

e Machine

e Machine, group (search area for machine and higher-level group)

Upload directory

The configured

upload directory in the dialog function is machine specific, that is,

all uploaded programs can only be stored in this defined section. The configuration
is performed via a combination field. The following search areas are available:

e Link (upload directory: The link assigned to the machine; the file is stored here
without any administrative data).

e Machine

e Group (upload directory: The higher-level group of the machine)

Note

DNC generates administrative data for uploaded files stored in a machine or
group directory. All the automatic mechanisms for version management and the
releasel/trial cut IDs apply here.

FBDN1/10-216
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Configuration errors on the machine server in conjunction with the dialog function
are indicated on the user interface by a red square on the machine.
Communication errors with the dialog function occur when the machine server is

configured incorrectly.

A communication error on a machine when the dialog function is selected can

occur in the following situation:

Machine 1 and machine 2 are both using the dialog function. The machine servers
for machines 1 and 2 are also configured on COM port 1. The user interface

displays a communication error on machine 2.

!rﬁi.,_DNE - Terminall

FEile Edt “iew Ophons Machine Alignment Help
| W 4 BER e XxEda Y I Address iE:\Pngrams\,Michsuﬂ Officel** *
_ Mame | Size | Date modifis
-l test link Microsaft .. 333 21.07.9915...
= graup Microsoft .. 366 21.07.9915..
E"ﬂgﬁ'ﬂhmm Microsaft .. 322 21.07.9915..
L link? . :
P ; Microsoft ... 338 21.07.9315...
: 'imll'”*: N |ach|n82 Microsoft . 453 21.07.9915...
=0 group 55 Microsoft .. 467 12.05.9913.
‘:"'ﬁmac i Microsoft .. 394 21.07.9915...
P Microsaft .. 472 21.07.9915...
=1 group?
uﬁ i Microsaft .. 394 21.07.9315...
M3 Acoes.. 282 21.07.9315...
MSCREA.. 0 120593 13...
OF97SPE.. 265 04.09.97 00...

Fig.
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10.5.6 Configuration dialog for the tool setting device

General
Tool setting devices are always inserted directly underneath the plant root.

N

Configue Tool Setting Device |

Configaration File:

EDIT
[WZEG MCF
y Config. Dialog
Station: Froducts:
| Terminala |oNC
Traresmizzion budule, [T Teminate banually
I Serial without protocol j I TTD j Freset D ata

ITOA "I actual Data

Yerzion Strategy For Upload

[

[k I Cancel Help

Fig. 10-25: Properties of tool setting device

Station

The assignment of a tool setting device to the HMI workstation is made via the
station name, which must be unique in DNC Plant. This entry is not necessary in
DNC Cell because there is only one station.

Note

The station name configured for a tool setting device must not be
used for any other tool setting device or machine. When you confirm
the Properties dialog, a plausibility check is carried out to determine
whether the station name has already been assigned to a tool
setting device or a machine. In this case, the dialog remains open
until a correct station name has been entered.

Transmission module
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As with the machine types, the tool setting devices can be connected in a serial
configuration or via the file system (network drive).

Preset data

Preset data is tool data that is downloaded to the tool setting device where it
provides a basis for setting and calibrating the tools. The display field contains the
NC data type for the preset data.

Actual data

Actual data is tool data that is generated on the tool setting device and is uploaded
from here back to the DNC system from where it can be downloaded later to the
relevant machine.

Note

Within a DNC plant, all the tool setting devices must use the same preset value
types and actual value types. They are defined in the DNCMACFG configuration

table.
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10.6 Editing database tables

The DNC database can be configured in DNC Admin by authorized users. To call
up and edit the database tables, choose Tools > Config. Tables .
The following database tables can be modified:
e DNCGLOBALSETTINGS
This table is used for managing all the global settings.
e DNCMACFG
This table is used for managing machine-specific configuration parameters.

To edit the database tables, call up the relevant dialog and edit the table containing
all the current parameters.
Existing data records can be changed or deleted and new ones created.
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10.7 Global settings

In the DNCGLOBALSETTINGS database table, the following global settings can
be defined in the database fields NAME and INTVAL:

e Maximum number of possible versions (default: 5)

e Version strategy for upload (default: 1)

e Storage strategy for editing (default: 1 (new version after editing))

Maximum number of NC data records displayed in a listin DNC HMI and DNC
Admin (default: 1000).

Note

To change the default setting of 1000, you may have to redefine the
"ReadMaxRecords" entry.

e Maximum number of NC data records displayed in a list in DNC IFC
SINUMERIK (default: 1000).

¢ Maximum number of NC data records displayed in a list on old SINUMERIK

840D machines (default: 1000).

Separator and comment characters for formatting CSV files

Defining the graphic types for the print function

Invalid characters for the NC data designation (& "+,;=!,(){}$R§u3)

Header for list printouts

Comments and export files in ASCIl or UNICODE

Version strategy for automatic import

List request for dialog function

Extent to which filters can be assigned to stations, display groups, and user

names

Identifier for DNC Plant and DNC Cell

e Further entries for special options

The key for the NAME field is assigned an integer value (INTVAL) or a string
(STRINGVAL).

10.7.1 Maximum number of possible versions

The assignment of the maximum number of possible versions is defined via the
MaxNCVersions key.

Table 10-14: Global settings for the maximum number of possible versions
NAME database field INTVAL database field

MaxNCVersions >1
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10.7.2 Version strategy for upload

The assignment of the version strategy is defined via the VersionStrategy key.

Table 10-15: Global settings for the version strategy for upload

NAME database field

INTVAL database field

VersionStrategy

1..6

You can choose one of six strategies:

Table 10-16: Version strategy for the upload

Configurable
numbers for

version strategy

Version strategy for
uploaded NC data

Release strategy for
uploaded NC data

Deletion strategy when
max. no. of versions is
reached

1 (default) The next free version is | The release identifier is not | The version with the oldest
assigned. set.* change date, which has not
been released, is deleted.
2 " " The "Delete Version Dialog"
is displayed.***
3 " The release identifier is The version with the oldest
set.** change date, which has not
been released, is deleted.
4 " " The "Delete Version Dialog"
is displayed.
5 The highest version is The release identifier is not
replaced. set.*
6 " The release identifier is
set.**
* The release identifier of an older version remains unchanged.
> The release identifier of an older version is reset.

For automation-related reasons, the dialog function does not support a

delete version dialog. For this reason, strategies 1 and 3 are adopted for
version strategies 2 and 4.

The version strategies do not apply to links because no administrative data is
maintained in the database for this NC data.

Note

The version strategy is set once during installation. Subsequent changes should
only be made by Siemens to prevent inconsistencies in the data management

system.
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10.7.3 Storage strategy for editing

The assignment of the storage strategy for editing is defined via the
NewVersionAfterEdit key.

Table 10-17: Global settings for the storage strategy for editing
NAME database field INTVAL database field

NewVersionAfterEdit 0/1

You can choose one of two strategies:

¢ 0= Unchanged versions and existing identifiers
e 1 = Next available version with the identifiers for the edited version
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10.7.4 Machine-specific version management

General

Machine-specific version management uses version zones to define the hierarchy
level within which NC data with the same name, type, and version can occur. By
defining a version zone, you can ensure that the same program is always used
within the version zone.

Version zones are always defined at higher-level node points (groups or sub-
groups). The node at which the version zone is defined and all of the subordinate
nodes (groups, subgroups, machines) together form the version zone.

Note

The plant root (at the top) is a node, not a group.

You can only define the version zone at node points (groups, subgroups). Version
zones cannot be defined at machine level.

When you define a version zone, this causes all subordinate objects (including the
NC data directly underneath this node) to align with this node.

Note

If you do not define a version zone, each object (each node and each machine)
is regarded as a separate version zone. This is the default setting when the
system is shipped.
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When you set a version zone, all subordinate version zones are reset. You cannot
set any more version zones at subordinate nodes of the set version zone.

Nodes that indicate the beginning of a version zone are displayed in the tree view
by means of a white field with a "V" in the icon.

The version zone is defined via the PROCESSINGRANGEID field in the
DNCNODEINFO table.

Here, you can enter the NODEID of the node that defines the version zone.

This means that in the PROCESSINGRANGEID field, this node and all subordinate
nodes have the entry of the NODEID for the node with which the version zone is
formed.

Upload

The version zone is taken into account when an NC data file is uploaded. Before
an NC data file is uploaded, a check is carried out to determine whether the
maximum number of versions of this NC data has already been reached within this
version zone.

If this is the case, either an older version is deleted or the "Delete Version Dialog"
is activated (depending on the version strategy). Users can delete older versions in
this dialog.
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10.8 List editor

10.8.1 General

The list display layout is also stored in the database. This means that the list
display can be configured in line with the needs of users and machines (display
groups). You can create a list display in several languages for each display group.

Hame | * | Type | Yersion | Trialcut Id | Release [d
cut-olf-cycle SFF 4 1 0
cut-clf-cycle SPF 3 1 0
%] cut-olf-cycle SPF 2 1 0
ranual_gear kMFPF 3 1 0
@ gear-rellow

Fig. 10-26: List display variant of the operator interface
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Lizt description editor

Screen form defaultz 0k

j Uk | Cancel 1

Save

Diizplay group: GR

Delete

dde

Coolurnin amme: |, ]Name Column: [N ame =]
{or =] IName Indes: |1_ 2 | | 2
[FR =] [Nom duprogramme-piece widtt 20 Delete curr. column |
Name [ Typ |we. | Rele. | Tral. | Length| dwea |

Fig. 10-27: List Editor

The List Editor is divided into 3 sections:

1st section:  Defaults with buttons that refer to the complete list display for the
display group in question. Complete list display means that the
list for all the languages in a display group is saved or deleted
or that changes are ignored (Cancel).

2nd section: Section in which data can be entered with edit buttons and input
fields.

3rd section:  Preview of the list display set in the defaults.

Note

Changes to the current list display do not take effect until the next time DNC
or DNC Admin is started.

Not all of the available languages are shown in this dialog; not only does this
ensure clarity, but it is also rarely the case that all languages supported by DNC
are used in one plant.
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10.8.2 Description of the 1st section of the List Editor

General

The defaults determine the preview displayed in the 3rd section of the editor. The
display group also determines which complete list description (see above) is
currently being modified and will be saved.

Using the Display Group combination field, you can choose one of the available
display groups. If you change the display group, you have to decide whether you
want to save the changes made so far.

Using the Language combination field, you can choose one of the available
languages. This field determines the language in which your preview appears.

Creating display groups

To create a new display group, you enter the name of the new group in the
Display Group combination field. Then save this display group immediately.

Note

Before you create a display group, choose a display group with a list display
similar to your new one. This list display is used as a basis for the new list display
so that you do not need to start from scratch.

Before you can assign your new display group to a user, a screen and list
description must exist for this display group.

In addition to display groups that can be named as required by the user, DNC
contains predefined names for display groups:

e HCSV: Defines which field contents in the data records are written to the
CSV file.

e #PRINTLIST: Here, you can configure which field content is displayed when
the administrative data is printed or when the print preview is
called up.

e DELLIST Defines the sequence of columns in the "Delete Version
Dialog" in DNC IFC SINUMERIK.
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Deleting display groups

You can delete the complete list display in all languages for this display group by
choosing Delete.

A Caution

Before you delete a display group, make sure that it is not being used by any
users or machines (see also: Dialog function) !

The list description for the DELLIST display group is essential for DNC IFC
SINUMERIK. Do not delete the DELLIST display group if you want to use DNC
IFC SINUMERIK.

The GLOBAL list description is used for the generic filter. If you delete this list
description, the list description of the respective user currently active takes effect.
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10.8.3 Description of the 2nd section of the List Editor

Calurnr; IName j

Inde: |1_ - | S |

Wfidth; IEEI Delete cum. u:u:ulumnl

Fig. 10-28: Right-hand section of the List Editor (2nd section)

Choosing the column

Index

Width

In the Column combination field, you specify which items of administrative data for
the NC data you want to display in the list display and which column is currently
being edited.

You can also choose the column (date of administration modification) using your
mouse in the preview.

The number after the index indicates the position of this column in the list display.
Using the arrow buttons, you can move the column further forwards or
backwards.

In this field, you can enter the width of the column to specify how it is to appear in
the list in all languages. You can also set the width directly in the preview using
your mouse. You are, however, advised to check the width because you can set it
more accurately using the mouse. You can do this by entering the width again,
selecting a different field with your mouse, and watching the field in question while
you do this.
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Deleting a column

To delete the column currently entered in Column, click: Delete current column
(see above). This column is then deleted in all languages!

Adding a column

To add a new column, you have to select a date of administration modification in

the Column combination field. You then have to enter the column names in the

appropriate language (see below). You can set the index using one of the buttons
for the index (arrow buttons). You then have to specify the width after which you
can view the new column in the preview.

Column name

Column name: |, ]Name

IGH j IName

IFH j INDm du programme-pigce

Fig. 10-29: Left-hand section of the List Editor (2nd section)

In the area shown, you can enter the name of the column for the relevant language
as it is to appear in the list. The fields for the following languages can be seen
here: GR for German, UK for English, and FR for French (See also: Languages).

In the right-hand part here (see figure above: right-hand section of the List Editor
(2nd section)), you can confirm, extend, abbreviate, or rename the shown name of
the column.

Note

The input fields for the languages you do not use can be left empty. It is
advisable, however, to maintain these fields in your language. If the language is
then changed at some later point in time, the list headers are not empty.
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10.9 Screen editor

10.9.1 General

The layout of the Properties screens for the NC administrative data is also stored in
the database. This means that the screen display can be configured in line with the
needs of users. You can create a screen display in several languages for each
display group. The Properties screens have a fixed resolution of 360 x 160 pixels.

. EEK

Field Edit “iew
Screen form defaults QFk. |
Drigplay group:

GROUPAD Secreen fu:urml Mew MC data j

Save

Figld: I Marme

Large dizpl 5 Page: T |‘ |
[ Large display LIE. sl IGE”E’al J Cancel
«| Field Editb E - Delet field
J i | it b J elete cur. fie |
|1 [:;:J field [Edibox E El Refresh |
Coordinates

Field ] IN ame

"

I GR j IF'rc:grammname

M Iﬁ

i

W

IFH j INu:um du programrne-pigce Length: |

=
=

Fig. 10-30: Screen Editor

The Screen Editor is divided into 3 sections:

1st section:

2nd section:

FBDN1/10-232

Defaults with buttons that refer to the complete screen display for
the display group in question. The defaults also determine which
preview is displayed.

Section in which data can be entered with edit buttons and input
fields for the preview to be displayed.
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Fig. 10-31: Screen Editor preview

3rd section: Preview of the screen display set in the defaults.

Note

Changes to the screen display do not take effect until the next time DNC is
started. Any changes made take effect immediately in DNC Admin.

Not all of the available languages are shown in the Screen Editor; not only does
this ensure clarity, but it is also rarely the case that all languages supported by
DNC are used in one plant.
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10.9.2 Description of the 1st section of the Screen Editor

General

The defaults also determine which preview is displayed. The display group also
determines which complete screen description is currently being modified and
will be saved. Complete screen description means that the screen description is

saved for all the languages used.

Field Edit iew
Screen form defaults OF. |
Dizpl L e
bl = RO LIFAD Screen fDrmINew ML data j
Save |
™ Large dizplay Uk = PagEiIEeneral j Ehee I

Delete

[

Fig. 10-32: Screen Editor — 1st section

Using the Display Group combination field, you can choose the appropriate
display group or create a new group. If you change the display group, you have to
decide whether you want to save the changes made so far.

All the other fields are used for setting the preview.

You use the Screen Type combination field to specify the type of screen you want
to create and display in the preview. You can use the New NC data option to
generate the screen for creating a new NC administrative data record. Using
Display/Change, you can configure the screen in which you can view or change
existing NC administrative data.

The Large Display checkbox allows you to display a magnified or normal-sized
version of the preview. If a large display format has been configured for the
selected display group, this setting must be selected so that the screens are
displayed and configured with the correct display format.

The Language combination field is used to change the language for the preview.

The Page combination field is used to change the tab page displayed in the
preview.

The menu options in the View menu perform the same functions as the
combination fields.

By choosing Edit-> Tabulator Sequence, you can display or change the tab

sequence in the relevant screen. You can then make an entry in the Tabulator
field in the 2nd section of the Screen Editor.
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Creating display groups

To create a new display group, you enter the name of the new group in the Display
Group combination field. Then save this display group immediately.

Note

Before you create a display group, choose a display group with a screen display
similar to your new one. This screen display is used as a basis for the new screen
display so that you do not need to start from scratch.

Before you can assign your new display group to a user, a list description
must exist for this display group (see also: List editor).

Deleting display groups

You can delete the complete screen description in all languages for this display
group by choosing Delete.

Caution

Before you delete a display group, make sure that it is not being used by any
users (see also: Dialog function) !
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10.9.3 Description of the 2nd section of the Screen Editor

General
Field: IName j {:iEhj IEdit box  E j Dielete curr. fieldl
WOe:
[ [:;*E“ field [Edithex  E =i Refresh |
E LK IName Coordinates
% |5 e |42
GR =| |Mame —
7 o | -
ISF‘ j INDmI:ure programa Length: [40
Fig. 10-33: Screen Editor — 2nd section
In the 2nd section of the Screen Editor, you can make changes to the screen
display for the display group in question.
Field

In the Field combination field, you can specify which administrative data is to
appear in the screen display and which field is currently being edited.

Delete Current Field

This button deletes the field selected in the Field combination field from the screen
description.

Update

This button refreshes the preview.
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Field type

Two combination fields are available for selecting the field type.

The upper Field Type combination field is used for the "Display/change” screen
type.

The lower Field Type New combination field is used for the "New NC data"
screen type.

You can choose the following field types:

Table 10-18: Field types

Field type Meaning Example

Edit box Input field Verson [~
Combo box Combination field Type m
Checkbox Checkbox rar k1T

Output field Inactive input field Lengh [
Output field checkbox Inactive checkbox Triakw D ™

Static text Text field Mame

The combination field is used exclusively for the program type, since a list must
exist from which data can be selected. Up to now, this was only possible with the
program type.

Note that checkboxes can only output the values "0" or "1".

The field types edit box (input field) and output field (inactive input field) can
be used for any field.

Static texts (text fields) cannot output any data values. They can be used for any
field.
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Tabulator

This input field, which you can edit by choosing Edit-> Tabulator Sequence,
displays the tabulator index of the field selected in the Field combination field.

When you open the Properties screen, the field with the lowest tabulator index is
selected automatically. When you move through the fields using the tabulator, the
cursor always jumps to the field with the next highest tabulator index until the field
with the highest tabulator index is reached. This is followed by the buttons for the
Properties screen. The cursor then jumps back to the field with the lower tabulator
index.

Note

The tabulator indexes do not have to be sequential (1,2,3,4,....10). They can also
contain gaps (1,3,5,6,7,10). The advantage of this is that it is not necessary to
resort all of the fields if the tabulator sequence is changed.

Field Name

Field ] I M arme

IGH j IName

ISF" j INu:-mI:ure programa

Fig. 10-34: Screen Editor — field names

In the area shown, you can enter the name of the field for the relevant language as
it is to appear in the screen. The fields for the following languages can be seen
here: GR for German, UK for English, and FR for French (See also: Languages).
The name displayed in the Field combination field can be left as it is, extended,
abbreviated, or a new name can be assigned.

Note

You are advised to ensure that the length of the names in the different languages
are roughly the same because the coordinates apply to all languages used in the
field. In the screenshot above, the field name entered in French was too long and
has been truncated in the screen.

The input fields for the languages you do not use can be left empty. It is
advisable, however, to maintain these fields in your language. If the language is
then changed at some later point in time, the field names in the Properties dialog
are not empty.
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Coordinates

Kl

Coordinates

w |5
B |
Length: [40

Fig. 10-35: Screen Editor - coordinates

In the area shown, you can enter the position and size of the field on the screen for
each field selected in the Field combination field.

Coordinates cross:

e Xx goes from left to right (1 to 350 in pixels)

e y goes from top to bottom (1 to 150 in pixels)

e The upper left corner of the tab page represents the origin (x =1; y=1)

x is the horizontal starting position for the field name.

y is the vertical starting position for the field name and the input/output fields.

x2 (1 to 350 in pixels) is the horizontal starting position for the input/output fields.
The field name appears in front of this (coordinate x). x2 is only relevant for edit

boxes (input fields), output fields (inactive input fields) and combo boxes
(combination fields).

General |Inf|:| | Additional

G_cylinder

Fig. 10-36: Screen Editor — position of a screen field
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The length must be at least 1 (1 to 80 approx. width of letters in normal view). In
the case of edit boxes (input fields), output fields (inactive input fields) and combo
boxes (combination fields), the length is the length of the input field or combination
field without the field name. The length is of no importance for the other field types.
(Exception: Length = 0 - the field will not be displayed)

[Ficldlength LEM|

General |info | Additional

5_cylinder

Fig. 10-37: Screen Editor - length

Note

Fields that exceed the screen border are truncated.

When you define new fields, it is useful to note the positions of the other fields.
The layout of the screen can then be structured symmetrically.
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10.9.4 Saving the screen display in the database

General

10 Configuration

The DNCFORMDESCRIPTION database table defines the screen display of the
Properties screen for the NC data and import function. All the other screens have a

predefined screen layout.

Table 10-19: DNCFORMDESCRIPTION screen definition table

DISPL.- COL.- FIELD- DLG- PAGE | X Y |X2 |[LEN |FIELD-
GROUP NAME N._GR ORD. TYPE
GR_AD NCDATA- Name 1101 1 5| 5 42 40 | E
NAME
GR_AD DNCDATA- Type 1102 3 5125| 42 3|/COB
TYPE
GR_AD RELEASEID |Release 1103 1 5|180| 42 1| CKB
ID
Group1 VERSION Version 2108 2| 150|25| 200 3|E
Group1 TRIALCUTID | Trial cut 2109 1| 150 80| 200 1| CKB
ID

DISPLAYGROUP field

DISPLAYGROUP defines the user group for which the screen display is to be valid.
The name of the DISPLAYGROURP is user defined.

COLUMNNAME field
COLUMNNAME assigns the screen field to the field of the same name in the

DNCDATA database table.

Note

COLUMNNAME only evaluates field names in DNCDATA.
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FIELDNAME_<LANGUAGE?> field

These database columns contain the language-specific field names.

FIELDNAME_GR contains the German field name,
FIELDNAME_UK contains the English field name (and so on).

DLGORDER field

DLGORDER describes the order number of the fields in the screen output. It must
be unique. The following method of assigning numbers is recommended:

Display group Tab sheet Tabulator sequence

et
1 2 0 8

Fig. 10-38: Order number of the fields in the screen output

1208 means, therefore:

e Display group 1 -> GROUPAD
e Tab page 2 - Info
o Tabulator sequence 08 -> Field is reached when the tabulator is

pressed eight times

PAGE field

PAGE defines the tab page on which the field is to be placed. The following
assignment applies:

e 1-> tab page General

e 2-> tab page Info

e 3~ tab page Additional

Note

The Comments and Attachments tab pages are reserved exclusively for
comments and attachments for the NC data. They cannot be configured via the
DNCFORMDESCRIPTION table.
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X, X2 and Y fields

The X and Y fields indicate the pixels in the top-left of the field to be displayed and
its field name.

The X2 and Y fields indicate the pixels in the top-left of the field to be displayed
without the field name.

LEN field
LEN indicates the length of the field in characters.

FIELDTYPE field

FIELDTYPE defines the field type of the screen field for the NC data Properties
screen. The following types can be defined in DNC:

FIELDTYPE_NEW field
FIELDTYPE_NEW defines the field type for entering data (import and new NC data

screen).

o OQutput field -0

e Editfield >E

e Combination field (combo box) -> COB
e Checkboxes -> CKB
e Output checkboxes - OCKB
e Static output field > STXT

This separate field type for entering data allows you to define
input fields that only appear as display fields in the standard Properties dialog, that
is, they must not be changed after data has been entered.

e Output field -0

o Edit field >E

e Combination field (combo box) - COB
e Checkboxes -> CKB
e Output checkboxes -> OCKB
e Static output field > STXT
SINUMERIK*: SINUMERIK 810D

SINUMERIK 840D
SINUMERIK 840Di

PCU50 under Windows with SINUMERIK 840D sl
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Notes
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11.1 General

Central logbook

DNC features a central, cross-application error evaluation function.

Log messages (errors and messages; no traces) from all DNC applications

(DNC IFC SINUMERIK, DNC Cell, DNC Plant, auto archiving and auto import) are
entered in a central database table. Exceptions to this include applications such as
SerIntSvr (machine server) or DNCConvSvr (code conversion server), which do not
have an interface with the database.

All the errors and messages that have occurred for relevant events are stored.

The memory capacity depends on the type of database on which DNC is based:

Table 11-1: Memory capacity of the logbook:

[ Database type | Memory capacity | Behavior when capacity is exceeded \
SQLServer/MSDE 25.000 Delete the oldest 1000 entries
Oracle 50.000 Delete the oldest 1000 entries

Separate execution sequence log

An execution sequence log is stored in separate log files independent of the central
logbook.

11.2 Functions of the central logbook

In DNC or DNC Admin, you can view the error/message entries in the database.
You call this function from Tools > Logbook. You can configure the data view by
defining your own filters. You can delete errors/messages in DNC Admin and
export them to a text file.

The following activities are entered in the logbook:
Users logging on (system message)
Creation/deletion of users

Creation/deletion of NC data

Import/export of NC data

Download/upload of NC data

Setting/resetting of version zones

Result of auto archiving

Enabling of option packages

Etc.
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11.2.1 Displaying the messages

All of the messages and errors are displayed in chronological order in accordance
with the following structure:

T| Timeztamp | E rrornumber | Test I Statich l Application | AI
E 10102002 09:34.10 4 Eror ReadFilterColurmn Tarmnall DMC Admin

E 102002105508 -1 CFilterDigh ewr:UpdateFilter ReadFilterCal . Temnall DHE Adrmin

E 102002105508 -1 CFilterDigh eve:LpdateFilter ReadFilterCal .. Temnall DHE Admin

E 102002125252 3 Fehler beim echreiben in die KommentarD...  Temnall DHC

E 102002124947 2147217 InsertM CProglata ExecuteCommand Termnall DHC

E 02102002 12:49:47 -1 [atenbank- Fehler [Mewt CPog) Termnall DHC

E 102002124346 3 Fehler Eeim schreiben in die Kommentar-D...  Temnall DHC

E  [@B102002124314 3 Fehler Eeim schreiben in diz Kommentar-D...  Temnall DHC

E 102002122452 3 Fehler beim zchreiben in die KommentarD . Temnall DHC

E 25.03.2002 15:57:46 -1 Erar ReadFilkerColurmn Termntall DME Admin

Mo &09.2002 155628 0 logdata deleted DHC Adrmin o
E  &H09200215%:4922 -1 CFilterDig ewr:UpdateFilter ReadFilterCol...  Temnall DMC Admin

E  &H092002154922 -1 CFilterDigt ewr::UpdateFilter ReadFilkerCol...  Termnall DMC Admin

E 2092002154855 -1 Error ReadFilterColumn Termnall DHC Admin

E  2&09.200215%0713 -1 Error ReadFilterColumn Temnnall DHC Admin

E 2032002150643 -1 Error ReadFilterColumn Temnall DHC Admin

E 2092002145746 -1 Error ReadFilterColumn Termnall DHC Admin

F 2|09 2nn? 14-RE-R7? A Frrar BeadFiltar™ nlimn Termnall TN & Arnin .:.!

Clze l [lelete Ewmort | I" :_I Filter |

Fig. 11-1: Log file

Table 11-2: Logbook display
LED

Description

E/M/S
DD.MM.YYYY HH:mm:ss

Error / message / system message
Timestamp
Error number

Text Error text / message text
Station

DNC IFC SINUMERIK Application

DNC Cell

DNC Plant

DNC Station
Auto archive
Auto import

Note

You can sort the messages in ascending or descending order in accordance with
their individual meanings by clicking a column header.
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11.2.2 Filtering log data

You can call the Filter Editor by choosing Filter. All the filter functions in the editor
are available (see also: Section 3.2). If you have selected a filter, only the filtered
data is displayed.

11.2.3 Exporting errors/messages

In DNC Admin, the errors/messages in the central logbook can be exported to an
external text file where they can be processed further if necessary. The export file
created is located in ...DNC\Export.

The following requirements must be fulfilled for the export:
e The user must be authorized to export data.
e Afilter must be selected before data is exported.

Note
In the standard installation, the export directory is diverted to the import directory.

File name of the export file

The name of the exported error/message file is as follows: LogyyyyMMdd_x.TXT
(the index x is incremented by 1 if several export files are created on one day). The
first file is assigned index 1).

Structure of the export file

E|[2002-09-25 10:36:43.183000000|-1|Error ReadFilterColumn|DNC Admin|Terminall |

The columns in the error/message display are separated by the character | in the
export file.

A Caution

If the display in the log file is filtered, only the data displayed is exported.
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11.2.4 Deleting errors/messages

In DNC Admin, users can delete errors and messages in the central logbook
provided the following conditions are fulfilled:

e The user must be authorized to export data.

e Afilter must be selected before data is deleted.

Note

During the deletion procedure, all of the log data displayed is deleted.
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11.3 Separate execution sequence log

Independent of the central logbook in the database, the DNC programs write to the
circular execution sequence log files with the names Programmname0.trc ...
Programmname9.trc located in the ..\Siemens\MCIS\Data\Trace\DNC directory.
For each start of the program and when the log file has reached the configured
size, a new file with the next-higher number at the end of the file name will be
begun; after 9, the numbering starts again at 0. The current log file is the file that
has the most recent date.

Log files can be opened and analyzed with a text editor.

The log files of the individual clients are located on the terminal servers under the
directory ...\Siemens\MCIS\Data\Trace\DNC\Client.

The size (in KB) of the log files can be parameterized in the trace.ini file in the
..\Siemens\MCIS\Data\Trace\DNC directory.

The .ini file contains sections for all MCIS programs that should be logged.

Table 2-3: Example trace.ini

[GLOBAL]
Trace_Level=4
Trace_FileSize=32

[DNC_HMI]
Trace_Level=4
Trace_FileSize=32

[DNCAdmin]
Trace_Level=4
Trace_FileSize=32

[...] Section with program name
[DNC_HMI] = DNC program
[DNCAdmin] = DNC Admin program
Trace_Level Classification of the program execution for logging
All specified and lower classifications will be logged.
0= No execution sequence log
1-4 = Trace level of all program execution sequences

that should be logged. Execution sequences with
a lower trace level are also logged.
FileSize Size (in KB) of the log file
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12.1 Function of DNC Auto Archive

i DNC - C:\Siemens\MCISADNCATmp

File Edit ¥iew Options Machine Alignment Help

|@| $ R X E a7 || | =]
J.&ddress I
E MCIS | i | T_l,lpel Versionl Hele.l Length| Archivl
200 area gears MPF 1 1177 1
B MC programming system SFE 4 o ] 3
{1 automatic gear . 1
-l machie ] EMP 2 0 40018 0
machine 2
22 machine 3

ED manuel gear
machine 4

4 o 7
Fig. 12-1: List display with auto archive identifier

Note

The archive run can also be activated manually for a machine or machine group
via the operator interface.
See also: Section 4.5 > Archiving (manual)
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12.1.1 General

The auto archive function compares NC data in SINUMERIK* machines with that in
the DNC system and automatically downloads any differences to the DNC system.
On the SINUMERIK* side, DNC IFC SINUMERIK must be installed to enable the
auto archive function. The auto archive function also takes into account loaded NC
data in the SINUMERIK* NC data management system.

In addition to the main/subprograms and workpieces, all the other files on the data
management server and NC active data can be archived.

The Auto archive function downloads NC data and NC active data generated or
changed in the SINUMERIK to the DNC server automatically where it is archived.
This means that data generated or changed on the SINUMERIK (e.g. if
SINUMERIK data has been lost) is always available on the server.

Note
DNC Auto Archive is available for PCU 50/70, but not for MMC 103.

12.1.2 Auto archive ID

Archived files are assigned an auto archive identifier. The auto archive identifier
appears in the DNC list display in the Archive column (see Fig. 12-1).
The following auto archive IDs are supported:

Table 12-1: Auto archive ID

Auto archive ID Description

0 The file has not been archived or
archiving was set to 0 by the current archive run.

1 The file was the last one to be archived and is available
on the SINUMERIK. This program is the most up-to-date
version.

2 The file was archived in an earlier run, but is no longer
available on the SINUMERIK.
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12.2 Configuring the auto archive function

12.2.1 General

To configure SINUMERIK* machines for automatic comparisons and archive runs,
you have to set the Auto Archive checkbox for the machine in DNC Admin. The
upload directory is always the machine directory.

Comparison basis for the auto archive run

NC data in the machine directory in the DNC system whose auto archive
identifier is set to 1 or 2 is compared with the NC data in the machine directory on
the relevant SINUMERIK*. If a version with an auto archive identifier is not found,
released NC data at the search level in the DNC system is compared with the NC
data in the machine directory on the relevant SINUMERIK*.

The comparison takes place on the basis of the change date and the length of the
files to be compared.

For each machine, you have to configure which DM directories for the machine and
which file types in these DM directories are to be compared/archived.

Auto archive time

To define the times at which the auto archive/comparison run takes place, enter
DNC Auto Archive in the Windows task scheduler.

These configurations are explained in more detail in the following sections.
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12.2.2 Configuration in DNC Admin

12 Auto archiving

You can use DNC Admin in configuration mode to configure the machine

properties for the auto archive function.

Note

The user must be assigned the necessary authorizations for these functions.

See: User administration

Areal 5in840D
Configuration |

Conficuration file:

{mackine 5.MCF

Station:

EDIT

]

[Eattia dislag

1

Tranzmizzion module:

|SINLIMEF|IK 2400 ;l ¥ &uto Compare
W Ao drchive

Upload directony

;‘h machine 5 __‘:j
Yerzion Strategy For Upload

B

Diizplay group for ligt;

[ MLISTY

Search levels for HC data

7l

rl machine &

:.j

Ok,

Cancel

Help

Fig. 12-2: Machine properties in configuration mode

You first have to set the transmission module "SINUMERIK 840D ".
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Auto Compare / Auto Archive checkbox
If only the comparison function is required, activate the Auto Compare checkbox.

If you want to archive NC data on the machine in the DNC system, activate the
Auto Archive checkbox.

Note

Do not activate both the Auto Compare and Auto Archive checkboxes at the
same time because otherwise the comparison will be carried out twice before the
data is archived.

The upload directory is set automatically to Machine when you select Auto
Archive; the search level of the NC data for the machine can be changed as
required.

Special features of the NC data search level

The configured search level is machine specific. It determines the search levels at
which the system searches for NC data for the comparison.

Note

Workpieces are considered only in the machine directory. In the log database
and the log trace file , however, you are informed if a workpiece with the same
name is located within the search level. This prevents "half-finished" workpieces
from being generated in the machine directory, which would then result in
separate versions of the program being created.

The configuration is performed via a combination field. The following search areas
are available:

e Machine

e Machine, group (search area for machine and higher-level group)

Note

The upload directory must be located within the search level otherwise a new
version of the same program would be created each time data is archived.
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Special features of the auto archive function

If workpieces are included in the auto archive run, they are uploaded to the
machine directory even if the search level contains identical workpieces (but not in
the machine directory). The reason for this is that half-finished workpieces are not
created in the upload directory.

Depending on the version strategy (see "Configuration"), the archived NC data is
either released or not. Its version is then determined. To allow the auto archive
function to run without any user intervention, the "Delete Version Dialog" is not
displayed. The version strategy is, therefore, converted automatically from 2 > 1;
from 4 - 3 in the DNC Auto Archive function.

The configuration is performed via a combination field. The following directories are
available:

e Machine

e Group (upload directory: The higher-level group of the machine)

Note

DNC creates administrative data for uploaded files. All the automatic mechanisms
for version management and the release / trial cut identifiers in DNC apply here.

The auto archive run also sets the auto archive identifier of archived files to 1. If
the machine directory already contains NC data with the same name and type,
the auto archive identifier of this data may be reset to 0.

If the machine upload directory contains NC data that was not found on the
machine, the auto archive identifier of this data (which was previously released or
assigned auto archive ID 1) is set to 2.

The auto archive identifier for the NC data is only set/reset within the machine
directory because it could otherwise be set/reset by more than one machine,
which means that the assignment would no longer be clear.
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12.2.3 Configuration in the machine configuration file

General

DHDIR...

Machines should be configured in DNC Admin. To do so, enter configuration
mode in DNC Admin, choose the required machine, and open the Machine
Properties dialog. To fetch the required machine configuration file, choose
Edit. If this machine does not yet have a configuration file, you can create and
open one containing the standard parameters for the SINUMERIK transmission
module.

The [COMPARE] section is reserved for the auto archive. Here, you can specify
the DM directories that are to be compared with the DNC system during the archive
run. For each DM directory, you can also decide whether files in the directory are to
be archived in a pseudo workpiece with the workpiece name *.DIR and which file
types are included in the archive run. You can also exclude individual files in each
DM directory from the comparison and archive run.

The parameters in a DM directory are separated by means of ";".

Note

The auto archive function is station dependent, which means that only machines
in one particular station are compared and archived.

Here, you can define up to 30 DM directories for each machine (DHDIR1 ...
DHDIR30).

The numbering dictates the sequence in which the DM directories are compared
and archived.

The numbering can contain gaps.
Extract from machine configuration file:

DHDIR1 = MPF.DIR;0; MPF
DHDIR3 = SPF.DIR;0; SPF
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DM directory name

The first entry after the equals sign contains the name of the DM directory that is
to be compared/archived.

Extract from machine configuration file:
DHDIR1 = MPF.DIR;0; MPF

Note

If the DM directory contains another subdirectory, the subdirectory is not
included in the comparison/archive run.

Pseudo workpiece

The pseudo workpiece decision identifier is then set to specify whether or not this
DM directory is to be compared/archived in a pseudo workpiece. This is necessary
if the various DM directories to be archived contain files that have the same name
and type. Pseudo workpieces allow a clear association to be established with the
source directory of the data. They also prevent the number of versions from
increasing dramatically.

Pseudo workpieces can be identified by their name, which corresponds to the DM
directory (*.DIR workpiece ID)

Range of values:
0; FALSE : Files are sent directly to the upload directory

1; TRUE : Files are sent to a pseudo workpiece with the name of the DM
directory in the upload directory and the system searches for them in the DNC
system in order to compare them.

Extract from the machine configuration file:
DHDIR5 = CST.DIR;TRUE; AWB;COM;SPF
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File types

The pseudo workpiece decision identifier must be followed by the file types that are
to be compared/archived for this DM directory. The file types are also separated
with ";".

Note

Note that you can only select file types that are also entered in the DNC database
table DNCDATATYPE.

Extract from machine configuration file:
DHDIR3 = WKS.DIR;0; MPF;SPF;TOA;ZOA;RPA;WPL;JOB;BMP;ARC;INI

Excluding files

For each DM directory, you can specify files that are to be excluded from the auto
compare/archive run. The syntax comprises the key word: "EXCLUDE_" and the
DM directory.

Extract from machine configuration file:
DHDIR1 = MPF.DIR;0; MPF; CEC
EXCLUDE_MPF.DIR = Test; Test1

Test.mpf, Test.cec; Test1.mpf, and Test1.cec are excluded (provided that they
exist in the DM directory MPF.DIR).
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12.2.4 Backing up NC active controller data

NC active data

The auto archive function can only archive controller data that can also be saved in
a file in the file system at the operator interface. The Backup NC active data
function can be used to partially rescind this restriction.

Data that is located exclusively in the NCU/NCK is stored in a data archive that is
regenerated by DNC during each archive run and saved there in ASCII format. This
data, which cannot be entered individually (e.g. drive data or GUD variables), is
called NC active data.

During the auto archive run, a data archive containing the NC, PLC, and file system
data can be created prior to the archive run using a predefined subset. This archive
is stored in the archive directory of the data management system (ARC.DIR) and
archived too via the auto archive mechanism.

One archive file, which is created in the archive directory prior to the archive run,
can be defined for each machine. If it already exists, it will be overwritten.

An input file is used to define which data is included in this archive file.

Settings for this function must be made both on the controller and on the DNC
master computer.

This function allows you to create standard archive files.

You can define which sub-areas of the NC active data are to be taken into account
and then read and stored in the archive file via the DNC Cell/Plant auto archive
function.

This function is based on the service server interface (ARServer.EXE).

Note

You cannot create a series startup archive or an upgrade archive.

Important

The Backup NC active data of the controller function is realized only for
PCU 50.
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Creating the input file for the
auto archive run from the determined data

The PCU50 services function can be used to create the input file for generating an
archive manually.

You can use the Select button to select the required data areas (e.g. "Machine
data channel 1", "Setting data axis 2", and "Tool offsets").

An archive is then created "manually" ("Archive" pushbutton).

Once the archive has been created, an input file (ARCHIVXX.IN) in which the
parameters for creating this archive are entered is stored in the F:\tmp directory.
This file can now be copied 1:1 to the F:\add_on directory and, if necessary,
renamed to something more meaningful (e.g. NCACTDATA.IN). This name must
be entered in the ARCJOB parameter in the appropriate machine configuration file
(see also: Section 10.4.5 - Configuration dialog for the SINUMERIK* connection

type).

Note

If you have any further questions about the services server, contact the hotline.

Services CHAN1 JOG Ref
KHB_TEST.MPF

Program aborted

. Channel reset

8022 : Option "activation of more than 768kB SRAM' not set m
Programs/data: SOURCE \NC_ACT.DIR
Name |Type | Loaded | Lenglhl Dﬂlel Enﬂblel _
= Archive DIR 1970572005 X ~| LRS232C
e NC-active-data DIR 061172002 X
& Machine-data DIR X 01/01/1980 X _
- Meas.-system-error-comp. DIR X 0170141980 X
@ Option-data DIR X 010171980 X [FE
-7 Protection-zones DIR x 01/01/1980 X
{85 Quadrant-error-compensation DIR bt 0170141900 » _
| R-variable DIR X 017011980 X Disk/
- Setting-data DIR X 01/0171980 X Card
i} Tool/magazine-data DIR X 0170141980 X
- User-data DIR X 01/01/1980 X _
. Wark-ofisets DIR X 017011980 % Archive...
SE| Initialization-program-({INI) INI X 0 017011980 X
WE Sag/angularity-complete INI X 0 0170171980 X _
| Part-programs DIR X 0170141980
| Subprograms DIR X 0170141980
I User-cycles DIR X 0470372004 X =l

Free memory: Hard disk :  2.970,134,528 NCU : 148,680

Job is ready
Data out Data
selection

Fig. 12-3: Dialog for selecting data areas
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Settings on the master computer

Settings on the master computer can be made on the Job Archive Server tab
page (SINUMERIK* machine configuration) in the configuration dialog for the
SINUMERIK* connection type (see also: Section 10.4.5 - Configuration dialog for
the SINUMERIK* connection type).

Controller settings

Data that is located in the NCU or in the controller PLC only and that cannot be
loaded to the hard disk without an archive file being created should also be backed
up using the auto archive function.

This includes data from the following areas:

GUD data (Global user data)
TEAdata (Axis machine data)
R parameters

Work offsets

Compensation data

Option data

Setting data

You are advised not to back up all of the data in the areas above. Instead, only
data that could change during operation should be backed up in an archive file.
Data generated automatically by setting devices or tool offsets does not need to be
backed up.

Data that has a fixed directory on the hard disk of the controller and that, if
necessary, can also be loaded from the NC to the hard disk does not need to be
backed up in this way either. It is better to archive this data via the standard auto
archive function for unpacked data. This includes the following data and directories:

MPF.DIR (part programs)
SPF.DIR (subprograms)
WCS.DIR (workpieces)
CUS.DIR (user cycles)
CMA.DIR (manufacturer cycles)
CST.DIR (standard cycles)
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12.2.5 Start parameters for auto archive

The auto archive function has two start parameters.

ONLYCOMP

This parameter determines whether the setting for the machines is to apply for the
archive run, or whether the archive run is to be skipped and just the comparison
carried out.

Without the start parameters, the archive function is carried out depending on how
the machine has been set.

When the "ONLYCOMP" start parameter is set, only the comparison function is
carried out on all the machines for which "Auto Compare" is configured, regardless
of whether the "Auto Archive" function is also configured.

Call:
DNCAArch.exe ONLYCOMP

SHOW_FILESONDNC

This parameter determines whether the NC data found in the DNC system only is
to be displayed in the comparison results.

Without this parameter, this NC data is not displayed in the comparison results
because it is usually of little relevance for the auto archive function.

This NC data is displayed if the start parameter "SHOW_FILESONDNC" is set.

Call:
DNCAArch.exe SHOW_FILESONDNC
DNCAArch.exe ONLYCOMP SHOW_FILESONDNC
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12.2.6 Starting the auto archive function automatically

The Windows task scheduler (service: Task Scheduler) can be used to start the
auto archive function automatically at set times.

To do so, the task scheduler must be running and AT commands must be used
to determine at what times DNC Auto Archive is to be started.

Example:
C:\> AT 01:00 /every:Mo,Tues,Wed, Thur,Fr,Sa,Sun "C:\Siemens\MCIS\DNC\DNCAArch.exe"

Auto Archive started each weekday at 01:00 a.m.

C\> AT
Shows the list of scheduled commands:

Status ID Day Time Command row

1 Every Mo Tues Wed Thur Fr...01:00 AM  C:\Siemens\MCIS\DNC\DNCAArch.exe

Note

For more help on using the task scheduler, see the Windows help function
(Start>Help and Support) under: Task scheduler - at command (scheduled
tasks and the AT command).

The activation can also be started under Insert Control Panel / Scheduled
Task.
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12.3 Comparison results

When the auto archive run is started, it creates or replaces a file with the
comparison results for each archived machine. These files are located in the DNC
data directory in the CmpResult, with the name of the machine and additional
"_AArch.txt" attachment.

The files are in English.
The files contain the following information:

1. Group and machine name (below each other)

2. Date (at start and end)

3. An area entitled "NC Data in machine only" in which files are listed that were
only found on the machine.

4. An area entitled "different NC data" in which files on the machine are listed
that differ from those in the DNC system.

5. An area entitled "NC Data in DNC system only" in which files are listed that
were only found in the DNC system. This section is created with only the start
parameter "SHOW_FILESONDNC". The NC data located in this section and in
the upload directory is assigned the auto archive identifier "2".

6. The final result is specified at the end. This indicates whether errors occurred
during the auto archive run and how many files were archived. If no errors
occurred and this machine has been configured for archiving, all the above
files must be archived. This means that no differences are found during the
next DNC auto archive run provided that the data on the machine has not been
changed again by this point.

12.4 Tracking auto archive actions

Since the auto archive function does not have a user interface, its progress can
only be tracked via the central logbook.

The comparison results can also be used for this purpose. Note that these are
regenerated at the start of each auto archive run, which means that no history
function is available. The system always displays the last actions for each machine.

SINUMERIK*: SINUMERIK 810D
SINUMERIK 840D
SINUMERIK 840Di
PCUS50 under Windows with SINUMERIK 840D sl
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1 Introduction

1 Introduction

The DNC IFC SINUMERIK software is used to connect CNC machines with
SINUMERIK* (PCU50/70 and MMC103) to the NC program management DNC
Plant or DNC Cell via the Ethernet network.

DNC IFC SINUMERIK provides user interfaces on the SINUMERIK operator panel
to request NC data, such as NC programs, workpiece data (e.g. in graphical form)
from the DNC Cell/Plant archive. NC data, e.g. optimized NC programs, can also
be uploaded to the DNC archive.

In this way, any required NC data and information (also in graphical form) is
available quickly and up-to-date on the SINUMERIK.

DNC Cell/Flant

Ethernet

- =%

SINUMERIK 840D/840Di/810D/840Dsl

Fig. 1-1: SINUMERIK with DNC IFC SINUMERIK connection to DNC via an Ethernet
network

SINUMERIK*: SINUMERIK 810D
SINUMERIK 840D
SINUMERIK 840Di
PCUS50 under Windows with SINUMERIK 840D sl
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Notes
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2

2 System requirements on SINUMERIK

B B P10 V7= 1< TP 2-8

2.2 SOfWATIE ... e e 2-8
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2.1 Hardware

DNC IFC SINUMERIK can run on SINUMERIK* with the following hardware:

e PCU 50/70 with OP 010/012/015, TCU, HT8
e MMC103 with OP 031/032

and additionally:

- PCI/ISA adapter

- Ethernet network interface

2.2 Software

The following SINUMERIK software is required for DNC IFC SINUMERIK:

¢ HMI software as of SW Version 6
under Windows NT/XP on PCU 50/70
¢ MMC software as of SW Version 4.04.17

(only possible on request for a specific project)
under Windows 95 on MMC 103

Note

There are function restrictions when using MMC 103 (e.g. no archiving, no quick
filter).

SINUMERIK*: SINUMERIK 810D
SINUMERIK 840D
SINUMERIK 840Di
PCU50 under Windows with SINUMERIK 840D sl
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3

3 Operator interface

3.1 User interface of DNC IFC SINUMERIK on the SINUMERIK ......... 3-10
3.2 Structure of the user interface ...........ccoccoiiiiii 3-11
K B 1Y o1 = | S 3-11
3.2.2 Refreshing the displayed NC data.............cccoociiiiiiiiiiiiniieeee 3-14
3.3 ONlNE NEIP e 3-14
3.4 LanQUAGgES .. ..o 3-14

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition FBDN2/3-9



DNC IFC SINUMERIK - Downloading NC Data via a Network (FBDN2) 05.07

3 Operator interface

DNC IFC SINUMERIK is integrated in SINUMERIK HMI and can be called via the
DNC IFC function key.

3.1 User interface of DNC IFC SINUMERIK on the SINUMERIK

The following basic user interface is available:

FBDN2/3-10

DNC administration

to display the NC programs available in the DNC archive DNC Cell/Plant and
to download the NC data to the SINUMERIK

Data management

to display the NC programs available in the SINUMERIK data management
and to upload the NC data to the DNC archive DNC Cell/Plant

Logbook

to display, for example, NC program downloads as well as various system
messages

Filter

to select and change filters for the NC data in the DNC archive DNC Cell/Plant

© Siemens AG 2010 All Rights Reserved
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3.2 Structure of the user interface

3.2.1 General

Structure

Header (1)

; 1
DNC IFC  [CHAN1 Jog |Loco {1}
Channel reset {4}
Program aborted Detail
Contents of DNC - machining centre/motor 2) Group +
= DMC Source 7 MC-Program name
(3} |F'r0gram narne I: I (8)
Hame | = | Type | Werzsion | Fiel.. | Trialzutid | Length | Group -
4-valve-colinder-head MPF 3 1 ] 74490
clamping setup =GR 1 1 0 4008
Scus iR Machine
cub-affeycle SPF 4 1 0 710
cylindertheadB45 = MPF 2 1 ] 1792 Change
divinggear3368 * MPF 2 1 0 1733 Transfer
fire-grinding-cycle SPF 4 1] 1] E720 Dest.
kepwav-miling-cycle SPF 4 0 0 455
Delete
1] | i
Target in Data Management ‘a’ Free Space Tr::sfer
[/ork pieces\mator 13464052 Byte

Transfer

Logbook Filter

LU S| Management

Fig. 3-1: DNC IFC SINUMERIK user interface

The DNC Administration screen is divided into the following areas:
(1) SINUMERIK HMI header

(2) Title bar

(3) DNC IFC SINUMERIK screen contents

(4) Vertical softkeys

(5) Horizontal softkeys

(6) Message line

(7) Transfer direction

(8) Quick filter

The header is part of the SINUMERIK HMI. The most important machine states,
the status of the NC and alarms from the alarm server are displayed here.
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Title bar (2)

The title of the respective screen window is displayed in the title bar. The NC data
storage structure of the machine in the DNC archive is also displayed. In the above
example, the data is managed in the DNC archive in the area motors group, of the
group 6 cylinders subgroup and the machining centre machine.

Note

The NC data structure of the machine is performed in the configuration program
(DNC_IFC.INI) on the PCU 50/70 / MMC 103.

Screen contents of DNC IFC SINUMERIK (3)

The contents consist of a source and target area. The data management of DNC is
always displayed in the upper part of the screen; depending on the screen, it is the
target or the source.

DNC IFC SINUMERIK has two views of the NC data available in the system:

e DNC administration

e Data management

The selected NC programs can be downloaded via softkeys.

Further functions can also be selected via softkeys:
e Logbook

o Filter

e Detail view of NC data

Message line (6)

Error and operation messages (e.g. for the download) are displayed in the
message line.
The i icon is on the right to call the online help.

Transfer arrow (7)

A direction arrow is displayed at the interface between the upper and the lower
screen areas which indicates the direction for the transfer of the NC data.

Quick filter bar (8)

The quick filter function allows you to change a filter value without having to call up
the filter selection.

Once you have selected a filter, the first filter condition of the current filter is
displayed in three fields in the toolbar area. The first two fields contain the field
name and operand, while the third field, which can be edited, contains the current
filter condition value.
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Note

The value of the filter condition is treated in the same way as a value with a
wildcard, although the wildcards are not displayed in this field.

Examples:

Program name = A

means that the system filters according to program names that contain "A"
e.g. Program1, Appl_1, 135_A_ xzy

Program name = A*
means that the system filters according to program names
that begin with "A"

e.g. Appl_1
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3.2.2 Refreshing the displayed NC data

During active system operation, new NC programs are accepted, released,

deleted, etc. in the DNC archive by NC programmers. In order that these changes

in the DNC archive are also displayed in DNC IFC SINUMERIK, the display is

refreshed:

¢ Automatically when DNC IFC SINUMERIK is switched to the foreground

e Cyclically when this has been set in the configuration user interface. The time
between the last operator action and the first refresh as well as the time
between two refresh cycles, can also be set.

3.3 Online help

The online help for operator support of the DNC IFC SINUMERIK software can be
called via the Information key. The online help contains information on the current
operator control screen as well as on the system operation.

3.4 Languages

If the language is changed on the controller, DNC IFC SINUMERIK automatically
adjusts to the new language when the language is available for DNC IFC
SINUMERIK.

DNC IFC SINUMERIK is supplied in the languages: German, English, French,
Spanish, Italian, Chinese and Russian. The online help is available in the
languages: German, English (for English, Chinese and Russian DNC IFC
SINUMERIK), French, Spanish and Italian.
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4 Functions

4.1 Connection to DNC Cell/Plant

DNC IFC SINUMERIK is used to access NC data that is archived and managed in
DNC Cell/Plant. DNC IFC SINUMERIK allows the user to download or upload NC

data via an Ethernet network from the controller.

4.2 NC data download from DNC Cell/Plant to the SINUMERIK

4.2.1 View of the data management of DNC Cell/Plant

General

A
DMC IFC  |[CHAN1 Jog MPFD
Channel reset .
Program aborted Detail
Contents of DNC --- machining centre/motor Group +
— DMC Source 7 MC-Program narne
|F'rogram narme |= |
Mame | £ | Type | Version | Rel... | Trialcutid | Length | Group -

4-valve-cylinder-head MPF 3 1 ] 430

clamping setup = BMP 1 1 0 40018

EcusoiR Machine

cut-off-cycle SPF 4 1 0 710 :

cylinderheady'545 = MPF 2 1 i 173z

drivinggear3368 # MPF 2 1 0 1793

fine-grinding-cycle SPF 4 i} i] E730

SPF 4 a ] 455
Delete
4| J =
Target in Data Management ‘ Free Space Tr::sfer
|W'orkpieces\motor 13484032 Byt

Transfer

Data
Management

Fig. 4-1: DNC administration

DHC
Administrat.

Logbook Filter

The DNC Administration screen provides the machine operator with a user
interface to view the available NC programs and for the NC data transfer.
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Selection of the hierarchy level of the plant topology in DNC

Source

Target

In the DNC Cell/Plant archive, the NC data can be stored in several hierarchy
levels (group, subgroup, machine, etc.) depending on the plant topology. You can
navigate on these hierarchy levels with the relevant vertical softkeys and display
the NC data of this hierarchy level and the ones above.

The hierarchy affiliation of the NC data in the plant topology of DNC Cell/Plant is
documented in the * column. The following assignment applies:

Table 4-1 Assignment of the NC data in the DNC plant topology

* column Description
Machine

* Group

** Higher-level group

In the upper area of the screen, NC data is displayed in the form of a tabular list
view, which is available on the higher-level DNC Cell/Plant for the SINUMERIK.
The list displays all the available NC data and workpiece directories of DNC in
alphabetical order.

Table 4-2 Identifiers of the DNC data management in DNC IFC SINUMERIK

Identifiers Description

Symbol for NC data

ﬂ Symbol for workpieces / pseudo workpieces

The standard download target is displayed in the lower part of the screen.
Depending on the configuration of DNC IFC SINUMERIK, the download is
performed:

o With the Transfer softkey (target in file system)

or

o With the Transfer & load softkey directly into the NCK (target in NCK).

Except for workpieces and pseudo workpieces, the target path results from the NC
data type.
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4 Functions

4.2.2 NC data transfer (standard)

NC data can be selected in the source area and downloaded to the SINUMERIK.

The NC data can be:

e Stored on the operator panel with integrated PC (PCU or MMC) (Transfer

softkey)
or

e Loaded directly into the NC area (NCK = NC kernel) (Transfer & load

softkey).

The preset download target, file system or NCK, can be changed when the select
key Change transfer target (configurable on the configuration user interface) is

available.

Individual NC data files from the DNC source are downloaded to the relevant type
directory of the data management. NC data that belongs to a workpiece is also
downloaded to the relevant workpiece directory in the controller, irrespective of
their data type. Copying procedures in progress are displayed in the message line.

Table 4-3 Correlation between the NC data type in DNC and the target path of the file system or the NCK

NC data file type in DNC

Target directory in the file system or in the
NCK )*

.MPF Part programs
.SPF Subprograms
.ARC Archives

NC data in workpieces Workpieces

)* If no pseudo workpiece has been defined. Files from pseudo workpieces are downloaded to the
respective data management directories of the same name.

If a type conversion is configured in the DNC IFC SINUMERIK configuration user
interface, the file types for the download to the file system or NCK are changed in
accordance with the conversion tables.

The download from DNC to the controller is performed irrespective of the plant

topology in DNC.

FBDN2/4-18
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4.2.3 NC data transfer (with change of target, name, type)

General

4 Functions

DHC IFC  |[CHANI1

Jog

MPFD

Channel reset

Program aborted

Trangfer from DMC to --- machining centre

=DMC Source
Mame | il | Type | Yerzion | Rel... | Trialcutid | Length | |
cylinderheadvE45 MPF 4 i 1] 455
<] | H
(& MMC/FCU Mame | Tvpe | L] Length | Changed
-~ drchive 4valve-cylinderhead MPF 7492 21.11.2000
B3 Part-programs 2] 4-valve-cylinder-head MPF 104 21.11.2000 BN
~E7 Subprograms . Transfer
prog clamping setup WP motor EMP 40018 21.11.2000 Dest.
B4 Worknieces B cut-cff-cycle SPF * 21.11.2000
<
Directory Target file name Type LG
|m0t0r IC}'|indBlhBad\-"545 IMF'F j
= Transfer
IS management | o950k

Fig. 4-2: Downloading NC data to a selectable target of the SINUMERIK (a workpiece

directory in this case)

The following can be performed during the transfer with this function (Transfer to

softkey):

e The name of the target file can be changed.
o The type of the target file and the target directory can be changed.
e The NC file can be stored in a workpiece directory.

¢ Changing of the workpiece name in the target system.

The NC data can be downloaded to the file system and also directly into the NCK
as with the standard download.

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition

FBDN2/4-19



DNC IFC SINUMERIK - Downloading NC Data via a Network (FBDN2) 05.07
4 Functions

4.2.4 Delete

With the Delete softkey, NC data files that have not been released can be deleted
from the DNC Cell/Plant archive when the user has the appropriate rights.

\
DMC IFC  |[CHAM1 J
29 |MPFo
Channel reset i
Program aborted Detail
Contents of DHC --- machining centre Group +
— DMC Source N
|F'rogram narne | | _
Mame * | Type | Wersion | Rel.. | Length Group -
=
Flasasa = MPF 1 1 47
Flazaza = MPF 2 1 47 Machine
Flasaza * OMPF 1 0 47
ﬂ blablabla * MPF 1 a 4] i
3 i ange
# Bohrungen_Aufhangung_122 SPE 1 a 1541 Tracarer
ﬁ KHETS MPF 1 a 54 Dest.
FKHBTEST Datum - MPF 1 1 0 |
ﬂKHﬂTEST x 2 MPF 1 Q 54
g Delete
ﬁ KHEBTESTZ MPF 2 a 54 &
ExuatEsT2 MPF A n Ad
Target in Data Management * Free Space
['aa P 13434032 Byte
Cancel,

Delete

Logbook Filter

LUl e 8 Management

Fig. 4-3: Delete NC data
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4.3 NC data upload from the SINUMERIK to DNC Cell/Plant

4.3.1 View of the data management

General

Target

Source

A
DHMC IFC  |[CHAM1 Jog MPFD
Channel reset
Program aborted
Contents of data management --- machining centre Group +
— DML target
Target in DMC _
Imachining CEte Group -
l_-_'_=5‘ MMC/PCU Mame I T_l,lpel LI Length I Changed 7
LB Archive 44/ALVE-CrLINDER-HEAD MPF 14 1040142002 BAAEhINS
g P ait-pregiams CrLIMDERHEADWEAS MPF 490 281142000
o Subpm_grams DRIVINGGZARIIES MPF 74490 281142000
25 Workpieces
i1 GEARWPD
1 MCASING. WPD N
-3 MO™ORWPD Select all
I‘=_“I MO~ ORBLOCK.WFI
82 YMOTORMWPD [
Transfer
to...
. |
Transfer
DHC -
Administrat. 5] Lot [llizD

Fig. 4-4: Data management

The Data Management screen provides the machine operator with a user interface
to view the NC programs available in the SINUMERIK and for the NC data upload.

In the upper area of the screen, the target in the DNC Cell/Plant archive is
displayed.
This target area (group, machine) is set in the configuration user interface.

The lower area of the screen contains the contents of the data management in a
tree view and list view.
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4.3.2 NC data upload (standard)

NC data (e.g. optimized NC programs) can be selected in the source area and
uploaded to the target area of the DNC Cell/Plant archive.

This target area (group, machine) is set in the configuration user interface.

NC data that belongs to a workpiece is also uploaded to the relevant workpiece
directory of the configured hierarchy level (group, machine) in the DNC archive,
irrespective of their NC data type.

NC data from data management directories for which a pseudo workpiece is
configured in DNC, is uploaded to the relevant pseudo workpiece.

If a type conversion is configured in the configuration file, the file types for the
upload to the DNC are changed in accordance with the conversion tables.

The copying procedures in progress is displayed in the message line.

Before an NC data file is uploaded, a check is made to determine whether the
maximum number of versions of this NC data has already been reached in the
DNC archive. If this is the case, an automatic deletion is performed before the
upload or the Versions Deletion dialog is activated and the user prompted to
delete one of the available old versions, depending on the version strategy. After
the deletion, the operator can decide whether to continue with the upload or cancel
it.
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4.3.3 NC data upload (with change of target, name, type)
.\

DNC IFC  [CHAHM1 Jog MPED

Channel reset

Program aborted

Retransfer to -— machiming centre Group +
I Hame | * | Type | Yersion | Rel... | Trialcutid | Length | -
SADFRE Group -
_':] FINE-GRIMDING-CYCLE SPF 7 1 0 3528
H FINE-GRIMDING-CYCLE SPF 4 0 0 2520
?‘ keyaw ay-milling-cycle SPF 4 1 0 576 Machine
WMB.DIR
LEMOTOR
Fdwor nie
Default target for DMC
Directory Workpiece z Taget file name Type
[Maschire? MOTOR | [wPD x| Smm—
n4_‘1.".»"-\L\J"E_CYLII"JDEFLHE.ﬁD WPF T4B2 17.03.2005 _
HCUT_OFF_CYCLE SPF 38 17.03.2003 Screen

back

General

Transfer

DHC
Administrat. § 5100 (S0
Fig. 4-5: Uploading NC data to a selectable target in DNC (target workpiece MOTOR in this

case)

Logbook

The following can be performed during the transfer with this function (Transfer to
softkey):

e The name of the target file can be changed.

o The type of the target file and the target directory can be changed.

e The NC file can be stored in a workpiece directory.

The NC data upload can be performed at an arbitrary position in the plant topology
(group, machine).

Changing the workpiece directory via an entry field in the target directory

With a new workpiece, this does not exist in the plant topology of the DNC- archive
and is not displayed in the list view. The new workpiece name must be entered.
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4.4 NC data detail view

A
DHC IFC |[CHANM1 JOG MPFO
Channel reset
Program aborted
Detail General --clamping setup.BMP Ei::zll
~DNC
Hame |clamping setup Type IBMF’ 'I Hersion |1 Detall
Additioral
Length IdDmB Loadcounter |2 Lastload |2'| 11.0011:20:14 _
Detail
Commert
¥ Felease-IN ™ Triglewt- 1D _
Shioww
Developer [Semen: Develdate [210933 154207 ﬂ
Modifier | Woridate |
Administator [=rea molor Admindate | S
“Workpiece | Cancel
DHC Data
LD Management] LoObook

Fig. 4-6: Detail dialog

General

In addition to the program name for each NC program there is further
administration/detail information that can be displayed in DNC IFC SINUMERIK.

The screen structure is user-dependent as for DNC Cell/Plant. The screen
description is managed by DNC Cell/Plant.

The Detail dialog can contain up to four detail screens that are called via the
vertical softkeys.

The administration information that has been released for editing, can be changed.
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Display graphic

4 Functions

Graphics, such as graphical information for the workpiece machining, can be

displayed via the Display graphic softkey.

DNC IFC

CHAN1

Jog

Channel intermupt

Program aborted

Graphic for DNC IFC SINUMERIK -

Fig. 4-7: Display of a graphic in the detail view

Note

Graphics can only be displayed with PCU and access via network drives (not in

conjunction with FTP protocol).

All graphic types that are supported by the Internet Explorer can be displayed
(e.g. BMP, JPG). Further graphic types can be displayed when the appropriate
plug-ins are installed. The graphic types must be entered in the configuration user
interface.
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4.5 Filter function

The filter function provides the user with a filtered view of the DNC Cell/Plant
archive. When the filter is activated, the user only sees the data that corresponds
to the filter conditions.

Note
Filters for DNC IFC SINUMERIK are created and assigned in DNC Cell/Plant.

In the DNC Administration and Data Management screens, the following filter
functions are available via the Filter softkey:

e Filter on/off
e Edit current filter
e Filter selection

DNC IFC  [CHAN1 b -

Channel interrupt

Program aborted

Setting for DMC IFC SINUMERIK --- machining centre

—DMC zetting kT4 | MPF Filter
Filter
OO

Edit
Curr. Filter
| B
Select
Filter
DHC Data

Administrat. | Management Loghook Logoff

Fig. 4-8: Filter settings
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Switching filter on/off

The name of the current filter is displayed below the header line in the Filter
screen.

The filter symbol indicates whether the filter is switched on or off

v 7

Filter switched on Filter switched off

The current filter can be switched on or off via softkey (F3).

Edit current filter

L
DMC IFC  |[CHAN1 | Jog |MPFD
Channel interrupt
Program aborted
Edit current filter of DNC IFC SINUMERIK --- machining centre
r DMC filter dialog MPF-Filter _
Release ID - 1 . —
Develdate = 11.07.01
[0 Ceveldate = 11.07.01 09:43:53 _
Change
Accept
changes
Field narne Operand Yalue Cancel
|Programmname % j s

DHC
Administrat. | Management

Fig. 4-9: Dialog for changing a filter

Logbook

The Filter dialog displays all the filter criteria of the current filter. Activated
checkboxes in front of the filter criteria indicate the active criteria.

The respective filter criterion can be activated or deactivated via the checkbox.
Operand and value of the respective filter criterion can also be changed with
Change and Accept changes.
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Directly editing filter criteria

It is possible to directly edit filter criteria in the relevant screen line without having to
use Change and Accept changes. Which criteria can be directly edited is
indicated in the * column (* in the line of the respective filter criterion means that it
can be directly edited). Two preconditions must be satisfied for this:

1. The following parameter must be set in DNC_IFC.INI:
[GLOBAL]

FilterInlineEdit =1
2. The Editable button must be activated in DNC when creating the filter
criteria.

If the first criterion is not satisfied, the * column is not displayed.

Note

Expansions or deletions of filter criteria are not performed in DNC IFC
SINUMERIK, but in DNC Cell/Plant.
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Filter selection

DNC IFC  [CHAN1 Jog :IPFI]

Channel interrupt

Program aborted

Filter zelection of DMC IFC SINUMERIK. - machining centre
— DML filker

Filker Mame: I
*Machine2 / DMC

Filter_3878

Filter 4711

FA PF-Filter
SPF-Filer

Cancel

shows only MPF-Files

DNC Data
Ll DT S Management

Fig. 4-10: Filter Selection dialog

Logbook

All filters available for the machine and user are listed in the Filter Selection dialog.
The message line contains a comment on the selected filter.

Note

If a filter is marked with *, this is a machine and user-specific filter. The filter name
contains the machine and user name for which this filter is valid.
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Quick filter

= DMC Souce 7 MC-Program name

|F'n:ugram name |= |

Fig. 4-11: Quick filter

The following precondition must be satisfied for the quick filter to be displayed:
The following parameter must be set in DNC_IFC.INI:
[GLOBAL]

Quickfilter =1

The quick filter function allows you to change a filter value without having to call up
the filter selection.

Once you have selected a filter, the first filter condition of the current filter is
displayed in three fields in the toolbar area. The first two fields contain the field
name and operand, while the third field, which can be edited, contains the current
filter condition value.

If another condition is to be displayed in the quick filter, the order of the conditions
must be changed in the filter editor of DNC Cell/Plant.

Note

The value of the filter condition is treated in the same way as a value with a
wildcard, although the wildcards are not displayed in this field.

Examples:

Program name = A

means that the system filters according to program names that contain "A"
e.g. Program1, Appl_1, 135_A xzy

Program name = A*

means that the system filters according to program names
that begin with "A"

e.g. Appl_1
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4.6 Logbook

4 Functions

1]

Y
DHC IFC | [CHAM1 Jog MPED
Channel interrupt
Program aborted
Logbook of DMC IFC SIHUMERIK ---
DMC logboak:
Type | Date | MHurmber | Meszzage text il
&l 3006.200317:3514 0 Mumber of files copied DMC->MMC: 0 von 1 —l
b 30.06.200317:3308 O Tranzterring file: <ABCDEF_1.MPF>
&l 0062003173306 0O Mumber of files copied DMC->MMC: 0 von 1
& 0062003173256 O Tranzterring file: <ABCDEF_1.MPF:

Fig. 4-12: Logbook

General

LT

The logbook contains all the errors and messages that were displayed in the
message line with data and time. This enables operations such as downloads,
uploads, deletions, user logins and logouts, etc. and any errors that have occurred,

to be traced.

The logbook can be displayed from any screen via the Logbook softkey.
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4.7 Login

General

DNC IFC SINUMERIK normally starts with an automatic login, i.e. work is

performed with the user and his/her rights that are entered in the configuration file.

Further options for the login can be set.

o [f different users with different rights are to be able to log in, this must be set
manually in a Login dialog.

e ltis also possible to work with the user rights that correspond to the current
protection level of the SINUMERIK or the key-operated switch position.

The login procedure (automatic or manual login) can be set in the DNC_IFC.INI

configuration file or via the Configuration dialog.
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5.1 General

The settings of DNC IFC SINUMERIK are configured using a configuration
program. This is started in the Windows service mode of the SINUMERIK 840D
with PCU50 at f:\Add_on\DNC_IFC, or with MMC103 at c:\Add_on\DNC_IFC, by
double-clicking the DNC_IFCCFG.exe file. The configuration performed with the
configuration program is then stored in the DNC_IFC.INI configuration file.

Example of a DNC_IFC.INI configuration file

MCIS DNC IFC SINUMERIK V2 - initialization file
"DNC_IFC.INI"

This file can be customized with "DNC IFCcfg.EXE"

[GLOBAL]

; Higher-level database type

; (0 = MSDE/SQL Server / 1 = Oracle)
DataBaseType =0

; TRACE 1-3 can be activated for a detailed recording
; Only change temporarily during troubleshooting!
TRACE =1

; IP address or DNS name of the higher-level DNC server
DNC-HOST =MCISDNC2

; Use FTP protocol
; (0=No / 1l=Yes with local DNC_IFCDB / 2=Yes with remote DNC_IFCDB)
FTP protocol =0

; File type change
; (Y=0n/N=0Off)
; Note: DrivelInternPath cannot be set to 1 or 2 if
; DataTypeChange=Y

DataTypeChange =N

HWSystem =32

; Default transfer target switchable via Select softkey
; (Y=Softkey available / N=Softkey not available)
ToggleSK =Y

; Default transfer target

; (MMC=Transfer to MMC / NCK=Transfer to NCK)

; Switchable via softkeys (MMC_NCK=Transfer to MMC or NCK ->
ToggleSK=Y set)
DefaultTransfer =MMC NCK

; Standard directory when starting DNC IFC:
; (0=Machine / 1=Group / 2=Higher-level group)
StartupLayer =0

; Job interfaces mode
; (0=Interactive / l=Automatic)
AuToDownLoad =0

; Time in minutes after which an unfinished job is deleted
DeleteTime =60

AutoResolution =Y
SwitchLanguage =
; FontName =Arial Unicode MS -> only relevant for languages with
special characters (such as Russian, Chinese)
FontName=

; 0 = Do not overwrite, 1 = Overwrite

; The check as to whether an NC program is already available only functions
correctly with DriveInternPath = 0

OverwriteNCData = 1
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[FTP]
; FTP parameters (only for FTP protocol = 1/2) relevant.
FTP-HOST =DAISY
FTP-User =A99399958D9895928F
FTP-PW =A98CA48E93A092C79EA8A18E8FD59A96A1A696

; Transfer mode (1=ASCII/2=Binary)
FTP-Mode =2

[DcoM]
; DCOM configuration: Login
DOMAIN =DNC_DOM
USER = John Do
PASSWORD = A98CA48E93A092C79EA8A18EB8FD59A96A1A696

[REMOTELOGIN]
REMOTELOGIN=0

[PATHS]
; Path names without final backslash
MMCIniDrive =F:

; Data directory of MCIS DNC for access to the NC data
; The drive specification must be from the DNC IFC viewpoint
; Either connected network drives (1.) can be specified
; or computer and path in UNC notation (2.) When using
; FTP (3.), the path must be specified in the notation required
required
; by the FTP server
; (1.) N: 1Is connected to DNC\Data on the MCIS DNC server
;WorkPathDNC =N:
; (2.) TUNC notation
;WorkPathDNC =\\DAISY\DNCS\Data
; (3.) Path specification for the FTP server
;WorkPathDNC =/DNC/Data
WorkPathDNC =\\DAISY\DNC\Data

; DHSTempPath for the temporary storage of files during transfer for
; DHS server and FTP. If DHSTempPath is empty, the content of the
Windows
; environment variable %TEMP% is used.
DhsTempPath =

; DriveInternPath for DHS Open
; (Values: 0= Do not evaluate file header / 1= Evaluate first header
/ 2= Evaluate all headers)
; Caution: If DataTypeChange=Y -> DrivelInternPath cannot be set to 1
or 2
DriveInternPath =0
; If DriveInternPath =2 and DIPNoWP =1, then the file compiled ;from all
workpieces in the upload directory, is not stored in ;a workpiece, but
directly in the upload directory.
DIPNoWP=1

[FILES]
LogFile =DNC_IFC.log
ErrLogLen =10

[MACHINE]
; Station name in MCIS DNC
MACHINE = PCU50_840D

; Path for upload
; 0= Machine / 1= Group / 2= Main group
DefUpload =0
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[USER]

Define the type of login:
dialog, Name= and Password= is used

0= No

1= User and password must be entered

3= Login with parameter ACCESSLEVEL= assigned user or dialog

Login

; 2= Login with parameter ACCESSLEVEL= assigned user

; Because of the display group assignment by MCIS DNC, the user name

must be enter

ed

; device-specifically for the same user, depending on the screen

resolution
Name =DNC
Password =DNC

; Access levels according to SINUMERIK HMI Advanced commissioning user

interface

ACCESSLEVELO
ACCESSLEVEL1
ACCESSLEVEL2
ACCESSLEVEL3
ACCESSLEVEL4
ACCESSLEVELS5
ACCESSLEVEL6
ACCESSLEVEL7

[TIME]

=HMISystem

=HMIManufacturer

=HMIService
=HMIUser

=HMIKeyPosition3
=HMIKeyPosition2
=HMIKeyPositionl
=HMIKeyPositionO

; Wait time influences the duration of the display of the time-

controlled me
MessageTime =

ssages
1000

Wait time for VB functions

SysTime =500

Timer controls the delay of the list view display when scrolling in

H
the tree view

DelayTime =70

0

; Time during which the transfer of a program can be aborted

BreakTime =50
[REFRESH]

i
Refresh =N

; Values in seconds

0

Refresh list view regularly (Y=On/N=Off)

Time between last actuation and first refresh

RefreshDelay

=10

; Time between two refresh operations
RefreshInterval =60

[GRAPHICTYPE]

; Permissible graphic types

TYPE1l =GIF
TYPE2 =JPG

[DHDIR]

; Selectable view on DM directories

(in upper case letters)

(in upper case letters)

; xxx.DIR = DM directory name

; ;0= Do not create a pseudo workpiece

; ;1= Pseudo workpiece will be created
DHDIR1 =MPF.DIR;O0
DHDIR2 =SPF.DIR;O0
DHDIR3 =WKS.DIR;O0
DHDIR4 =ARC.DIR;1
DHDIR5 =CST.DIR;1
DHDIR6 =CUS.DIR;1
DHDIR7 =CMA.DIR;1

DHDIR8 =MB.DI

R;1

[MachineReference]

; MCIS

machine ID

MaschineID1 =Maingroup\Group\PCU50_ 840D

FBDN2/5-36
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NCDataDescription 1]
D1 =NCDATANAME
D2 =NCDATATYPE
D3 =RELEASEID

[NCDataDefaultvalue 1]

D1 = SPF
D2 =1
[DNCMMCTypeTab]

; Data types from MCIS DNC are converted to data types on MMC/PCU
; Number of types for conversion
DNCMMCTypeCount=2

; Conversion types (e.g. convert TXT to MPF)
DNCMMCTypel =TXT MPF
DNCMMCType2 =DOC INI

[MMCDNCTypeTab]
; Data types from MMC/PCU are converted to data types on DNC
; Number of types for conversion

MMCDNCTypeCount =2

; Conversion types (e.g. convert MPF to TXT)
MMCDNCTypel =MPF TXT
MMCDNCType2 =INI DOC
; Copyright (c) SIEMENS A&D, ALL RIGHTS RESERVED
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5.2 Configuration program

. DNC IFC SINUMERIE configuration program = |EI|1|

File Language Help

DNC IFC SINUMERIK

Configuration program

Password || Lagin |

Fig. 5-1: Login screen of the configuration user interface

Enter your password and then click the Login button to open the configuration
program.

The following menus are available in the configuration program:

e File
e Save
e End
e Language
e German
e English
e Help
e Help topics
e About

The configuration program is exited via the menu File 2> End.
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After logging in, a configuration dialog opens with six tabs:
Basic settings

DNC

FTP interface

Graphics

Login

Job interface

This configuration dialog can be exited either by clicking the Cancel button or by
pressing the Esc key and on the operator panel with the CANCEL key. The login
screen of the configuration user interface then appears again.

Configured data can be saved either by clicking the Accept button or by pressing
the Ctrl+S keys and on the operator panel with the CTRL+S keys.

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition FBDN2/5-39



DNC IFC SINUMERIK - Downloading NC Data via a Network (FBDN2) 05.07
5 Configuration file

5.2.1 Basic settings
&8 DNC IFC SINUMERTK configuration program RI=TEY

File Language Help
Basic zetting IDNCI FTP interface | Graphicl Login|

Transfer target

: Target Dielay [zec) for dialog abort |"'M zeC
¥ Toogle via soft key |PCU 'i
FontMame | SwitchLanguage | S |

- Directom of databaze server

DE directony
“SPF.OIR | | |
WS DR 7 " =
# |MF'F.DIF| Pseudo = ange elete
& r workpisce

- DNC - DM file type conversion
DMC bype DM type

Fold AR IW __)W MHew | Ehangel Delete |

DM -> DML file type conversion

DM type DMC bpe

ABLC Y2 IW __JW Mew | Changel Delete |

Abort [ESC] | DK [Clrl+5) |

Fig. 5-2: Configuration user interface / Basic settings

The basic settings for the download or upload and operation on the PCU are
defined in the Basic settings tab.

Transfer target switchable via softkey

This parameter specifies whether the default transfer target for the download from
DNC can be switched via a Select softkey:

Checkbox activated = Select softkey available > (v)

Checkbox deactivated = Select softkey not available > ()

Extract from the configuration file:
Section [GLOBAL]
ToggleSK = Y

Target

This parameter specifies the default transfer target for the download from DNC:
PCU = The NC data is transferred to the file system
NCK = The NC data is transferred to the NC and loaded

Extract from the configuration file:
Section [GLOBAL]
DefaultTransfer = PCU
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Wait time for dialog abort

Font

The key parameter specifies the time in seconds during which the transfer of a
program can be aborted.

Extract from the configuration file:

The entry in the configuration file is made in ms!
Section [TIME]
BreakTime = 5000

This parameter specifies the font for DNC IFC SINUMERIK.

If no font is specified, the standard system font is used.

A font must be specified for languages that require a special font for correct display
of the (special) characters. This is the case, for example, in Asian and Cyrillic
languages. Arial Unicode MS must then be entered.

Extract from the configuration file:
Section [GLOBAL]
FontName =Arial Unicode MS

Language switching

This parameter specifies the internal parameter for DNC IFC SINUMERIK, mainly
for the English area.

The system language is entered in the first entry field.

The language used internally is entered in the second entry field.

Example:

UK > US

The system language of the computer is UK English.

US is selected from the DNC IFC SINUMERIK internal language list as American
English is to be displayed.

Extract from the configuration file:
Section [GLOBAL]
SwitchLanguage =UK,US

Directories of the data management server

New directories can be created for the data management server, existing
directories deleted or renamed in the Directories of the data management server
frame. The directories displayed in DNC IFC can be selected.

Note

The directory names must be specified in upper case letters.
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Pseudo workpiece

A pseudo workpiece is an organizational unit that is required, in particular, during
automatic archiving, in order to draw conclusions about the source directory of a
file.

Activation or deactivation of the Pseudo workpiece checkbox specifies whether
the NC data is to be stored in a pseudo workpiece in DNC.

Important

The Pseudo workpiece checkbox may not be activated for WKS.DIR!

Extract from the configuration file:
Section [DHDIR]

DHDIR1 =MPF.DIR;O

DHDIR2 = SPF.DIR;O0

Note on the DNC_IFC.INI configuration file

In the configuration file, the digit (0 or 1) behind the directory name specifies
whether the NC data is to be stored in a pseudo workpiece.

0 = No pseudo workpiece

1 = Store NC data in pseudo workpiece

Only 0 is permitted for WKS.DIR! (WKS.DIR is already a workpiece!)

© Siemens AG 2010 All Rights Reserved

FBDN2/5-42 Motion Control Information System DNC (FBDN) - 04/10 Edition



05.07

DNC IFC SINUMERIK - Downloading NC Data via a Network (FBDN2)

5 Configuration file

DNC - DM file type conversion

In the DNC > DM file type conversion frame, the conversion of file types from
the DNC system to the Data management server PCU/MMC can be specified, or
existing conversions deleted or changed. The conversion is performed with the
download of the data from the DNC system to the data management server of the
SINUMERIK 840D.

Important

The conversion is only performed when the Evaluation of the internal PCU path
is not performed in the DNC tab. Selection: No evaluation.

Only specify file types that are known in the DNC system (DNCDATATYPE table)
as DNC type.

Extract from the configuration file:
Section [DNCMMCTypeTab]
DNCMMCTypeCount = 2
DNCMMCTypel=TXT MPF
DNCMMCType2=DOC INI

Note

The conversion only takes effect with privernternpath=o.
DNCMMCTypeCount= contains the number of file types that are converted.
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DM -> DNC file type conversion

In the DM - DNC file type conversion frame, the conversion of file types from
the Data management server PCU/MMC to the DNC system can be specified, or
existing conversions deleted or changed. The conversion is performed with the
transfer of the data from the data management server to the DNC system.

Important

The conversion is only performed when the Evaluation of the internal PCU path
is not performed in the DNC tab. Selection: No evaluation.

Only specify file types that are known in the DNC system (DNCDATATYPE table)
as DNC type.

Extract from the configuration file:
Section [DNCMMCTypeTab]
MMCDNCTypeCount = 2
MMCDNCTypel=MPF TXT
MMCDNCType2=INI DOC

Note
DNCMMCTypeCount= contains the number of file types that are converted.
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5.2.2 DNC
R

File Language Help

Basic sefting  DMNC |FTP interface | Graphic | Lc-ginl

- DMC database
& MSDE DHE host name or TCRAP address DCOM
" ORACLE |'IS2.'IEB.'I'I.SE [omair: |DNE_DDM
User |J0hn Do

MEDE 4 50L Server Instance

Check comnection | | Paszmord: |

[ Remate Lagin

xxxxxxxx

-~ Machine
y Standard return tranzfer ||j vI
tachine IPCUED_84UD
Startlevel |D vl
DN hast path name |\\MCISDNC2\DNC$\Data Evaluation of intermal ML path
MML Directory |F: Mo Evaluation j
Abort [ESC) | OK [Cul+5] |

Fig. 5-3: Configuration user interface / DNC

The connection to the higher-level DNC system and the identification of the PCU in
the DNC system are defined in the DNC tab.

DNC database

The option button is used to select the database that will be used in the DNC
system:

e MSDE /SQL Server (DNC_IFC.INI: 0)

e Oracle (DNC_IFC.INI: 1)

Extract from the configuration file:
Section [GLOBAL]
DataBaseType =0

DNC host name or TCP/IP address

The TCP/IP address or the computer name of the DNC host (DNC CELL or DNC
PLANT) is entered in the entry field. A connection test can be performed by
clicking the Test connection button.

Extract from the configuration file:
Section [GLOBAL]
DNC-HOST =192.168.1.100
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MSDE / SQL server instance

DCOM

The entry field is only relevant and sensitive for MSDE databases. The instance of
the MSDE database (SQL Express) must be entered in the entry field. If no
instance has been assigned for the database, the field must remain empty.

Extract from the configuration file:
[SQLSERVER]
INSTANCE=MCIS

Domain, user name and password on the DNC server are defined in the entry
fields at the top right for the DCOM connection.

Extract from the configuration file:
Section [DCOM]

DOMAIN =DNC_Dom

USER = John Do

DPASSWORD =*****xx*

Remote login

Machine

The definitions for the domain, user name and password of the DCOM connection
are also used for the remote login when this checkbox is activated.

Extract from the configuration file:
[REMOTELOGIN]
REMOTELOGIN=1

Machine is for the assignment to a machine (controller) configured in DNC. The
machine name of the machine assigned in DNC is entered in the Machine entry
field.

Extract from the configuration file:
Section [MACHINE]
Machine = PCU50_840D
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Standard upload

The hierarchy level in which the NC data is uploaded to DNC is specified here.

0= Standard upload to the machine directory.

1= Standard upload to the group directory (father) that is at a higher level than
the machine directory.

2 = Standard upload to the group directory (grandfather) that is at a higher level
than the group directory of the machine directory.

Extract from the configuration file:
Section [MACHINE]
DefUpload = 0

Start of the view

This parameter specifies the standard directory at the start of DNC IFC.
0=Machine

1=Group

2=Higher-level group

Extract from the configuration file:
Section [GLOBAL]
StartupLayer =0

DNC host path name

The drive specification for DNC host path names must be specified from the
DNC IFC SINUMERIK viewpoint.

It is the specification of the directory in which the NC data can be found on the
networked DNC computer.

Note

The path specification for Windows computers or UNIX/LINUX computers with
Samba:\DNC computer name\DNC data directory.

Option for swapping out the NC data on a UNIX system:

The path specification is, for example, for UNIX/LINUX computers with FTP:
/DNC computer name/DNC data directory.

Extract from the configuration file:
Section [PATHS]
WorkPathDNC=\\MCISDNC2\DNC$\Data
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PCU directory
The key parameter describes the drive or path of the SINUMERIK software.

Important
F: Is the drive of the PCU 50/70.
C: Is the drive of the MMC 103.

The drives are mandatory and can only differ for the installation on a PC. The
path in which the SINUMERIK software is expected, must then be specified.

Extract from the configuration file:
Section [PATHS]
MMCIniDrive = F:

Evaluation of the internal PCU path

This parameter controls the evaluation and generation of a header with an internal
path (Siemens program header) in the NC data file.

¢ No evaluation (0)

e Evaluation of a path (1)

o Evaluation of several paths (2)

Extract from the configuration file:
Section [PATHS]
DriveInternPath = 2
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5.2.3 FTP interface

o]

File Language Help
Basic settingl DMC  FTP interface IEIaphicI Loginl

FTP protocol Mo =

Host name |Dﬁ|s\r'

User |an0n_l,.lm0us

Pazsword | xxxxxx

Transfer made IBinary j'

Check connection |
Abort [ESC) OFK [Ctrl+5]

Fig. 5-4: Configuration user interface / FTP interface

The FTP interface to the higher-level DNC system is defined in the FTP interface
tab. The configuration is only required when the transfer between the machine and
the higher-level DNC system is to be performed by means of FTP.

A connection test can be performed by clicking the Test connection button.

Note

Usually transfer by means of FTP should be avoided as the data is not encoded
for transmission via the network.

© Siemens AG 2010 All Rights Reserved
Motion Control Information System DNC (FBDN) - 04/10 Edition FBDNZ2/5-49



DNC IFC SINUMERIK - Downloading NC Data via a Network (FBDN2) 05.07

5 Configuration file

FTP protocol

e No (0):
Operation without FTP:
Transfer is via the Microsoft network. The DNC host path name in the DNC tab
must therefore refer to a released network drive with the data directory of DNC.
e Yes (1):
Operation with FTP:
DNC_IFC.EXE and DNC_IFCDB.EXE access the NC program files via FTP.
DNC host path name in the DNC tab must contain the path used to switch to
the data directory of DNC after the FTP connection has been established.

Extract from the configuration file:
Section [GLOBAL]
FTP-Protocol =0

Computer name

User

This parameter designates the host name or the IP address of the FTP server,
e.g. DAISY
e.g. 180.212.26.200

Extract from the configuration file:
Section [FTP]
FTP-HOST =DAISY

This parameter designates the user on the FTP server,
e.g. anonymous

Note
The entry in the DNC_IFC.INI configuration file is encoded.

Extract from the configuration file:

Section [FTP]
FTP-User =A99399958D9895928F
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Password

This parameter designates the password for the specified user on the FTP server,

*kkkkkkkk
e.g.

Note
The entry in the DNC_IFC.INI configuration file is encoded.

Extract from the configuration file:

Section [FTP]

FTP-PW =A98CA48E93A092C79EA8A18E8FD59A96A1A696
Transfer mode

Two modes can be parameterized:

e ASCII (1)
e Binary (2)
Important

The Binary mode is recommended as transfer mode for the FTP connection
between DNC and DNC IFC SINUMERIK!

Extract from the configuration file:
Section [FTP]
FTP-Mode = 2
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5.2.4 Graphics
@8 DNC IFC SINUMERIK configurationprogram =Tk

File Language Help
Basic setting' DNCI FTF interface  Graphic |Login|

Graphics types

GIF Mew |
N Change |
Delete |

Abort [ESC) OK [Ctrl+5)

Fig. 5-5: Configuration user interface / Graphics

The graphic types permissible for display in the screen Detail Dialog > Display
Graphics are specified in the Graphics tab.

Graphic types

All graphic types that are supported by the Internet Explorer can be displayed (e.g.
BMP, JPG, GIF). If further graphic types are to be displayed, the necessary plug-
ins must be installed.

Note

Graphics can only be displayed with PCU and for operation without FTP protocol.
The type must be specified in upper case letters.

Extract from the configuration file:
Section [GRAPHICTYPE]

TYPE1l =GIF

TYPE2 =JPG

TYPE3 =PDF
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5.2.5 Login
-l x]

File Language Help

Basic settingl DNC' FTF'interfacel Graphic  Login |

el o |NO login dislog i

Uzer |DNC Pazzword |m=)1

r Azsignment of users to access levels

Level |HMIS_I,Istem Level 4 HiIk.eyP osition
Level1 |H b b anufacturer Level 5 HHIK eyPosition2
Level 2 |HMIService Level B HHIK eyPosition
Level 3 |HMIL|ser Level 7 HHIE eyPozitionD

Abaort [ESC) DK [Ctrl+5]

Fig. 5-6: Configuration user interface / Login

The login procedure to start DNC IFC SINUMERIK is configured in the Login tab.
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Type of login

This parameter specifies the procedure to start DNC IFC SINUMERIK.

No login dialog (default setting) (0):

DNC IFC SINUMERIK is started with the access entered in User and
Password. No other login is possible.

Login dialog (1):

The user must log in with name and password in a Login dialog when starting
DNC IFC SINUMERIK.

Login via protection level (2):

DNC IFC SINUMERIK is started with the user specified via Assignment of
users to protection levels of the current SINUMERIK protection level. A DNC
user with certain rights, which can also be adapted in the user management of
DNC Admin, is assigned to each protection level.

Login via protection level or Login dialog (3)

The login to DNC IFC SINUMERIK is performed as with the Login via
protection level (2), however a Login dialog appears if a user

has not been assigned or the user is not in the DNC user administration.

After a successful login, the softkey Logout is displayed so that the user can be
changed.

Extract from the configuration file:
Section [USER]
Login = 0
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User/Password

These two parameters correspond to the user name and associated password for
the automatic login (type of login: No Login dialog).

Note

The user DNC with password DNC is defined in DNC IFC SINUMERIK as default
setting. After installation of DNC, the preset user should be deleted and replaced
by your own user ID, as the DNC user has administration rights per default. The
preset user should then also be replaced by a user configured in DNC in

DNC IFC SINUMERIK.

Extract from the configuration file:
Section [USER]

Name = DNC

Password =DNC

Assignment of users to protection levels

A user can be assigned to each of the eight protection levels 0-7 in accordance
with SINUMERIK HMI Advanced. Depending on the current type of login, it is
therefore possible to start DNC IFC SINUMERIK with the rights of one of the
entered users.

Extract from the configuration file:
Section [USER]

ACCESSLEVELO =HMISystem
ACCESSLEVEL1l =HMIManufacturer
ACCESSLEVEL2 =HMIService
ACCESSLEVEL3 =HMIUser
ACCESSLEVEL4 =HMIKeyPosition3
ACCESSLEVEL5 =HMIKeyPosition2
ACCESSLEVEL6 =HMIKeyPositionl
ACCESSLEVEL7 =HMIKeyPositionO
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5.3 Further configuration options via DNC_IFC.INI

Configurations on the following parameters must be made directly in the
DNC_IFC.INI configuration file:

Section [GLOBAL]
DataTypeChange =

N = When transferring to a selectable target (Transfer to), it is not permitted
to change the file type.

Y = When transferring to a selectable target (Transfer to), the file type can be
changed by the user. This also applies when conversion tables are configured
in the sections [DNCMMCTypeTab] and [MMCDNCTypeTab]. The
DataTypeChange=Y parameter acts only if DrivelnternPath =0.

OverwriteNCData =

0 = Existing NC data files of the same name are not overwritten on the controller.

1 = Existing NC data files of the same name are overwritten on the controller
(default).

A Warning

The check to determine whether an NC data file already exists on the controller

can only be carried out correctly when the parameter DrivelnternPath=0 is
parameterized.

Section [PATHS]
DhsTempPath =

DhsTempPath describes the directory for temporary files. If the parameter is not
set, the temporary directory (temp) is used by Windows.
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Section [TIME]

MessageTime =
The key parameter controls the dwell time (in ms) of the displayed messages of
DNC IFC SINUMERIK.

The key parameter controls the wait time for VB functions.

A Warning

The parameter may only be changed during commissioning or after consultation
with the hotline!

DelayTime =
The key parameter controls the delay (in ms) of the list display of directories when
scrolling through the tree view of DNC IFC SINUMERIK.

Section [REFRESH]

Refresh =
N = Switch off automatic refreshing of the screen content
Y = Switch on automatic refreshing of the screen content

RefreshDelay =
Time between last operator action and first refresh

RefreshInterval =
Time in seconds between two refresh cycles
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A.1 DNC Glossary

Abbreviation

Description

ASCII code American Standard Code for Information 7-bit code

BMP BitMaP Graphics file for clamping sketches, etc.

CNC Computerized Numeric Control Numeric controller with microprocessors

DNC Direct Numeric Control System with which several CNC machines are
coupled with a central computer using bidirectional data exchange

DNC IFC Direct Numeric Control InterFace Client System with which several

SINUMERIK CNC machines are coupled with a central computer using bidirectional
data exchange. The download to SINUMERIK 840D is made using a
network.

FTP File Transfer Protocol

EIA code Electronic Industries Association Although 8-track paper-tape code
corresponds to the ISO code, it has an even number of holes per character

HMI Human Machine Interface

ISO code International Organization for Standardization 8-track paper-tape code

ISQL Interactive Structured Query Language Possibility of the interactive
database access

MDA Machine Machine Data Acquisition Stand-alone for SINUMERIK / PC, incl.

SINUMERIK machine data acquisition / process data acquisition evaluation

MDA Machine Data Acquisition Process data acquisition and evaluation on
SINUMERIK 840D

MPF MainProgramFile Main NC program

MMC Man Machine Communication

0OCX OLE Custom Controls

OLE DB Object Linking and Embedding DataBase Database access functions
using OLE/COM

OLE/COM Object Linking and Embedding / Component Object Model Object-

oriented program model for defining the object behavior, also over process
boundaries
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Abbreviation | Description
PCU PC Unit
SINUMERIK* SINUMERIK 810D, SINUMERIK 840D, SINUMERIK 840Di, PCU50 under
Windows with SINUMERIK 840D sl
SPF SubProgramFile NC subprogram
SQL Structured Query Language Database query language
SQL-net Structured Query Language-net Interface for the database access over
the network
TCP/IP Transmission Control Protocol / Internet ProtocolTransmission
protocol
TDI Machine Tool Data Information Machine Information about the provision and
handling of tools.
TOA ToolOffsetActive Tool offsets
WPL WorkPLan ASCII file for tool plans
ZOA ZeroOffsetActive Zero offset
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